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Chapter 1 – Introduction 

Video:  Acquiring PowerPoint 2013 

 
Toby:  Hello and welcome to our course on PowerPoint 2013.  My name is Toby and I’m your 

instructor on this course. 

I think there can be little doubt that PowerPoint is by far the leading presentation software in the 

world, both in terms of numbers of users and in terms of the range of applications of this 

presentation software.  There are other good presentation products and particularly in the area of 

the Mac there are one or two strong competitors.  But in terms of overall use, PowerPoint really 

is head and shoulders above the competition.  In this course, we’re going to look at the latest 

version of PowerPoint; PowerPoint 2013. 

So who is this course for?  Well, the simple answer is that it’s for anybody who wants to use 

PowerPoint 2013.  But there are specifically three groups of users that I’m targeting.  The first 

group of users are people who have never used PowerPoint before, probably never even used 

presentation software before.  I am going to assume that you have a reasonable level of 

competence and confidence with using Windows software, so I’m going to assume that you 

know how to minimize or maximize a window, how to use a dialog box and scroll bar, and the 

other main components of a Windows interface.  My aim on the course is to get you to the point 

where you’re a competent user of PowerPoint 2013 and you can produce good presentations and 

use many of the facilities of PowerPoint with a high level of confidence.  You’ll also be aware of 

other areas of PowerPoint, maybe ones where you need to learn a bit more or experiment a bit 

more, but you should be aware of just about all of the main aspects by the end of the course. 

The second group of users are those who’ve used much older versions of PowerPoint; versions 

like PowerPoint 2000 or PowerPoint 2003.  These older versions do not use the Ribbon interface, 

which has been in the last couple of version of PowerPoint and which has become an integral 

part of using PowerPoint.  The Ribbon interface is developed further in PowerPoint 2013, but 

they’re many other features have been introduced into PowerPoint in the versions since those 

much older ones.  So if you’re used to PowerPoint 2000 or PowerPoint 2003, learning 

PowerPoint 2013 really is going to involve learning a lot of new things and these are not just 
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things related to the Ribbon interface.  There are many improvements and new features related to 

sharing, collaboration, use of animation, and many other features.  So for people with knowledge 

of the older versions of PowerPoint, although some features will be familiar, there will be many 

new things to learn as well.  My intention for that second group of users is to get you up to speed 

on the new version and to be aware of all of the latest features and able to use just about all of 

them. 

The third group of users are those that do have experience of the Ribbon in that they’ve used 

more recent versions of PowerPoint, such as 2007 and PowerPoint 2000.  You should be aware 

that the Ribbon has changed a little in PowerPoint 2013 and in particular it’s changed to 

accommodate touch use.  But you also have, of course, several new features and for those uses of 

the more recent versions I’m really going to make sure that you can add the use of those new 

features to the skills that you already have in the use of Microsoft PowerPoint.  In general, when 

planning and designing this course I’ve tried to achieve a good, broad coverage of PowerPoint 

2013.  Some subjects we will go into in a lot of detail, some of them will be at a fairly 

introductory level, but there are very few exclusions.  One of the exclusions, however, is the use 

of PowerPoint VBA, effectively programming in PowerPoint.  So we won’t be covering this as 

part of the course. 

One of the key new features of Office 2013 in general is the accommodation of the use of touch 

base devices.  And on this course I’m actually using a touch device to develop the whole course.  

So from time to time when we get into any kind of new topic I’ll also briefly cover how to 

achieve the same effect or perform the same action using a touch device.  However, I should 

point out to you that primarily I’ll be doing things with mouse and keyboard.  That is still by far 

the most popular way that people interact with PowerPoint in particular.  And in fact if for every 

single subject on the course I did it with mouse and keyboard and using touch it would be a very 

long course indeed.  So generally speaking on this course, the default is mouse and keyboard.  

But whenever something that is new for touch device users comes in, I’ll cover that as a touch 

subject as well.  And in fact, at a couple of point in the course, I will specifically look at some of 

the ways that you can particularly do things with a touch device.  Also as we’ll see a little bit 

later on in the course when we look at Help there are various resources and sources available to 

help you if you’re using a touch device. 
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Let’s look now at what the system requirements are to run Office 2013.  Within the Microsoft 

site there is a section called TechNet and within TechNet there’s a section here, System 

Requirements for Office 2013.  There are various other sources, but at the time of writing this is 

probably the one I would recommend.  If I scroll down here, one section tells you what the 

versions of Office 2013 are.  Now I should warn you that I’m actually recording this very early 

on in the life of Office 2013 and it may well be that the versions change or additional versions 

come on to the market.  And this does include the versions of Office 365 which is effectively the 

sort of online version of Office 2013.  But given that list of versions, just below it there are then 

the standard system requirements for Office 2013.  There are hardware requirements, so the sort 

of computer and processor you need, the amount of memory, the amount of hard disk space it 

needs.  But very importantly in the middle here we have the operating system requirements.  

Now in terms of a PC or laptop operating system, you need Windows 7 or Windows 8.  Office 

2013 is not supported on Windows XP or Vista.  So if you have Windows XP or Vista and you 

want to run Office 2013, you’re going to need to upgrade.  It is also supported on the latest two 

Windows Server products, 2008 RT and Windows Server 2012.  Another significant option for 

running Office 2013 in general and PowerPoint 2013 in particular is to use one of the new 

Microsoft Surface tablets and either the Windows RT version or the Windows 8 Pro version 

offers you the opportunity to run PowerPoint 2013. 

Now as I mentioned earlier on, I’m recording this quite early in the life of Office 2013 so I’m 

going to have to be fairly general about installation.  But let’s suppose that you’ve established 

that you’re going to use PowerPoint 2013, you have a suitable device to run it on.  It may be that 

you’ve by now acquired a device with it already installed which is fine.  It may be that you are 

installing a version.  Now there were customer preview versions in the very early days of Office 

2013 then Microsoft in late 2012 started offering a downloadable 60 day trial version, and if 

you’re a subscriber via TechNet or MSDN, you can get a version via one of those sources.  So 

there are various ways of acquiring Office 2013 at this time.  It is also, of course, entirely 

possible that you’ve bought a copy of Office 2013 from your local computer store or from an 

online source.  You may have purchased a copy from Microsoft and downloaded that.  Now 

however, you’ve acquired your copy of Office 2013 I won’t be covering any instructions on how 

to install it.  The Microsoft.com website is the place to go for the installation instructions.  At the 

time of writing, the best instructions are on the TechNet part of that website.  And here we have 
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installing the new Office 2013 customer preview.  These instructions came out in the middle of 

2012 and a couple of versions of the software have come out since then.  But the instructions are 

still good.  They’re step by step instructions with a good explanation.  The chances are that 

you’ll be installing Office 2013 sometime after I record this course, so these instructions may 

well have been upgraded or replaced.  So check on Microsoft.com for the latest installation 

instructions.  Just type in, in the Microsoft.com Search box Installing Office 2013, see what it 

comes up with.  But I’m going to leave the installation to you and from this point onwards I’m 

going to assume that you have successfully installed Office 2013. 

But let’s look at the situation that some of you may be in.  You don’t have a copy of Office 2013 

at the moment.  You’re not completely committed to buying it yet, but you’d like to find out 

about it so you’re following this course and you’d also like to be able to work along with the 

examples and just try it out for yourself for a while.  Well, I mentioned a little while ago the 60 

day trial.  At the time of recording this course the 60 day trial was still available.  It’s available 

via the TechNet evaluation center.  Again, if you go into Microsoft.com and search on Download 

Microsoft Office Professional Plus 2013, that gives you access to the trial version which as I say 

at the time of recording gave a 60 day evaluation.  The instructions for downloading are included 

there.  That will refer you to the later instructions for installation and so on.  And that’s a way of 

getting a fully fledged copy of Office 2013 that you can use for 60 days. 

As you’ll see later on in the course with Office 2013, the need for a pretty much constant internet 

connection is greatly increased.  Virtually all of the help for Office 2013, including PowerPoint 

2013, is online help.  There is a limited version available when you’re not connected to the 

internet, but it’s certainly not the full help.  And another aspect of having an internet connection 

is that it gives you access to the various forums, particularly forums within TechNet and 

associated Microsoft sources that gives you access to things like tracking down problems.  So if 

you have a problem installing Office 2013 or running it or accessing PowerPoint, you can very 

often find the solution to your problem by browsing the various forums there.  But you will need 

an internet connection.  I think it’s fair to say that if you’re trying to use PowerPoint 2013 or any 

other part of Office 2013 without an internet connection, you are really going to be quite 

constrained in what you can do.  It’s by no means impossible, you can use it without, but it will 

severely restrict you in certain areas. 
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So from this point onwards I’m going to assume that you have successfully installed Office 2013 

or at least PowerPoint 2013 and I’m also going to assume that you can locate and identify the 

folder containing the sample files.  Now the sample files will be a different list to the one you 

can see in front of you here, but the names will be of this style.  So they’ll have names beginning 

ssi-powerpoint2013.  There will be a folder with those files in it and these files are the ones that 

I’m going to use to set you exercises to do from time to time and they’ll include my answers to 

those exercises.  So make sure you know where that folder is and you can locate that easily 

because you’re going to need that from time to time during the course. 

So having installed PowerPoint 2013, probably as part of Office 2013 you should now be able to 

start it.  You may be using the Start Menu from Windows 7, the Start Screen from Windows 8.  

You may have setup a desktop shortcut or added it to your taskbar.  To a large extent how you 

start it during this course is unimportant as long as you can get it started whenever you need to 

get it started.  You can see it in front of you now.  You’re color scheme may be different to mine.  

You’ll certainly be a different user if you look in the top right hand corner there you’ll see me as 

a user.  But basically if you can start PowerPoint now and it runs and it looks something like this, 

then you’re where you need to be for the rest of the course.  We’ve actually got a couple of other 

things to look at quite quickly before we really start using PowerPoint, but the important 

milestone here is that you can actually start it and see PowerPoint in front of you as I can here.  

So that’s it for this section.  I’ll see you in the next one. 
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Video:  What’s New in PowerPoint 2013 

 
Toby:  Hello and welcome back to our course on PowerPoint 2013.  In this section, I want to run 

through the main new features in PowerPoint 2013.  This is new in comparison with the previous 

version PowerPoint 2010.  Now if you haven’t used PowerPoint before, you may think that 

looking at the new features won’t really help you very much or mean much to you, but I think 

it’s still worth going through this section because it will highlight some of the main points that 

I’m going to be looking at and also give you an idea of the structure of PowerPoint 2013, 

particularly because some of the changes in it have a very general kind of impact. 

Now the first thing to point out is that within Microsoft.com in the Office part of the Microsoft 

website there is a page, What’s new in PowerPoint 2013, begins with a video covering the main 

new points and then there’s a list of each of the points, a brief description of what each of them is 

and does.  So I suggest you take a look at that.  There are also links from that page into a couple 

of other useful areas.  One of them here, Make the switch to PowerPoint 2013, this is particularly 

for people who’ve been using earlier versions.  And then for people who are beginners, there are 

basic tasks for creating a PowerPoint 2013 presentation.  Now generally speaking, the materials 

that are available on the Microsoft site for learning PowerPoint are a little bit restricted compared 

to a fairly comprehensive course like the one I’m presenting here.  But they certainly give a 

different view on each of the topics and it’s always good to look on the Microsoft website to see 

what training materials or help materials they’ve got with any topic that you’re trying to find out 

about in relation to PowerPoint. 

One of the most significant features in PowerPoint 2013 is the significant feature in virtually all 

of Office 2013 and that is that the interface has been redesigned to accommodate the use of 

touch.  So there’s very much an emphasis on making it easy to use on tablets and to look at 

presentations on phones and so on.  And as I mentioned earlier on I am at various points in the 

course going to look at how to achieve various things using a touch screen rather than a keyboard 

and mouse.  I’m not going to keep referring to that in this What’s New section, but it is very 

significant and in many ways it’s a key driving force behind Office 2013 in general.  So its 

importance is not to be underestimated. 
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So let’s look at some of the key new features other than the touch related ones and let’s start with 

more choices for getting started.  If you’ve used PowerPoint before, you know that there are a 

number ways of starting a new presentation.  You could begin with a blank one.  You could start 

with a presentation you made before.  You could use a template or maybe a presentation that you 

created before but haven’t used for some time.  Now with PowerPoint 2013 all of these options 

are really presented to you on one screen to make it very easy for you to get started on a new 

presentation, whichever approach you’re going to take to creating that presentation.  Now even if 

you haven’t given a PowerPoint presentation yourself, you may well have seen one being given 

where the presenter may be sits at a desk with a laptop or a PC and the presentation itself is 

shown on the monitor to the audience.  And what has been greatly improved in PowerPoint 2013 

is the ability to control that presentation in a number of ways.  Just to give you one specific 

example, let’s suppose you’ve got some notes to go with the presentation but you don’t really 

want the audience to see those notes; you want to be able to read them yourself.  Well, you can 

show the notes on the PC or laptop that you’re using to control the presentation without them 

appearing on the monitor that the audience are able to see.  So there a number of new features 

associated with what’s called Presenter View, presentation tools we’ll call them that have been 

either introduced in PowerPoint 2013 or very much improved. 

Now if you bought a TV recently, it will almost certainly be HD and widescreen.  If you’ve 

bought PC or a laptop or a monitor that will almost certainly have been widescreen as well.  

Well, PowerPoint is now very much geared up to giving you the ability to work in widescreen 

and it’s very easy to switch between the standard 4:3 aspect ratio presentations of old and the 

new widescreen 16:9 aspect ratio layouts that we come to expect nowadays. 

Of course, it’s not always the case nowadays that if you want to present to a group of people, you 

get them all together in a room and present on to a monitor or a white board.  Nowadays, it’s 

increasingly popular to run presentations online.  And with PowerPoint there are several ways of 

sharing your presentations over the web.  Some of those have been improved and a couple of 

new ones introduced in PowerPoint 2013 and we’re going to look at some of those online 

presentation options.  These enable you to present to an audience where the audience are pretty 

much anywhere and it gives them a very wide choice of device that they can use to follow your 

presentation. 
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The use of themes in PowerPoint has been established for a couple of versions.  If you’re 

familiar with older versions of PowerPoint, you may not be familiar with themes.  But really a 

theme gives you a consistent set of design styles, guidelines, and tools within a presentation and 

also between the components of Office 2013.  Well, within Office 2013 and specifically within 

PowerPoint 2013, you now have theme variations and you can more closely achieve your design 

goals using variations on your chosen theme. 

It’s very often the case when you’re preparing a presentation and you have some complex 

graphics in it that you have to align objects.  Well, some of the improved tools, including smart 

guides in PowerPoint 2013 will help you to align objects and space objects accurately and 

quickly. 

Increasingly people are using animation in their PowerPoint presentations and the animation 

features of PowerPoint have significantly improved in recent versions.  There’s a further 

improvement in PowerPoint 2013 which will help you with motion path to envisage not only 

where a particular object starts out but where it will finish up after it has moved along your 

specified path. 

Another new feature of PowerPoint 2013 is the ability to choose two or more common shapes 

and to merge them to make a custom shape. 

There’ve been a number of improvements to video and audio support.  These include the 

introduction of support for more multimedia formats and more high definition content, but also 

the inclusion of additional built in codex.  You can also play music in the background.  So you 

could play a song for the duration of a slideshow for example. 

PowerPoint 2013 includes a new eye dropper tool that you can use for color matching.  This 

means you can take a sample from an object on the screen and apply that color to any shape in 

your presentation. 

Another improved feature in PowerPoint 2013 which is pretty much now a feature across the 

board for Office 2013 is the ability to save your documents, your presentations to SkyDrive and 

to use that as a way of sharing those documents, in this case presentations, with other people. 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

PowerPoint 2013 also now includes a comment facility whereby you can review a PowerPoint 

presentation and give feedback by inserting comments at appropriate points. 

And finally one part new and part improved feature of PowerPoint 2013 is the ability to work 

collaboratively on a presentation with your colleagues.  And one important factor here is the 

ability to use the online version of PowerPoint to work on a shared document that is accessed 

online. 

So there we are.  That’s a quick sort of whistle stop tour of PowerPoint 2013.  I hope you find 

that useful even if you’re not very familiar with PowerPoint because hopefully it’ll point you in 

the direction of some of the things we’re going to be looking at on the course.  The first thing 

I’m going to look at and that’s what we’re going to cover in the next section is the use of touch.  

Now there are some general aspects of using touch in Office 2013 that I’m going to cover first.  

The specifics of using touch in PowerPoint 2013 some will be covered in the next section and 

some will be covered at the appropriate points during the course.  So please join me for the next 

section. 
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Chapter 2 – Using Touch 

Video:  Overview of Principles 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to take a look at touch in relation to PowerPoint 2013 and largely speaking that means 

looking at touch in relation to Office 2013 at this stage.  I mentioned earlier that one of the major 

new features of Office 2013 is extended support for touch screen devices.  So the use of touch is 

a very important aspect of this new version of PowerPoint.  I also mentioned earlier that by 

default on this course I’m going to be using mouse and keyboard, but whenever something new 

or different occurs that affects the use of PowerPoint 2013 using touch, I will go through that and 

also from time to time I will use touch as an alternative means of interacting with PowerPoint to 

perform specific tasks. 

Now if you’re planning to use touch, there are some very useful articles on Microsoft.com both 

in terms of how to use touch with Windows in general and specifically about the use of touch in 

Office 2013.  There’s also some information in the Office 2013 Help, but more of that in a little 

while.  This particular article that I’m looking at here which is actually about the use of touch in 

Windows is a particularly good one because it talks about a keen user and their experience of 

using touch to perform particular tasks and the sort of things that work and the sort of things that 

maybe don’t work so well.  So some of those sources you should find very useful. 

Now in many cases the way that you would use touch instead of a keyboard and mouse to 

perform a task in PowerPoint 2013 is a pretty straightforward swap where I say click, then with a 

touch screen device you would tap.  And that’s a pretty good basis on which to work.  However, 

there are quite a few situations in which click and tap although nominally performing the same 

function will actually achieve different results and very often the way that PowerPoint reacts to 

tap instead of click is either subtly different or in some cases is quite different.  So things like the 

indicators that you see on the screen, the information say about making a selection is different on 

a touch screen device to the information that you get when you’re using keyboard and mouse.  

So even if on the face of it what you’re doing with a touch screen device is the same as what 

you’re doing with a keyboard and mouse what you see in the process may be quite different. 
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Now let me give you a particular example of that.  Now, don’t worry about everything that you 

can see here.  I’ll be explaining this to you later.  I just want to demonstrate within PowerPoint, 

this is a single slide in PowerPoint, what I mean by the equivalence and differences comparing 

mouse and keyboard with touch.  This slide has some text on it, at the top Behavioral Chain of 

Responsibility and then some text here.  And then down here we have a picture.  Now if I click 

with the mouse on that picture, it becomes selected.  Note that it’s got a sort of frame round it 

with these little handles on the corners and a little rotation control at the top there.  If I click on it 

again, nothing happens.  It’s selected and I can choose to do things with it or not as the case may 

be.  If I just click outside the slide and start again, let me now touch with my finger on the 

picture and note it’s done exactly the same thing.  It’s selected that picture.  But let me now 

touch with my finger again on the selected picture and what I see is a little toolbar that comes up 

with options like Cut, Copy, Delete, Style, etc.  Although in the end what you can do with a 

touch device and what you can do with mouse and keyboard are going to be exactly the same for 

this picture the processes, the things that appear, the tools, the commands, the information about 

what’s going on, will differ in many cases.  So although it’s true to say that you can do the same 

things with both the route while you’re doing that and the information you get while you’re 

doing that may be different between the two approaches. 

So as we work through this course on PowerPoint 2013 I’ll be aiming to cover these very 

specific gestures with a touch device and not only covering how to do things using this touch 

device but also pointing out some of the differences where they occur with mouse and keyboard.  

And although the default will be mouse and keyboard throughout I’ll aim to give adequate 

coverage for those of you wanting to use touch devices that you’re going to be confident in using 

PowerPoint 2013. 

Now if you’re planning to use touch with PowerPoint 2013, I suggest you look at one or two of 

the very good articles on Office.com about the use of touch with Office.  And the one that you 

can see here is a particularly good one because not only does it explain some of the basic aspects 

of using touch with Microsoft Office but it also gives some of the background.  And if you’re 

interested in understanding why things work the way they do, this is a very good article to start 

with.  It also contains one or two particularly useful sections.  One section contains a very useful 

explanation of why one of the key aspects of implementing touch for Office 2013 was to space 
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certain things out more.  For instance, we’ll see later on that with the Ribbon if you work in 

touch mode, everything is spaced out more as in the lower diagram here.  And the basic reason 

for this is pretty straightforward and that is that if you’re operating something with your fingers, 

your fingers, particularly if you’ve got fat fingers like mine, tend to need more space to operate 

than clicking with a mouse.  And this is a recurring aspect of the way that Office 2013 has been 

redesigned to support the use of touch.  Another very useful section in that article explains how 

text and object selection works and how the little selection handles that you see, if you’re using a 

touch device, are different and work in a subtly different way to the ones that you see when 

you’re using keyboard and mouse. 

And one other very important aspect of using a touch device is that when you do need to enter 

text and if you’re using a keyboard, whether you’re using a physical attached keyboard or 

whether you’re using a virtual keyboard, there are differences in how this works; for example 

between Windows 7 and Windows 8.  It’s not possible for me to cover every possible way that 

you might use a keyboard at every point in the course. But at one or two points, the issue of a 

virtual keyboard will come up and I’ll be assuming that whatever device you’re using you’re 

able to enter text without difficulty. 

So that’s the end of the sort of background information about PowerPoint 2013.  It’s time to start 

making some presentations.  So I’ll see you in the next section. 
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Chapter 3 – Getting Started 

Video:  PowerPoint Workspace; Opening, Saving and Exiting 

 
Toby:  Welcome back to our course on PowerPoint 2013.  The very first thing you see when you 

start up PowerPoint 2013 for the first time will be something similar to this and in fact this 

screen shows you one of the main changes in PowerPoint 2013 compared to earlier versions 

because on this screen you have presented to you a number of different ways of getting started 

working on a presentation. 

So let’s start on the left of the screen here.  You would normally have a list of recent 

presentations that you’ve worked on.  Now since this is the first time that I’ve launched this 

installation of PowerPoint 2013, the list of recent presentations is empty.  Below that is a button 

that enables me to open other presentations.  This means that I can access one of the 

presentations that I’ve got stored on my computer or on a touch device or on a network drive.  

On the right over here, I’m basically looking at ways of starting a new presentation.  Now this 

particular entry here which has a caption Blank presentation, very often will be the one that I 

choose if I want to start with a completely empty PowerPoint presentation that’s the option that 

I’d choose.  Below that I have a whole list of templates.  These are if you like designed but not 

filled presentations.  So each of these will have a certain style and the style will include things 

like color schemes, fonts, font sizes, and the like.  And there’s quite a long list of these templates 

available from the start screen.  However, if you don’t want or you don’t like those presentations, 

if you look at the note at the bottom “Not finding what you’re looking for”, use the Search box at 

the top to find more templates and themes.  And up here you have a search box.  You can type in 

a subject and search for a template to suit the content or the style that you’re looking for.  Now 

just under that search box there’s a list of suggested searches; so, Business, Calendars, Charts 

and Diagrams, Education, Medical.  They’re typical kinds of presentation that you might want.  

A very popular one is over here on the right, Photo Albums.  So you can enter a term here, 

search for it, and try to find an appropriate template, and we’ll be coming back to templates in 

detail later on. 
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Let me go back up to the start again.  There is also a Welcome to PowerPoint tour available here 

and you can click on that and take the tour.  And if you’re new to PowerPoint I think that’s a 

very good place to go. 

In the very top right hand corner of this screen, you see a set of buttons that are pretty much the 

standard ones that you see in a Windows application.  So we have a Close button.  We have a 

Maximize button which makes the window fit the screen, Minimize button that normally shrinks 

the window down to sit on your taskbar and the question mark in PowerPoint 2013 gives access 

to Help.  We’ll be coming back to PowerPoint Help a little bit later on in the course. 

Below that set of buttons, you can see details of the current user including a Microsoft account if 

there is one.  And that’s very important in relation to two or three things in PowerPoint 2013 and 

in particular in relation to the use of SkyDrive.  We’ll come back to that later on, but obviously 

once you are using PowerPoint 2013 as when you see a name and an email address there, they 

will not be the same as mine. 

So the first thing we’re going to do is to look at one of the presentations that is supplied with this 

course.  So click on Open other presentations and you will see a list similar to this, Recent 

presentations.  That list will be empty if you haven’t opened any presentations so far.  Link to 

your SkyDrive which you may or may not have setup; mine is setup.  And then there’s the link 

through to your computer.  So click on Computer and, again, you should see a list something like 

this, Recent Folders which might be My Documents, your desktop; you need to click on Browse 

and then browse to the folder that contains the files that came with this course.  Now your folder 

will almost certainly be in a different place to mine, so click on Browse and then browse to that 

folder.  So when you’ve found that folder, click on the first example, example-01.pptx, and then 

you can either click on Open or you can double click on the file name.  So let me double click 

there and my first presentation is now open. 

Now during this section and the next one we’re going to talk a lot about this PowerPoint 2013 

workspace.  But I want to start in this section with a few of the basics that you’re going to need 

throughout and one of them is actually one of the new features of PowerPoint 2013.  You 

probably saw a little message pop up on the right just then and there’s a strange little box sitting 

down here on the right.  Let me just hover over that, Welcome back!  Pick up where you left off.  
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One of the features which is across quite a bit of Office 2013 is a Resume Reading function.  If 

you’ve used Word 2013, you may well have seen it there.  But basically if you’re working on 

something, if you’re were working on a presentation or perhaps in Word reading a document and 

you’re partway through it, this gives you an easy way to get back to where you were working 

before.  Now I’m going to talk about resume reading a little bit more later on, but basically the 

last time I opened this presentation, I worked on what’s called Slide 3 and if I wanted to go back 

to the slide I was working on, I could literally click here, it would take me back to Slide 3.  But 

I’ll come back to resume reading in a bit more detail later on. 

So let’s look at some of the main features of the PowerPoint 2013 workspace.  Right at the top 

we have a title bar and in the title bar we can see the title of the current presentation that we’re 

working on.  This is ssi-powerpoint2013-example-01.pptx and that’s always a good point to 

make sure you’re working on the presentation that you think you’re working on.  Along here we 

have the Ribbon and I’m going to talk about the Ribbon a little bit later on.  In the top left corner, 

we have something called the Quick Access Toolbar.  I’m going to talk about that later as well.  

But down in this pane on the left we can see the slides or, to be more accurate, we can see 

thumbnails of the slides.  There are currently three slides in this presentation and if I hover over 

each one, I get a summary of one of the pieces of text that’s written on the slide.  So that’s Slide 

1, that’s Slide 2.  When I select a slide, it appears in the window on the right, the main document 

window, the main slide window in PowerPoint 2013.  So let me now select the third slide and in 

each case you’ll see that the slides have different text written on them.  To select the first slide 

again, I just click there.  Note also that when I’ve got the cursor in that panel, I can step through 

the slide using the arrow keys and, of course, I can easily select them just by tapping on the 

screen with my finger if I’m using a touch device. 

Now on this particular occasion I’m going to select the second slide.  I’m only reading it.  I’m 

not changing any of the content on the slide at all.  But now I’ve finished working on this 

presentation and when you finish working on a presentation, you would normally close it.  To 

close the presentation, you go into what’s called Backstage View and to access Backstage View 

in PowerPoint 2013, you click on the File tab up here. The very left one on the Ribbon, just the 

top left of the Ribbon, you’ll see a little tab there that says File and that takes you into Backstage 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

View.  Now we’re going to talk about Backstage View at length later on, but just go down to 

Close, click on Close, and that particular presentation is now closed. 

Now once I’ve closed that particular presentation I have no presentation open so the title bar now 

just says PowerPoint.  If I wanted to exit PowerPoint all together, the simplest way of doing it is 

just to go to the top right hand corner, the close cross in the top right hand corner, click on that, 

and I will close PowerPoint.  So I’m now going to close PowerPoint and then reopen it again.  

When I reopen PowerPoint again, I’ve now, of course, got an entry in my recent presentations 

list.  But even so if I ignore that and go to Open other presentations, I will still, again recent 

presentations appears here and there’s the one presentation that I’ve worked on so far, click on 

that, and the presentation opens again.  Now note in this case I get the resume box on the right as 

well, but it knows that last time I looked at this presentation I looked at Slide 2.  So it’s updated 

that to Slide 2.  If I click on that it’ll take me straight through to Slide 2 this time. 

So in this section you’ve seen how to open a presentation, some of the basic structure of the 

PowerPoint 2013 workspace.  You’ve seen how to close a presentation and how to use the recent 

presentations list.  In the next section, we’re going to actually do some work on a presentation, 

make some changes, and fill in some more of the details of the PowerPoint 2013 workspace.  So 

please join me for that. 
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Video:  Backstage View; Protecting Presentations; Editing Properties 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at the PowerPoint 2013 workspace in a little bit more detail. 

Now the first thing I want to do is to look again at Backstage View; so click on the File button, 

that takes us into Backstage View, and the main categories of things that we can do in Backstage 

View are listed down here on the left.  Now some of these we’re going to be looking at in a lot of 

detail later on, but I just want to concentrate for the moment on the main ones and generally 

introducing you to the ideas behind Backstage View. 

The fundamental idea behind Backstage View is that it’s the area where you do things to a 

presentation that aren’t actually part of the presentation.  Give you a good example of that; one 

of the things you can do from Backstage View is to print a presentation.  Now if I select the Print 

option in Backstage View, I get a lot of other options that I can select from.  So I can choose, for 

example, which printer I want to use, how many copies I want to print, and various other 

settings.  And we’ll be looking at the print option in quite a bit of detail later on in the course.  

But the important thing here is that having chosen Print we then have a number of print options 

to choose from and we can control specifically the way that we print a particular presentation. 

Now each of the options in Backstage View requires its own additional information and gives us 

access to different facilities and features of PowerPoint 2013.  So it’s time for a quick tour of 

Backstage View. 

First of all, right at the top there is a left pointing arrow and if I click on the left pointing arrow 

that takes me back to a presentation.  So whichever presentation I’ve accessed this from, press 

the arrow, and I’m back in the presentation again.  Click on File and I’m back in Backstage 

View.  The next category down is Info.  Now Info is extremely important and a couple of things 

in this we’re going to be looking at in quite a bit of detail.  I’m going to come back to Info in just 

a few moments from now.  We’ll go down to New.  New is the area here I can access what I 

effectively saw on that start screen.  So I can choose to start a blank presentation or I can choose 

one of the listed templates or indeed I can search for a template.  We’ll be using templates later 

on in the course for creating new presentations and, in fact, we’re going to create a new 

presentation from a blank quite soon.  Open; we’ve already seen.  It gives us access to opening 
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either recent presentations, ones that are stored on SkyDrive, or any presentations that are stored 

on our computer or a device accessible from it such as an attached external drive or a network 

drive for example.  We click on the Save option here to save the current presentation.  Click on 

File to get back into Backstage View and if I want to save the presentation that I’m working on 

under a different name, I use Save As.  We’ll look at Save As in a couple of minutes from now.  

Print we’ve talked about.  Let’s have a look at Share. 

Now if I click on Share, I’m presented with a number of options and which options are available 

will depend on things like whether I have setup my SkyDrive.  The sharing options are to do 

with making a presentation available to other people either to view or in some cases to work on, 

maybe to read it or to change it or maybe to mark up comments about it.  Sharing is something 

we’re going to look at in quite a lot of detail later on in the course. 

The next option is Export and there are various options for exporting a presentation.  Again, 

we’ll look at these later on but we can, for example, export a presentation in PDF format or we 

can do a package presentation for a presentation to go on to a CD for example.  We can also use 

it to create some of the material that go with a presentation, such as creating handouts. 

And then one other option down here we have is Close which we’ve already used to close a 

presentation.  Now there are two other options down here, Account and Options, and I’m going 

to look at both of those a little bit later on. 

So let’s now go back and take a look at Info.  Now there’s a group of three buttons here.  Mainly, 

I’m going to cover these later in the course but one of them I want to cover now and that is 

Protect presentation.  Now if you’re working on a presentation and you want to protect the 

contents either for security or confidentiality reasons or maybe just because you’re not ready to 

show the world the contents of your presentation yet and you don’t want prying eyes to see what 

you’re working on, then you can protect the presentation by encrypting it with a password.  So 

click on Protect presentation, click on Encrypt with password, and you see this little dialog.  

Now part of this dialog is a very important warning.  Caution:  If you lose or forget the password 

it cannot be recovered.  It is advisable to keep a list of passwords and their corresponding 

document names in a safe place.  That is a very important warning. 
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So what we’re going to do now is to apply a password to this document.  Now I recommend that 

you use a reasonably complex password, one that may be relatively easy for you to remember 

but which will be difficult for somebody else to guess. As a general guideline, I tend to go for at 

least six characters.  One of those characters or more would be a numeric digit and nowadays I 

generally tend to put in some kind of punctuation character as well.  So the password I’m going 

to use here is T-O-B-Y-A-1, hyphen, click on OK.  You’re then asked to enter it a second time.  

This is to cover a situation where you might have typed it wrongly the first time.  You may have 

thought you’d entered the password but you made a mistake.  Bear in mind that passwords are 

case sensitive.  So you may accidentally, for example, have had the caps lock key on.  But let me 

type that again, T-O-B-Y-A-1, hyphen, click on OK, and notice that the message next to that 

button has now changed.  It now says a password is required to open this presentation.  So what 

I’m going to do now is to close the presentation and then reopen it.  So click on Close.  

PowerPoint asks me, do you want to save the changes?  Well, it’s very important now that I do 

save the changes because the main change that I have made is to apply a password; so click on 

Save.  The presentation has been closed.  What I’m going to do now is to reopen it.  So back into 

Backstage View, recent presentations; this time, of course, before I work on the presentation I 

need to enter the password.  So it’s T-O-B-Y-A-1, hyphen, click on OK, and I can access the 

presentation. 

Now if I want to remove the password it’s pretty straightforward.  Go into Backstage View 

again, back to the Info page, click on Protect presentation, Encrypt with password, and all I need 

to do is to clear that password box so that it’s empty, click on OK, and now the presentation is 

not protected by a password. 

So let me now go back into the presentation itself and I want to show you a couple of other 

things about the workspace and in particular I want to look at the very bottom of the display and 

you can see down here what’s called the Status Bar at the bottom.  Now the status bar which is a 

sort of orangey-red in the one that you can see here; I’ll talk about these color schemes later on 

in the course.  But there is information on the status bar which is very useful.  Much of it is going 

to make a lot more sense later on in the course, but I’m going to give you a very quick overview 

of it here.  
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Let’s look at the left hand end of the status bar first.  There is a count showing you which of your 

slides is currently selected and how many there are in total.  So here it’s saying Slide 1 of 3.  The 

little symbol there relates to spell checking and review of grammar.  We’ll come back to that a 

little bit later on.  But then we have the language.  This particular presentation has been prepared 

using the language of English United States. 

So at the right hand end of the status bar we have another batch of useful pieces of information 

and some of these are actually controls that we can use, particularly the group in the middle 

which is a set of buttons that enable us to change the view of the presentation.  Now we’re going 

to be talking about views of presentations later on.  We’re currently in what’s called Normal 

View but there are three or four other alternatives that you need to be familiar with.  To the left 

of those view buttons, we have Notes which we can click to enable us to enter notes to go with 

the presentation.  Comments where we can access the comments related to a presentation.  So if I 

were reviewing this presentation, I could have my own comments or I could look at comments 

that other people had made.  And then towards the right hand end, we have the zoom controls 

that let us zoom in and out of a presentation to be able to take the broader view or a more 

detailed view of a slide or indeed of the whole presentation set.  Now we’re going to come back 

to zoom later on in the course as well. 

So having taken that tour of the PowerPoint 2013 workspace, let’s now just go one back one 

more time into Backstage View and the Info category and look at the right because on the right 

we have Properties and the properties are the properties of the presentation that we’re currently 

working on.  This is often called the metadata of a presentation.  It’s data about the presentation 

rather than data that’s in the presentation.  Now the basic metadata is listed here on the right.  So 

the title by default gets its title from the first slide in the presentation.  The author is here.  The 

identity of the last person to modify it is here.  We also have a space here for tags, categories. 

We keep track of when it was last modified, when it was created, and so on.  If you click on 

Show all properties at the bottom, you get additional properties such as company, subject, which 

template was used.  And if you click on the drop down to the right of the word Properties up 

there and say Show document panel, a document appears above the slides showing you 

whichever properties have been defined for this particular presentation.  Now the most 

commonly used properties are here.  So for instance, the author, the title, the subject, and so on.  
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I’m going to change the title of this one and I’m going to call it PowerPoint 2013 Example 02.  

I’m not going to enter any of the other information.  But if I look at document properties, there’s 

a drop down to the right there, click on that for advanced properties, and I see a dialog which has 

a lot more advanced properties in it; so there is a summary where again I can enter information in 

pretty much the same way.  So for instance, I can put the company name in there. Statistics about 

the presentation, how many slides, how many paragraphs, how many words; it will even tell me 

what presentation format it is.  In this case, it’s widescreen.  And how much time I’ve spent 

editing it.  It gives information about the contents, the fonts used, the theme that’s used, the slide 

titles, and then I can define custom properties as well.  So as we’ll see throughout the course 

when we add to some of these properties, we can define some fairly comprehensive properties 

that we can use to analyze our work and to locate particular presentations and so on.  Once I’ve 

made any changes to the metadata, the properties of the presentation, click OK, those properties 

are saved. 

On the right of the panel here, there’s a Close button that I can use to close the document 

information panel and then if I go back into Backstage View on the Info page, click on Show all 

properties.  The changes I’ve made such as the company name and so on are shown there. 

Now you notice that when I entered a title for this presentation I called it PPT 2013 Example 02.  

I’m now going to save this presentation using that different name and what I’d like you to do is 

to open example-01, add your own metadata to it, so change my name to your name, put in your 

own company name, or define any of these other items of metadata such as putting in a subject, 

add in some tags, put in some comments in, and then save this as a different presentation.  Now 

example-02 in the provided files is the example that I’m saving here and so if you save it as 

example-02, you will delete the one that comes with the course.  So you may want to call it 

example-01A or something like that.  But if you watch now how I save it as example-02, it’s 

pretty straightforward.  I’ve made the metadata changes, I click on Save As, choose as a location 

the current folder which is the folder that the example files are in, and I’m going to save it as 

example-02.  Of course, there’s already an example-02 here because like you, I’ve got example-

02 with the course.  So when I click on Save, it says PowerPoint example-02 already exists.  Do 

you want to replace it?  I’m going to say Yes.  That’s now saved and I can see that it’s example-

02 because it says that in the title bar at the top. 
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So that’s the end of this section.  I’d like you to make sure that you’ve saved a 01A or a 02 or 

even a completely different name if you like and I’ll see you in the next section. 
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Chapter 4 – Help 

Video:  Online and Offline Help 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

Help and Help has actually changed quite significantly in Office 2013 in general.  For example, 

if you’ve used, say, Office 2010 including PowerPoint 2010 in Backstage View, you would’ve 

seen an option down here for Help.  There is no such option in Office 2013.  Instead, there is a 

fairly consistent way of obtaining help which is this little question mark here brings up the 

appropriate help.  Now you notice this with the screen tip here, Microsoft PowerPoint Help and 

then in brackets F1.  F1 is the keyboard shortcut to bring up Help.  So wherever I am if I press 

the F1 key on my keyboard, I invoke Help. 

Now what we have here is the online Help for PowerPoint 2013 and one of the options here is 

Search online Help.  This is basically a browser based system of help and wherever you are, 

whatever you see when you fire up this online help, you can search for help on any topic related 

to PowerPoint 2013.  But depending on where you actually invoked Help either by clicking that 

question mark or pressing, the F1 key the Help is generally contextual in nature.  That is it tries 

to give you help on what you’re doing at this time.  Now when I press the F1 key just now, I was 

looking at the Info category within Backstage View, Protect presentation, Inspect presentation, 

versions, and so on.  And if you look at the Help, you’ll see that the topics on the Help I can see 

here generally relate to those subjects.  If in fact I wanted help on something all together 

different, so for example let’s suppose I happen to be on that page but I wanted to find out about 

templates which are nothing to do with that page really, I could just type in here Templates and 

then press the magnifier and Help searches for Help topics related to templates.  Now when I 

find a particular topic, say, this one, Where do I find templates, the link then takes me through to 

the online help related to templates.  So let’s just try that.  If I click on Where do I find templates, 

there is the Help topic.  I can work my way through that.  There will be further links within that 

to take me through to other information and also things like tips in an Office 2013 program 

choose a template from the new start screen. 

Now as I work my way through the Help trying to find the help that I need, as I mentioned 

earlier this is a browser based system so I can press the back arrow here to go back a page.  
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When I’ve gone back a page, I can press the arrow to go forward a page.  There is a Print button 

there if I want to print a particular topic.  And if I want to increase the size of the font, the text 

that I’m looking at when I’m reading the help, there’s a button here “Use large text” which will 

give me the help in a larger text form.  Click it again to go back down to the regular size.  At any 

time, I can go back to Home on the Help by clicking on this Home button. 

And in fact, if you’d like some more background information about PowerPoint 2013 including 

some free training, some learning for PowerPoint basics, tips for tablets, how to use the 

PowerPoint web app that we’ll look at later on in the course, and a list of keyboard shortcuts, 

looking at what’s new.  There’s some great links here that you should find very helpful.  The 

Home page for PowerPoint 2013 Help also lists some of the most popular searches for Help in 

PowerPoint 2013. 

Now I should emphasize here that this is online help that’s available when you’re connected to 

the internet.  If you’re not connected to the internet, you will not get this help.  What you get 

instead is offline help which is a very restricted form of Help which basically gives you access to 

information about how to locate things on the Ribbon and not very much else at all I’m afraid. 

The other thing to point out in relation to Help which is really just an extension of what we 

looked at so far is if we take the Info page here again and click on Properties, one of the options 

was advanced properties.  This is another route to get into that dialog with the advanced 

properties in it.  In earlier versions of PowerPoint, you will normally have had a button here 

saying Help, something of that sort within a dialog.  These buttons no longer exist in PowerPoint 

2013.  What you have instead is the same little question mark up here.  So the question mark is to 

the left of the Close button in this case; so click on the question mark and it brings up the 

PowerPoint online Help, again, provided that you’re connected to the internet.  And again, this is 

contextual.  So having clicked it from that Properties dialog we see a link, View or change the 

properties for an Office file.  And this is actually related to Office 2013 components in general in 

terms of the properties of documents, not restricted only to PowerPoint in this case.  So the 

dialogs that we’re going to see throughout PowerPoint 2013 will all share this feature in common 

as well. 
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So let’s now go back to the Home for the Help system and then look at a couple of very 

important items that we access from Home.  And let’s start with one of the ones I mentioned 

earlier which was keyboard shortcuts.  Now I must confess that I am not a great user of keyboard 

shortcuts myself.  I use a certain number and they tend to be the ones that are the same across 

many pieces of software, things like Control-C to copy or Control-V to paste.  But as you’ll 

appreciate if you’ve used Microsoft Office before, all of the components have very, very large 

numbers of keyboard shortcuts and I do appreciate that many people use many keyboard 

shortcuts. 

Now I’m not going to cover lists and lists of keyboard shortcuts on this course.  And if you like 

to use keyboard shortcuts, and I appreciate that many of you do, the PowerPoint Help system has 

a nice entry about keyboard shortcuts for use while creating a presentation in PowerPoint 2013 

and here it is.  The keyboard shortcuts are categorized and with each category, let’s just scroll 

down here a bit.  Let’s choose the category of Find and Replace.  If I click the plus next to Find 

and Replace, I’ll see the keyboard shortcuts related to Find and Replace.  So to open the Find 

dialog box the keyboard shortcut is Control-F, open the Replace Control-H, repeat the last Find 

action, Shift plus F4.  Now there are many, many of these keyboard shortcuts as I’m sure you 

appreciate.  Some people print them out, stick them on the wall, and use them all the time which 

is fine if that’s how you work.  I’m not going to cover those but the PowerPoint Help is a very 

comprehensive source for those and, in fact, if you scroll down there are some very useful 

general categories such as running a presentation because I think if I were going to do things 

with keyboard shortcuts, something like running a presentation would seem like an excellent 

application.  So the PowerPoint Help is the main source on this course for keyboard shortcuts.  I 

will mention one or two as we go along because one or two of them I think really need to be used 

to save a huge amount of time.  And of course, in many cases you will see the keyboard shortcuts 

because as with the example when we brought up the Help itself, the keyboard shortcuts are very 

often written in brackets after the name of a command and when we come to the Ribbon, we’ll 

quite often see the keyboard shortcuts marked there as well. 

So it’s back to Home in the online Help again and the other main area of Help that I want to 

point out to you now is the bottom right hand one here, Tips for tablets.  Now, Tips for tablets is 

an absolutely excellent place to start if you’re going to be using PowerPoint 2013 with a tablet.  
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There are descriptions of the main gestures such as tap, pinch, stretch, slide, swipe.  We’ll be 

using all of those during this course.  And then there are some general comments about how to 

do certain things in Office programs; for example, how to switch to full screen in an Office 

program.  We’ll be looking at quite a few of those.  How to move around in a file, make a 

selection, work with shapes and objects.  And then there are specific examples and gestures 

related to Excel and then particularly related to PowerPoint.  So how to zoom into a slide, how to 

zoom out of a slide, and we’ll be looking at quite a few of these as we go through the balance of 

the course.  In the meantime, I suggest this is a great place to look if you’re using a touch device 

and you want to find out a bit more about how to make the most of the touch device with 

PowerPoint 2013. 

When you’re using online Help in PowerPoint 2013, it is a separate browser window.  When you 

finish with it, just click on the Close button at the top right, the browser window closes, and 

you’re back to whatever you happen to be doing when you asked for help.  That’s it for this 

section.  I’ll see you in the next one. 
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Chapter 5 – PowerPoint Options 

Video:  Customize Settings and Preference 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

the PowerPoint Options.  Just before we do that let me just give you a useful little tip.  If you 

have some files, say, here in the recent files list, the recent presentations list, if you hover over 

them, you’ll normally see a little pin on the right.  Let me just hover over that pin and you’ll see 

it says Pin this item to the list.  Now where it says Pin this item to the list that’s called a Screen 

Tip, and screen tips we’re going to be talking about in this section.  But if you do pin this item to 

the list, what it means is that that item will stay on the recent files list until you unpin it from the 

list.  If you tend to work on a lot of presentations and it may be the case for example that you 

very often go back to an old one to use as a basis for starting others, by pinning it, it stays in the 

recent files list which otherwise just shuffles through; so ones that you haven’t worked on for a 

while will tend to shuffle off the bottom of the list.  That’s a way of pinning it to the list to stay 

there and then when you no longer need to pin it to the list hover over, unpin, and it’s unpinned 

from the list and it will remove itself from the list at the appropriate time. 

So anyway let’s now select that particular presentation, open it, and then go into Backstage View 

and I mentioned to you earlier on that one of the options we’d come back to is indeed Options 

down at the bottom here.  So let’s click on Options. 

Now I should point out that sometimes this PowerPoint Options dialog appears at other points 

where we’re using PowerPoint 2013.  Sometimes when we have to make a decision about 

something, this Options dialog will pop up and we’ll need to change or set something in that 

dialog.  So the dialog is arranged into pages and the pages on the left, General, Proofing, Save, 

Language, Advanced, etc.  And whenever we change something here to commit the change, to 

actually make it happen, we use the OK button which is at the bottom of the dialog.  So it’s a 

standard type of dialog.  And if you decide not to go ahead with the change you were going to 

make, hit the Cancel button to cancel that particular change. 

So what is the PowerPoint Options dialog for?  Well, the reason for having this is to enable you 

to customize your installation of PowerPoint 2013 and the customization takes several different 
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forms.  One very important aspect of the customization is identification.  And on this General 

page, roughly halfway down there is my user name and my user initials.  And your user name 

and initials should appear in the equivalent place in your set of PowerPoint Options in your copy 

of PowerPoint 2013.  I can also in that same section of the General page of the PowerPoint 

Options specify which Office background I want if any.  There are several to choose from.  I’ve 

got no background, but there are many others that I could use.  And I can also decide which 

Office theme I want.  It’s a choice of white, light gray, or dark gray.  If you are considering 

changing the background or the theme, I suggest you experiment with those and see which of 

them you like.  I tend to go for the white and very plain types of background in what I do. 

Now let’s take a look at a couple of the other options on this General page.  In the user interface 

options section, at the top there are two options.  There’s show mini toolbar on selection and 

enable live preview.  Now with both of these we’re going to come back to them later on because 

both of them will make more sense later on.  But I’m just going to hover over enable live 

preview now and you will see its screen tip.  It says Enable live preview; that is effectively the 

screen tip.  And then there is a description, Show a preview of how a feature affects the 

document as you hover over different choices.  Now within the PowerPoint Options dialog, you 

always see those screen tips and their descriptions.  But let me now go and look at a screen tip on 

a regular command on the Ribbon.  So I’m going to click on OK on the PowerPoint Options and 

I’m going to click over one of the buttons on the Ribbon on this particular presentation.  I’m 

going to go up and hover over that one, and what you can see there is a screen tip.  It says 

Shapes.  Now, let me go back into Options again.  On the General page, the third option there is 

screen tip style and it says don’t show feature descriptions in screen tips.  If I change that to, say, 

Show feature descriptions in screen tips. Click on OK, then go back to that same command 

again, hover over it, I now get Shapes.  Insert readymade shapes such as circles, squares, and 

arrows.  And then I can even click on Tell me more and it brings up the PowerPoint Help and it 

will tell me all about that particular option.  Add shapes, PowerPoint takes me through to a fairly 

comprehensive help about using that feature.  So that’s what showing the description with screen 

tips causes to happen. 

Now let me go back into the Options again and from the Options this time, instead of Show 

feature descriptions in screen tips, I’m going to select Don’t show screen tips.  Click on OK, 
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hover over that again, and I get nothing at all now; I get no kind of screen tip at all.  And this 

example effectively shows the second main category of PowerPoint Options and probably the 

one that’s most numerous and this is where you make a very subjective decision about how you 

like PowerPoint 2013 to work.  Do you like to see screen tips or not?  If you do, do you like to 

see the descriptions?  It may well be that when you first use PowerPoint 2013 you like to see the 

descriptions to remind you of what each of those commands does.  But then when you get more 

used to it, you know pretty much how all the commands on the Ribbon work, you don’t need 

those screen tips and their descriptions anymore, and sometimes they can get in the way.  When 

you’re working on something, they may appear over a piece of work that you’re doing and 

actually can be a little bit of a nuisance.  So a lot of the PowerPoint Options relate to personal 

preferences. 

And a very prominent one of those personal preferences is right at the bottom of the General 

page, Show the start screen when this application starts.  If you don’t want that start screen 

where you choose from recent presentations, open a presentation, the array of templates that you 

can use.  If you uncheck this box, next time you start PowerPoint, you won’t see the start screen. 

Now regarding the other PowerPoint Options, many of them we’re going to come back to later 

on.  So for instance the Proofing page which relates to Auto-correction which we’ll come back to 

when we talk about checking spelling and grammar; we’ll look at these option.  The Save 

options also we’ll come back to.  One or two of these you may want to take a look at now, for 

instance roughly in the middle there, “Default local file location” specifies where your 

presentations are saved by default. 

But one that you will need to check now is Language.  Now it’s important when you’re working 

in PowerPoint 2013 that you are working in the correct language.  I have two editing languages 

setup.  I use pretty much alternatively English United States and English United Kingdom 

roughly the same amount.  You need to make sure that you have the correct language set.  There 

are many languages.  If you look at the drop down below this main panel, Add additional editing 

languages, click on the drop down, there is a long list, and you need to make sure you’ve got the 

right language for you set there or the tools associated with the language you want and the 

general structure or the language you want will not be correctly set.  When you do have more 

than one language setup, you can set one of them as the default.  I have English United States set 
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as the default for me, and you can basically install as many as you like and switch between them.  

Of course, different presentations that you work on may be in different languages.  So you need 

to have setup all of the languages that you use when you’re working in PowerPoint 2013.  

Associated with this are things like which language do you want the screen tips in?  If you look 

at this entry down at the bottom here, you may be preparing a presentation, say, in French or 

Spanish but you may still want the screen tips to appear in English. 

So as I mentioned earlier on, several of these options we’ll come back to as we get to the 

appropriate point in the course.  On the Advanced tab, there are a really large number of very 

specific settings.  Some of them will mean a lot now.  So in the Display section at the beginning, 

Show this number of recent presentations.  Currently set by default to 25.  You could show more 

or less presentations.  Note the screen tip there that tells you that you can have any number of 

presentations between zero and 50. 

Customize Ribbon is another page; Quick Access Toolbar another one.  We’ll come back to 

those in a little while.  Add-Ins which we won’t be covering on this course.  But we will talk 

about the Trust Center briefly towards the end of the course.  So that in outline is the PowerPoint 

Options.  There are two or three there that you need to go through and make sure that you’ve got 

correctly.  The others we’ll come back to as we need them later in the course.  And that’s the end 

of this section.  I’ll see you in the next one. 
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Chapter 6 – The Ribbon and Toolbars 

Video:  The Ribbon 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to start to 

look at the Ribbon and toolbars.  And in this section in particular, we’re going to concentrate on 

the Ribbon.  And the Ribbon is very much the center of the interface between you and 

PowerPoint 2013.  If you’ve used the Ribbon before, you’ve maybe used a recent version of 

PowerPoint or another component of Office, then you’ll understand the basic principle of the 

Ribbon.  But I should warn you that it has changed in Office 2013 and the first thing we’re going 

to look at is what is probably the most significant aspect of that change. 

So I pointed out to you what and where the Ribbon is earlier on in the course and above the 

Ribbon there is the Quick Access Toolbar.  And on the Quick Access Toolbar one of the buttons 

has a pointing finger.  To the right of that pointing finger, there is a little drop down arrow and if 

we click on that we are given the choice between mouse and touch.  Now I’m currently in what 

we’ll call mouse mode.  If I click on touch and go into touch mode watch what happens to that 

Ribbon.  Basically everything gets spaced out more.  The Ribbon has lots of little commands on 

it, which we’re going to talk about in a moment, but they’re all spaced out more and that is to 

give you room to touch those commands and those buttons with your fingertips rather than using 

the relative accuracy of clicking with a mouse. 

We’re now going to look at the Ribbon in detail but you may want to go into the right mode for 

you first.  So if you’re using touch, go up to that drop down, go to touch.  If you’re using the 

mouse, click, go back into mouse mode. 

Now one thing to note about the Ribbon is these little command buttons that I’ve talked about.  

They’re all rather gray looking at the moment and the reason they’re rather gray looking is that 

we don’t have a presentation open.  So the first thing I’m going to do now is to open a 

presentation.  Now once I have a presentation open, the situation changes because now I can see 

that some of the buttons are dark and some of them are still gray.  And basically the difference is 

that the ones that are dark you can see the words on them and the actual buttons themselves are 

basically black rather than gray, they are enabled.  Now if you look at this button here it says 
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New slide.  If I wanted to create a new slide, I would click that button.  And at the moment, I can 

create a new slide.  I’ve got three.  If I clicked that, I’d get number four.  But all of the buttons 

here, this whole group of buttons here, they’re all gray and I can only use those when I have 

something selected.  Normally, I would have some text selected, because they’re the buttons that 

I use to change the font in use on some text in a presentation.  So the first thing to note is that 

some of these buttons are useable and some of them are not, and you can tell whether they are 

enabled like these ones or disabled like these ones.  We sometimes say disabled; we sometimes 

say grayed out. 

So what of the Ribbon itself?  Well, at the top of the Ribbon you see these words:  Home, Insert, 

Design, Transitions.  At the moment, you can see that Home is highlighted and this is the Home 

tab.  When we click on one of these, so in this case Home, we see a particular set of content on 

the Ribbon.  Now the content here is arranged into groups and the first group, the group on the 

left here on the Home tab is the Clipboard Group, then we have the Slides Group, the Font 

Group, the Paragraph Group, etc.  Now if I click on the next tab, the Insert tab, I have different 

groups.  I have Slides, Tables, Images, Illustrations, etc.  And the Design tab has its own groups, 

etc.  So one of the features is we have all these tabs and on each tab there are a number of 

groups.  Now with the groups, we have a number of different commands and the commands take 

different forms.  Some of them are very straightforward commands where you basically just 

click a button.  I mentioned now New slide.  That’s actually a command that’s in two parts.  If 

you just click the top part watch what happens here, our new slide, all that happens is I get a new 

slide.  Some of the other commands need quite a bit more work done on them.  For instance, if 

you look at the Clipboard Group in the bottom right hand corner, there’s a thing called a Dialog 

Box Launcher and if I click on that Dialog Box Launcher and you’ll see that other groups have 

Dialog Box Launchers as well, although not all groups do.  What that does is to bring up either a 

dialog box or an additional panel and we follow some instructions or make some selections in 

order to carry out whatever operation we need to carry out.  So what happens when you click 

something on the Ribbon varies quite a lot.  Now obviously during the course we’re going to be 

looking at many of these commands and what they do so I’m not going to go into them in great 

detail now.  But it’s important to recognize that different commands work in different ways and 

sometimes they’re a single click, click once something happens, in others you’re actually starting 

off quite a long chain of events and operations. 
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So what I’ve just done is to insert a picture on to this slide.  You’ll see how to insert pictures 

yourself later on.  But not that if I select that picture, so if I click on that picture, what happens is 

apart from the picture itself getting this sort of selection rectangle around it is if you look up at 

the Ribbon there is now a new tab.  It wasn’t there before, and it’s what’s called a contextual tab.  

It’s the sort of tab that only appears under certain circumstances.  One of the circumstances in 

which contextual tabs appear is if you have a picture selected and then you have tabs that come 

under the heading of picture tools and the tab you see here is the Format tab.  Now with that tab 

visible, you can select it and then you have a number of commands arranged into groups that are 

appropriate for formatting a picture, hence the name of the tab.  There are various other things 

you can do such as insert a table and in each of those cases you will get contextual tabs.  So 

although we have a basic set of tabs which are basically the ones from Home to View plus 

another one that we haven’t seen yet.  There are also in addition contextual tabs that appear 

depending on the situation that applies at that time. 

Now one thing you may be aware of if you’ve been using the Ribbon for a while or even if 

you’re new to the Ribbon you may look at it now and say the Ribbon actually takes up quite a lot 

of space doesn’t it?  If you’re trying to work on something where you need to see a lot of detail 

you don’t want to lose probably about 15%, 20% of the working area to the Ribbon.  Well, 

certainly once you’re used to using the Ribbon you can overcome this in a couple of ways.  One 

of the ways is to basically minimize the Ribbon, which doesn’t stop you using it; it just means 

you use it in a different way.  If I hover over this little arrow to the bottom right hand corner of 

the Ribbon, you’ll see that its screen tip is Collapse the Ribbon.  Need a bit more space?  

Collapse the Ribbon so only the tab names show.  If you click on that you certainly have more 

space to work in.  You may say well, how do I execute the commands because I can’t see them 

anymore, they’ve all disappeared?  The answer to that is that if you know where your commands 

are then you click on the appropriate tab.  Let’s suppose I want to do something on the Home 

tab, click on the Home tab and once you’ve clicked on it, the Ribbon appears until you execute 

one of these commands.  So you can actually say, right, I want to arrange some shapes or I want 

to put in a new slide.  Once you’ve executed a command, the Ribbon will then collapse back 

down again and move out of view.  So that’s one very good way of making more space available 

to work in PowerPoint 2013. 
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Now if you do decide to work in that way, then if you need to revert back to having the Ribbon 

visible all the time, the button on the bottom right hand corner of the Ribbon now says Pin the 

Ribbon.  Like seeing the Ribbon?  Keep it open while you work.  If you click on that again, then 

the Ribbon is now visible all of the time and doesn’t auto-collapse anymore. 

And there is another and more flexible way of achieving the same thing now in PowerPoint 

2013.  To the right of the Help question mark up here, there is a button that’s called the Ribbon 

Display options.  If I click on Ribbon Display options, you see I have three options:  Auto-Hide 

Ribbon, Show tabs, and Show tabs and commands.  Now Show tabs and commands basically 

means the Ribbons is there and open all of the time.  Show tabs is really the collapse version that 

we just saw.  Show Ribbon tabs only, click a tab to show the commands.  That’s what we did just 

now.  Now the third option, the top option, Auto-Hide Ribbon is one where the Ribbon is hidden 

all of the time and there is then a button to click at the top of the application to show the Ribbon 

again.  Now I can’t actually show you that because the way that this works in PowerPoint 2013 

is incompatible with the software that I’m using to record this course.  But give it a try yourself.  

It’s very straightforward.  You click that option, you no longer see the Ribbon or the tabs, but 

you do have a button that you click very similar to the one that you can see now at the top of this 

little mini menu.  You click that and then you can reset to one of the three options.  Obviously, if 

you want to go back to just showing the tabs you choose the second option or the lower option if 

you want to show tabs and commands. 

If you’re new to the Ribbon and perhaps if you’re new to PowerPoint or PowerPoint 2013, at 

least you may want to leave the tabs and commands visible for the moment. But as you’re skills, 

knowledge, and experience grow, you may find that you know where the commands that you use 

are on the tabs and you don’t really need to see the full Ribbon all of the time.  The other thing to 

bear in mind as we’ll see later on and during the rest of the course is that very often you can 

execute the commands you need without even using the Ribbon.  Let me show you a particular 

example of that.  I’ve still got this slide with a picture.  If I right click on the picture, what I see is 

a contextual menu and that menu contains many of the commands and options that I may want to 

apply to this picture.  Now exactly what appears on the menu depends on what I right click on, 

hence the term contextual.  But it will certainly cover the main things that I may want to be able 

to do to this picture.  This means that I could use the contextual menu instead of the Ribbon; for 
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example to change the size and position or to go into formatting the picture in some way.  Now if 

you want to do the same thing with touch, note that if I were say outside the slide, so let me tap 

outside the slide with my finger.  To select this picture, I just tap once to bring up the selection 

handles.  If I now tap again, I bring up a mini toolbar.  We’re going to talk about mini toolbars 

later on, but at the right hand end of that there’s a little drop down arrow.  If I tap on the drop 

down arrow, then I get a contextual menu using touch.  Now the commands on that are different, 

but the principles the same and generally speaking, you can achieve the same things by using this 

approach with touch.  And again, this avoids the need to use the Ribbon to perform the most 

common operations on this picture. 

So there’s just one other thing to look at in relation to the Ribbon before we move on; if I right 

click on the Ribbon, one of the options is Customize the Ribbon.  Click on Customize the 

Ribbon and what you see is the PowerPoint Options dialog with Customize Ribbon selected.  

Now on this page, you have on the right a panel and that panel lists all of the main tabs at the 

moment.  See main tabs is selected at the top.  Now the Home tab is first on the list and within 

that we have a list of all of the groups on the main tab.  So there’s Clipboard, Slides, Font, and so 

on, as we saw earlier on.  If I click on the plus sign next to a group, I can see the commands that 

are included in that group.  And in some cases, those commands are further subdivided or 

subcategorized.  This is currently the default setup for PowerPoint 2013.  The Ribbon tabs that 

you can see here are the ones that appear by default.  There is one standard tab that is not 

currently shown and that’s the Developer tab.  I mentioned to you earlier on in this section that 

one of the tabs you couldn’t see, that’s Developer.  If I wanted to show the Developer tab, I 

would tick here and click on OK.  The reason the Developer tab is not shown by default in 

PowerPoint 2013 is because it’s primarily associated with programming, with VBA, and 

therefore if somebody wants that, they’re going to know that’s what they need and they’re going 

to enable it.  And it can tend to be a little bit dangerous in the hands of people who perhaps aren’t 

fully aware of what they might do with the Developer tab.  I’m going to uncheck it for now 

because we’re not going to need it on this course. 

Now as we’ve already seen apart from those main tabs there are other tabs such as contextual 

tabs.  We saw earlier on, in fact you can just see it peeking out the top here, the Format tab when 

you have an image or picture selected.  But the pattern’s the same; each tab can have groups on it 
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and each group can have commands in it.  The list of available commands is in this big long box 

on the left here.  It’s a very long list.  This list is only popular commands.  If you actually look at 

All commands, you would see that in PowerPoint 2013 there are many commands. 

And you can create your own tab.  There’s a button down there, New tab.  On your tab, you can 

create a new group.  You could rename that group and you can move commands from the list on 

the left into your group or into your groups on your tabs.  So you can basically build up your 

own sort of extension to the Ribbon. 

Now that is outside the scope of this course.  I really wanted to show you that this is possible 

without going through in any detail how to do it.  If that is going to be of value in the future, then 

it’s certainly something you can look up on the internet or in fact if you look at the PowerPoint 

Help, it gives you some good information about how to do that.  One of the areas, one of the 

situations where I think this can be very useful is if you routinely use a particular combination of 

commands when you’re doing the work that you do and those commands are on different ones of 

the standard tabs.  You can create your own tab with perhaps four or five groups and each of 

those groups has some of the commands that you need for these standard processes that you 

perform, and I think that kind of thing can be very useful.  But as I say, customizing the Ribbon 

is outside the scope of this course and that’s really it on the Ribbon for now.  In the next section, 

we’re going to look at the Quick Access Toolbar.  So please join me for that. 
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Video:  Quick Access Toolbar 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at the Quick Access Toolbar. 

Now one aspect of using the Ribbon is that not all commands are visible all of the time.  And to 

some extent when you’re working on a presentation, maybe quite a complex presentation, you 

can spend quite a bit of time just flicking between the tabs and choosing the commands and 

groups that you need to use.  Some of the things you do in PowerPoint tend to be done quite a 

bit.  For example, if you want to regularly save your work, you need access to a command to 

save your work.  And if you’re like me and you tend to make a good few mistakes when you’re 

working one of the features of PowerPoint 2013 is the ability to undo and I like access to a very 

straightforward button I can push to undo something.  Now that’s really what the Quick Access 

Toolbar is for, quick access.  You choose a few commands, the ones that you use very 

frequently, and you have them available on this little bar at the top left hand corner of the screen. 

So let’s take a closer look at this Quick Access Toolbar.  At the right hand end of the bar, there’s 

a little drop down arrow with a little bar over it.  If I click on that, the screen tip says Customize 

Quick Access Toolbar.  Click and what you see is a list of commands and these are the 

commands that by default are available to show on the Quick Access Toolbar.  And you’ll see 

that some of them are ticked and some of them are not ticked.  The ones that are ticked are Save, 

Undo, Redo, Start from beginning, and Touch/Mouse Mode, and basically what this means is 

that they’re the ones you can see at the moment.  So each of them has an icon; so that one’s 

Save, that one’s Undo, that’s Redo, that’s Start from beginning, that’s Touch/Mouse Mode.  We 

used that button a little bit earlier on in the course.  If I wanted to show one of the others such as, 

for instance, Quick Print, if I click to check it, note the screen tip says Add to Quick Access 

Toolbar, then that will appear on the Quick Access Toolbar.  So check there.  I’ve now got a 

Quick Print button and I get the screen tip, of course, when I hover over it.  And basically that’s 

how you choose which buttons, which commands to show at any time and which ones to keep 

hidden. 

Now in fact you’re not restricted to the list of commands that we just saw on that menu.  Let me 

click on that drop down again and this time I’m going to choose More commands, click, and that 
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takes me into yet another page of the PowerPoint options.  In this case, the page is the one that 

we use to customize the Quick Access Toolbar.  Now I am very quickly going to show you how 

to do this.  It’s actually quite straightforward, although there are quite a few additional features 

that you might use perhaps a little bit further on in your use of PowerPoint 2013.  On the right 

we have a list of the commands that are currently shown.  If I wanted to add a command, let’s 

suppose that I’m always making text bold and I keep having to go back to the Home tab to find 

the Bold button.  Let’s suppose I want to add the Bold button to the Quick Access Toolbar.  On 

the left is a list of what are currently selected, the popular commands, and Bold isn’t one of 

them.  But if I click on All commands and let me just scroll down, B, B, B, B, there we are, Bold, 

and select that.  I can say Add and Bold now appears on the Quick Access Toolbar.  Note that 

not only does it appear there but there are a couple of arrows on the right.  Currently the move up 

is enabled, the move down is disabled.  I can actually decide where I want it.  Say, I wanted it 

between Redo and Start from beginning, click on OK, and now notice on the Quick Access 

Toolbar that I have a Bold button.  It’s currently disabled because I’ve got nothing selected.  But 

if I were to go to one of these other slides, select some text, Bold is enabled.  Click to make that 

text bold.  That shows you how easily you can use one of the commands on the Quick Access 

Toolbar. 

So the way that I would recommend that you use the Quick Access Toolbar is that maybe you 

customize it a little when you first use PowerPoint and then as your use progresses, you may find 

that it suits you to have a different combination of buttons on the Quick Access Toolbar.  It’s 

sometimes the case that you may want to put something there temporarily while you’re doing a 

particular job.  And although we don’t cover programming on this course, it’s sometimes the 

case that access to programs bespoke software that you use via the Quick Access Toolbar can be 

a real time saver. 

Just two other things about the Quick Access Toolbar.  There was one other option on the drop 

down here, right at the bottom, Show below the Ribbon.  This is very much a case of personal 

preference, but some people prefer to have it below the Ribbon.  It’s a bit less of a reach I 

suppose than going right up to the top of the screen, you can just click there to access the 

commonly used commands that you’ve got on the Quick Access Toolbar.  I’m going to put it 

back because I’m quite happy to have it in its conventional position at the top.  And the other 
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thing is if you’ve got a button, in this case the Bold button, and you don’t want it on there 

anymore, click, go to More commands, select it in the list on the right, click on Remove, click on 

OK, and bold has now gone from the Quick Access Toolbar.  So customizing it is 

straightforward both in terms of adding buttons and removing buttons. 

That’s the Quick Access Toolbar.  In the next section, we’re going to take a quick look at mini 

toolbars.  I’ll see you then. 
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Video:  Mini Toolbar 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at the mini toolbar or perhaps it will be more accurate to say the mini toolbars 

because there are sort of two of them, as we’ll see; so, mini toolbar. 

Now at one point in the previous section, we made the content of this line on this slide here bold 

and although we haven’t looked at selecting text at the moment what I’m going to do now is to 

select that line again using the mouse.  So I’m going to sweep across with the mouse and I want 

you to watch very carefully what happens.  Now having made the selection and left the pointer 

over the selection a box, a block of commands appears to the right, the upper right of the 

selection, and that is the mini toolbar.  On it there are a number of commands and they are 

deemed to be the most common or popular commands that I’m likely to want to execute having 

made that selection.  Now you notice on that mini toolbar, the one in the bottom left corner, the 

Bold button is highlighted and that’s because the text we’ve got there is bold.  If I wanted to un-

bold it, I wouldn’t need to go to the Ribbon.  I wouldn’t need to go to the Quick Access Toolbar.  

I could just un-bold it by clicking the button on the mini toolbar; so let’s un-bold it.  It’s now no 

longer bold.  I could also, for instance, make it italic or make the point size much bigger.  So it’s 

currently 18 point.  I could make it say 24 point.  So that is how you use the mini toolbar. 

Now before we look at doing the equivalent with touch, let me just point something out.  If I go 

into Options via Backstage View, you may remember on the General tab the very first option 

there is Show mini toolbar on selection.  And if I uncheck that and click OK, now let me select 

that text again exactly the same way as I did before, leave the arrow pointing at the text.  I don’t 

get a mini toolbar with mouse and keyboard if I have that option disabled.  Not everybody likes 

using the mini toolbar.  Some people find it gets in the way.  And a combination of using right 

arrow and contextual help which includes access to the mini toolbar when you actually do right 

click and using the Ribbon and Quick Access Toolbar is plenty for them; they don’t need the 

mini toolbar as well. 

So let’s do the same thing using touch.  In the case of touch, you can see the markers at either 

end of the selection, those little circles at either end of the phrase, Content of the first slide.  And 

in order to bring up the minibar or mini toolbar when using touch, all I do is tap and hold on the 
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selected text, and what you see now is the minibar.  Now this minibar has a different layout to 

the one that you get using the mouse and keyboard but other than that the function is very 

similar.  So you have operations like cut and copy which are relevant to a selection of text, but 

you also have options to do things like change from italic to bold.  And again, I operate these 

buttons just using my finger.  So let me change that from italic to bold and tap on the I to stop it 

being italic.  And apart from the bar itself, as you can see there, there is a little drop down on the 

right where I can access a contextual menu.  Now exactly what’s on the menu is contextual.  It 

does depend on the particular situation, but that will give you access to some more commands. 

And just one other thing to point out before we move on; in touch mode, as we saw earlier, the 

Ribbon has its commands much more spaced out.  When you’re using the mini toolbars, it’s 

noticeable that the one you get when you use touch has commands that are much more spaced 

out to make it easier to operate with your fingers. 

Okay so that’s it on mini toolbars for now.  We’ll be using those throughout the course.  It’s time 

to move on and have a quick look at customizing the status bar.  I’ll join you in the next section. 
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Video:  Status Bar 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, I’d like to give you a 

quick overview of how you can customize the status bar.  We looked at the status bar earlier in 

the course and at the moment the status bar here at the bottom of the screen has pretty much the 

default information displayed on it. 

So first of all, let me right click on the status bar and what you see is a list of all of the available 

contents for the status bar.  And as you can see, almost everything is ticked which means that in 

theory, it’s shown on the status bar.  In practice, several things are not shown.  Let’s start with 

one or two of the ones that are.  Let’s start at the top.  View indicator, Slide 3 of 4.  Well, you 

can see that the first item on the status bar says Slide 3 of 4 which says that we’re currently 

selected the third slide out of a total of four in a presentation.  One thing that’s not shown is the 

theme of this presentation.  And if I want to show something that’s not shown, so I’ve got 

something that’s not ticked, all I need to do is click on it and now it appears and you can see the 

theme is indeed Celestial.  If I don’t need to show that then again click it to un-show it. 

The next one, number of authors editing, I can’t actually see anything related to that and the 

reason is when something is blank or not relevant, so in this case because there is only one 

person with this presentation open, then nothing appears.  Similarly if I look a bit further down 

the list, I’ve got three items here together:  Signatures, Information Policy, and Permissions.  All 

of these features are actually off.  You can see on the right where all three of them say off.  So 

even though they’re ticked they don’t appear because the features themselves are switched off 

and information about their status is not available.  Whereas if I go back up to Language which is 

English United States and click that, of course, I’ll remove that from its display on the status bar 

and then I can tick it back on again. 

So that’s pretty much how it works.  Anything that’s ticked in theory is shown in the status bar, 

but things where a particular feature is switched off or is not relevant to the current situation will 

actually not appear on the status bar anyway.  So that explains why you’ve got an awful lot more 

ticks on this list than you have items on the status bar at the moment. 

That’s all you need to know about the status bar for now.  I’ll see you in the next section. 
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Chapter 7 – Backup, AutoSave and AutoRecover 

Video:  Backup Files; Adjust AutoSave; Recover Unsaved Presentation 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, I want 

to talk to you about Backup, AutoSave, and AutoRecover and we’re going to look at backup 

first.  And when I’m talking about backup here I’m talking backup if you like in the longer term. 

In the next section, we’re going to start to create presentations and as you create your 

presentations, you’ll be saving them presumably on a drive within the device that you’re using 

and when you finish doing what you’re doing for the day whether you’re at work or at home you 

switch your computer off, you come back again tomorrow or the next time you’re going to work 

on this course and you’re going to open up those presentations and carry on working on them.  

Well, what if when you come back tomorrow you’re computer won’t start?  What if when you 

come back to work next week somebody has stolen the computer you were using or perhaps 

somebody else has used it and accidentally deleted or maybe even deliberately deleted all of the 

presentations that you were working on?  What do you do about that?  Well, what you do about 

that is that you always have at least one backup copy of the work that you’re doing and it is on a 

device other than the one that you are working on. 

Now at the time of writing this, there are many options for taking backup copies of the work that 

you’re doing.  You could, for instance, just copy the work to a memory stick, a USB memory 

stick which would probably hold several gigabytes of data which may be hundreds of 

presentations and which maybe will cost a few dollars or a few pounds from your local computer 

store.  Alternatively, you could have an external drive device.  Again, it could be a USB device 

which may hold up to one or two terabytes of data which is probably going to be millions of 

presentations.  And again that will only cost 50-100 dollars, 50 pounds, something like that.  So 

there really is no excuse for not keeping copies of the work that you’re doing. 

Nowadays many people work in such a way that as they’re working they have an external device 

that is copying what they’re doing to the external device pretty much as they go.  So it’s doing a 

sort of live backup of the data in real time and that’s a good option, particularly if what you’re 

doing is going to be of great value to you.  From my point of view, what I do is I take a backup 
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copy of everything without fail at the end of the day, keep it in two places.  I keep it on my own 

network so that it’s safe at hand, but I also put a copy in, it actually goes in the boot of my car in 

a locked box. 

So you really need to make sure that you keep backup copies of your work and there is no built 

in intrinsic feature of PowerPoint 2013 to do this for you.  There isn’t some magic tool that we 

can switch on, one option we can click somewhere that will take offsite as they’re called, backup 

copies of what you’re doing.  That part of it is entirely up to you. 

For the rest of this section we’re going to be talking about a pair of features called AutoSave and 

AutoRecover.  And they are there to deal with an associated issue and I’ll come back to that in 

just a moment.  But I would like to point out that they are not there to solve the problem that 

we’ve been talking about.  They are not there as a tool for taking backups at the end of the day or 

making sure that you’ve got a copy of a presentation somewhere else.  They’re there for pretty 

much a different purpose all together. 

So let’s look at what AutoSave is about.  No matter how safe you’re working environment, 

things always go wrong.  For example if you’re using a PC rather than a laptop, there may be a 

power failure.  And if you get a power failure, your PC stops working, then the presentation 

you’re working on may be in an indeterminate state.  If that happens, how do you recover 

whatever you lost?  Have you got to start the presentation again?  Another situation that might 

occur is what happens if PowerPoint itself fails?  The current versions of the Office products, the 

Office 2013 versions I’ve been using for some time and I consider them to be relatively for what 

is new software at this time extremely stable pieces of software.  But I know that as with any 

other software, there will come a time when that software will fail.  It may not even be the fault 

of the manufacturer.  It may be something else on my PC that conflicts with it and causes it to 

fail.  But if it fails and I get one of those terrible “Not responding” type messages, again maybe 

my only option is to switch my PC off.  If I’m partway through working on a presentation how 

much of it have I lost? 

And this is exactly where AutoSave fits in.  So, into Backstage View, click on Options, go to the 

Save page, and one of the options not far from the top there, Save AutoRecover information 

every, I’ve got it here 10 minutes.  And what that means is that every 10 minutes while I am 
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working on a presentation, a copy of it is saved automatically.  If PowerPoint fails or the 

electricity fails or there’s some other interruption to my work that isn’t planned and controlled by 

me then when I restart PowerPoint, it can revert back to that AutoSaved version.  And that in 

turn means that at most with this setting, I will lose 10 minutes worth of work.  So it will go back 

to the last point at which the presentation I’m working on was AutoSaved. 

Now I can’t really think of any good reason why you wouldn’t have save AutoRecover 

information set.  In the past, particularly with older computers that struggled a bit more to run the 

more modern versions of Microsoft Office people would say, well, AutoSave slows me down a 

bit or every 10 minutes everything seems to grind for a halt while it does an AutoSave.  

Nowadays I think that tends to be a lot less of a problem.  So you really would need an extremely 

good reason not to have AutoSave set on.  You can adjust how frequently you run it and if you 

just click inside there the number you can enter for the number of minutes can be anything from 

one to 120.  I think auto saving every one minute may be overdoing things a little.  And auto 

saving every 120 may be a bit too infrequent because you could effectively lose two hours of 

work.  Ten is the default figure and it’s the one that I tend to run with. 

Now there’s one other option there associated with AutoSave and that is the file location where 

the AutoSaved copies are kept.  It’s set to the default.  Mine is here set to the default.  There’s a 

different one for each user of the device you’re using.  I generally don’t change this, but if you 

wanted to save that information somewhere else, you could, of course, save it on a separate 

device if you wanted to.  There’s no reason not to.  Then you can change that location if for some 

reason you want to do that.  Although, of course, if you were going to use a different device it 

would have to be a device that is connected and available all the time that you’re using 

PowerPoint 2013. 

So what would the sequence of events be?  Let’s suppose you’re working on a presentation in 

PowerPoint 2013 and it’s on a PC and you have a power failure.  Everything just grinds to a halt.  

The lights go out.  You sort out the power fault.  You get the power going again.  You switch 

your PC on again and you start PowerPoint 2013.  As soon as you start it, PowerPoint realizes 

that there is AutoSave information and it also realizes that you didn’t successfully save the last 

thing you were working on.  It then says to you, you didn’t finish what you were doing properly 

last time.  You didn’t close the presentation you were working on properly.  Things seemed to 
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stop unexpectedly.  Do you want to AutoRecover from the last saved copy of the presentation 

you were working on?  If for some reason it’s got the whole story wrong and you realize no, no 

that’s what happened at all and in any case what I was working on I don’t want anymore.  You 

can just say No and carry on as normal.  Whereas if in fact there was some sort of catastrophe 

and you do need to go back to that AutoSaved version you just click Yes, carry on, and it will let 

you continue with the AutoSaved copy of your presentation.  It happens to me from time to time 

and so far it’s proved an excellent way of recovering from that kind of disaster. 

Now, not so long ago Microsoft added an additional twist on this which also has proved very 

useful to some people.  When you have been working on a presentation for some time and you 

want to close the presentation you normally get a question as we’ve seen before; Do you want to 

save changes?  You’ll usually say Yes.  Occasionally you might have made some changes to a 

presentation and you’ve changed your mind and you’ve thought, no, no I don’t want to save 

those changes and you might say No.  But something that happens to everybody eventually or at 

least everybody I know it’s happened to, is that you’ve been working on a presentation, you 

close it, and it says Do you want to save the changes?  And you accidentally click No.  Now this 

is a bit of a worst case scenario really because you’ve just appeared to have thrown away all the 

work that you’ve been doing by saying no I don’t want to save those changes whereas in fact you 

really should have saved those changes.  One of the other options that’s available here can help 

you to fix that particular problem.  Just below the options with the interval time on it, the 10 

minutes in this case, there’s another box that I’ve checked that says Keep the last AutoSaved 

version if I close without saving.  And what that means is that everything’s fine.  You close a 

particular presentation.  It says Do you want to save changes?  You say No.  In the past, before 

this option was introduced, PowerPoint would’ve thrown away the AutoSaved copy.  Now it 

keeps it.  And if having done that you close PowerPoint or you come back to PowerPoint later 

and you think, ah, I said no to saving those changes and I really wanted to keep them.  There is a 

way of going back to that last AutoSaved version and I’m going to show you that now. 

So it’s pretty straightforward.  You go into Backstage View, click on Open, and down at the 

bottom there is Recover unsaved presentations.  Open a recent presentation that was closed 

without saving and it really as simple as that.  I hope you never have to do that.  I must confess 

I’ve had to do it once or twice. 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

Now at that point we’ve got to a situation where we can now start to create some good 

PowerPoint presentations, and that’s what happens from now on, on the course.  Many of the 

things that we’ve covered have been essential aspects of understanding the PowerPoint 2013 

interface, understanding something about the Ribbon, the Quick Access Toolbar, and so on.  But 

of all the things we’ve covered, in many ways those related to backup and AutoSave and 

AutoRecover are the most important.  So although this isn’t actually an exercise for you to do I 

do want you to make sure that you have those AutoSave options set.  You may choose to tune or 

tweak them later on in your use of PowerPoint, but make sure they’re set.  They may well have 

never have been changed and just be at the default settings which is fine.  But it is absolutely 

essential that you get those settings correct and that you make arrangements for those backups to 

a different device so that you don’t lose your work in the longer term. 

So in the next section we’re going to make our first presentation, please join me for that. 
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Chapter 8 – Creating a Presentation 

Video:  New Blank Presentation; Slide Size, Orientation and Background 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to create a new presentation and this is the first completely new presentation that we’ve 

worked on.  To get started, we click on File to go into Backstage View, then select New, and as 

you’ve already seen, there are a number of templates available each with a name like Celestial or 

Integral or Ion, and the very first item in the list here is Blank presentation and on this occasion 

we’re going to use Blank presentation. 

Now before we really get going on this, I need to point out a couple of things to you.  First of all, 

when we say Blank presentation there is actually quite a lot of information setup already when 

you select Blank presentation.  It may not be a very colorful template but there is still a template 

involved, as you will see.  And the second thing to point out is that in this section and the next 

one when we’re working on the first presentation, I’m going to show you some of the main tools 

and techniques for creating presentations, but almost without exception we’ll be coming back to 

them and looking at them in a lot more detail in later sections of the course.  So if in some of the 

things we do in this section and the next one it all seems a little bit sort of quick or that there are 

many unanswered questions left behind, don’t worry because we should be covering all of those 

unanswered questions later on in the course. 

Now when you create a new presentation, it’s given a default name by PowerPoint 2013.  The 

name will normally be Presentation 1 or Presentation 2 or something like that and the name 

appears in the title bar at the top.  The first thing I do with any new presentation is to save it with 

a name of my choice.  So I go into File, Save As, choose My Computer, and I’ll browse to a 

folder where I’m going to keep the working files on this course.  Now this is a different folder to 

the one where I’m keeping the sample files that you have as well.  So I’m going to browse to that 

folder now and I’m going to give this presentation a suitable name.  So I’ve located the folder.  

It’s currently empty.  I’ve typed in a file name.  I’ve called it Demo presentation 1.pptx.  

Whenever you’re saving a file in PowerPoint 2013, you will need to make sure that you have the 

correct file type selected.  For a standard regular PowerPoint presentation, the extension will be 

.pptx.  If you look at the drop down to the right as Save As type, there are actually many types of 
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document that you can save in PowerPoint 2013.  For instance, if you look at the third option in 

the list here, there is a PowerPoint 97 to 2003 presentation format, a .ppt format, which is the old 

format presentation.  I’ll talk about that briefly a little bit later on.  But you can also save a 

presentation, for example, as a PDF file, a Portable Document Format file.  You can also if you 

are programming, you are including program code in a PowerPoint presentation, it becomes a 

PowerPoint Macro Enabled presentation, a .pptm file.  But for the moment, we only really need 

to look at .pptx files.  I’ll talk about some of the others later.  So when I’ve put in my name, 

made sure I’ve got the right file type, I click on Save.  And as you would expect, once I’ve saved 

I’ve now got the correct title for the presentation on the title bar at the top of the window there. 

Now if you look at the way that different people set about creating presentations, they tend to do 

things in their own particular sequence.  And of course, like other people I have my way of going 

about creating presentations as well.  And the method when I’m starting from scratch with a 

completely new presentation is often quite different from the one where I am for example using 

an old presentation and just modifying it.  In the example here, we’re pretty much starting from 

scratch.  So I’m going to go through some of the main steps in what seems to be a pretty sensible 

order and you may adapt and adjust that yourself once you get used to using PowerPoint. 

Now one of the first things we need to do is to decide on the size of the slides.  In the past, the 

size of slides and the templates have tended largely to be sort of inextricably linked together.  In 

PowerPoint 2013, one of the changes is that it is now a standard basic decision whether a 

presentation is going to be standard or whether it’s going to be widescreen; that is 4:3 aspect 

ratio or 16:9 aspect ratio.  And I suggest that’s a good starting point.  If you click on the Design 

tab on the right in the Customize Group, there is a Slide Size box and if you click on the bottom 

of it, the drop down, there are the two most popular settings.  There’s standard 4:3 and 

widescreen 16:9.  You also have an option of going for a custom slide size and you can pretty 

much create any size you like.  And you need to be a little bit careful there because depending on 

how you’re going to present this presentation, a very strange slide size may cause you problems 

later on.  The other fundamental decision you can take at this point is whether you’re making 

landscape slides or portrait slides, and there is an Orientation option here.  In the vast majority of 

cases, presentations are landscape but there’s absolutely no reason that you shouldn’t make a 

presentation with portrait slides. 
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Another fundamental decision related to that is that for the notes, handouts, and outlines, do you 

want those in portrait or landscape format?  Now, that may not mean a lot to you at the moment 

and the fact that it defaults to portrait may seem a little strange.  But when I show you some 

notes and handouts later on, you’ll see why the portrait option here is the default.  So for the 

moment on this particular presentation, we’re going to stick with widescreen, landscape slides, 

and portrait notes, handouts, and outline, click on OK, and that’s the most fundamental decision 

made really. 

Now before we go any farther, I should just point out to you that I have got AutoSave set and I 

will from time to time in any case save my work.  But for the rest of the course, I’m not going to 

say to you every few minutes don’t forget to save your work.  But just this once, don’t forget to 

save your work.  So generally when I’ve made any kind of major change even allowing for 

AutoSave, I’ll go up there and click on the Save button.  This is one of the ones where I know 

the keyboard shortcut by the way.  So Save is there.  The keyboard shortcut is Control plus S.  

Get used to pressing Control plus S every now and then, particularly just after you’ve completed 

a large piece of work on a presentation.  So press the Save button or use the keyboard shortcut 

Control plus S frequently. 

Now we’re going to be working on the stylistic and design aspects of presentations extensively 

later in the course.  But let’s do a little simple operation here.  Also in the Customize Group on 

the Design tab, there’s a button called Format Background.  So let’s just try a very simple 

example within Format Background.  Click there and what happens is this Format Background 

Pane or Panel opens on the right hand side.  Now this kind of pane is going to be a common 

feature during the course to achieve certain effects, and Format Background is certainly one 

which is a flexible and powerful way of making our presentation really look more attractive.  

Now in this case, the option we’re looking at is Fill.  We’re going to be looking at these options 

for Fill later on.  We can have solid fill, gradient fill, picture or texture fill, pattern fill.  You’ll 

see what they mean later on.  Let’s just try a solid fill here and let’s choose a solid fill color.  

Now further down the pane, there is a color option and a control over here, Fill Color; click on 

that.  We get a thing called a Color Picker that I’ll talk to you about later on and what we’re 

going to do is to choose a fairly pale color from there as a background to these slides.  So let’s go 

for that color there, click on that one, and we’ve changed the background color of a slide to that 
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sort of pale, pasteley blue type of color.  We can also adjust another setting transparency, more 

of that later. 

And at any time when you’ve been working on the background of your slides, you have a button 

at the bottom that says Reset background.  And that’s a good example of the type of reset button 

we see throughout PowerPoint 2013 where basically if you’ve been working on something such 

as the background in this case and it’s all gone a bit sort of horribly wrong or you’ve changed 

your mind, if you click on Reset Background, it will put it back to how it was at the beginning.  

But for the moment, I think I’m quite happy to stick with this light blue background. 

So I’ve finished working on the background for now.  All I need to do is to click on the Close 

button on the Format Background Pane and it’s gone.  Note that when I’m using those kinds of 

pane PowerPoint 2013 always automatically resizes the other things that are on display in the 

workspace here to make good use of the available space.  So in this case, the slide that I’m 

looking at is made bigger to fill the space left by the disappearing pane. 

So we’ve added a tiny bit of style to our widescreen presentation.  Let’s move on now to actually 

put some content into it.  We’re going to cover that in the next section so please join me for that. 
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Video:  Adding Contents; Adding and Deleting Slides 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the previous 

section, we started our first brand new presentation and we setup the slide size and orientation 

and a background color.  In this section, we’re going to start to put some content into this 

presentation.  Now the subject of the presentation is creating our first presentation.  Now we 

created this presentation initially by choosing Blank presentation and the single slide that we get 

we can select on the left there and the slide itself is shown here.  Now I didn’t actually type in the 

words that you can see there.  They are what are called placeholders, and the Click to add title 

and Click to add subtitle are indications that I can now enter some text on to this first slide.  And 

literally if I click on the title, it appears to disappear. The cursor appears and I can type in my 

title.  Now my title is going to be My First Presentation.  Now when you’re using placeholders, 

that’s basically what happens.  You click within the placeholder and you type the text.  Let’s try 

that with the subtitle, and there we are.  That’s the first slide ready.  Note that as I’ve typed the 

thumbnail on the left, there it’s been updated to reflect what I’ve typed and that while I’m 

working on the slide, here you can see on the Ribbon that I’ve got a drawing tools contextual tab, 

a format tab as well. 

So how about a second slide now?  Let’s go to the Home tab and we’ve got in the Slides Group a 

New Slide button.  The button is in two parts.  The top part is the new slide, the lower part gives 

us the option to choose, as you’ll see in a moment.  I’m just going to click on the top one for the 

moment.  And if I do note that although it appears as a second slide here, the placeholders have a 

different layout to the one that I had on that title slide.  But let’s fill this in anyway and I’ll talk 

about that issue in just a moment.  So put a title on the second one, then click in to add some text.  

Note that in this case the text is in the form of a bulleted list.  So having typed Design tab, I’m 

going to now type and you can see what I’ve done here.  I’ve said the first thing I did was to set 

the slide size so I went to the Design tab and the Customize Group and then just to remind 

myself on the Design tab in the Customize Group it was the Slide Size command.  So there we 

are.  That summarizes how we set the slide size. 

So now I have a presentation with two slides in it.  Let’s suppose I want to now add a third slide 

and I know that the next thing I did when I made this presentation was the format background.  
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So the contents going to be pretty much like the content of this one.  I just need to change a 

couple of things.  But if I go back to the Home tab and click this time on the lower part of the 

New Slide button watch what happens.  Now when I click, what I see are a number of what are 

called Slide Layouts.  The first one, the title slide layout, that’s the one that I started with.  It had 

a title in the upper part and a subtitle in the lower part.  But there are various other layouts that 

are available given the template that I’m using.  Slide 2, the one I added, was the title and content 

layout.  Again, it’s in two parts.  The upper part is a smaller space for title, a heading for that 

particular slide, and then the lower part can contain content.  Now I want to look at this content 

again in just a moment.  I’ll come back to that.  But then I have various other layouts.  There’s a 

section header layout.  There’s a two content layout where I can have two items of content side 

by side.  I can have a comparison layout, title only, blank, content with caption, and picture with 

caption.  Now depending on the template I’m working with, I may have other or different layouts 

to this and I can in fact create my own layouts.  But for the moment we’re pretty much dealing 

with the default here. 

Let me do title and content again.  Now this gives me Slide 3.  Note that our newly inserted slide 

will appear after the one that’s selected.  So I had Slide 2 selected, Slide 3 appears after it.  And 

it has the layout that we saw just now with Slide 2.  Now this kind of layout is one that you’ll see 

very often in PowerPoint 2013.  We have a title at the top.  We have Click to add text and this 

defaults to a bulleted list because that is a very common type of content for PowerPoint 

presentations.  But the presence of these little icons in the middle indicates that we can actually 

put all sorts of different content in here.  And if I hover over those icons, you can see the sort of 

things we can put in.  By clicking on an icon, we will put in the corresponding type of content.  

So for instance on the first one it says Insert Table, Insert Chart, Insert a SmartArt Graphic, 

Pictures, Online Pictures, Insert Video.  So this particular layout is a very powerful one in terms 

of the kinds of thing that we can put into the content of the slide.  Now we’re going to come back 

to this later.  In fact, we’re going to spend a lot of the rest of the course looking at how we insert 

these different types of content into slides. 

So it will be a very straightforward job now to click in the title there of this layout of slide, put 

the new title in, Format Background, and basically put in very similar text to the text we used on 

Slide 2.  But instead of that, I’m going to do something you’re probably not expecting and that is 
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that with Slide 3 selected, so click on Slide 3, I’m going to press the Delete key and delete Slide 

3.  It really is as straightforward as that to delete a slide. 

What I’m going to do this time is I’m going to create Slide 3 by copying Slide 2.  Now first of 

all, if I was doing this with mouse and keyboard with Slide 2 selected I could for instance go up 

to the Clipboard Group on the Home tab on the Ribbon and one of the options on there, the 

middle one on the right, is Copy which will copy a slide.  And having copied the slide and 

making sure I select in this case Slide 2 itself, to paste it I could paste Slide 3 and it would be an 

exact copy of Slide 2.  Alternatively, if I’m using touch let me just touch on Slide 2.  That brings 

up the minibar, tap on Copy, again tap Slide 2, and tap on Paste, and I’ve done copy and paste 

using touch in that case. 

Now with Slide 3 selected I can click inside the title.  This is no longer Set the Slide Size.  And 

of course, the other thing that needs to change and there’s Slide 3.  Now I’m going to have a little 

run through of this presentation in just a moment to finish this section off.  But first of all, you 

can see one of the problems which is going to be a bit of a recurring theme throughout the course 

and that is that some things that you apply such as in this case the background to a slide, you 

have to be careful whether you’re applying them just to one slide or to the whole presentation.  

So if I go back say to the first slide there which we had that sort of light blue background to, 

back on to the Design tab, back on to Format Background, the color we had, you remember?  We 

selected there.  It’s still selected.  What I would really need to do is to say Apply to all and that 

background is then applied to all of the slides in this particular presentation. 

So we’ve created our first presentation in PowerPoint 2013.  We have three slides.  We have a 

nice blue background.  It’s very plain but that will help to make it very easy to read.  Let’s see 

what it’s going to look like onscreen.  Now when I’m doing this I have a number of options for 

how to view this onscreen and I’m going to talk about those options in the next section.  But for 

the moment I’m going to use one of the views that’s called the Reading View.  So I’m going to 

go into Reading View now.  You can see the first slide.  Note that because it’s a widescreen 

presentation on a non-widescreen computer display, we’re going to get the letter box effect.  

Don’t worry too much about that.  And I step through the presentation using the arrow keys on 

my keyboard.  So the right arrow key takes me to the next slide, again to the next slide, and then 

I can use the left arrow key to take me back again.  And that gives me some idea of how my first 
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presentation is looking.  And when I finish previewing my presentation, I can just click on the 

Normal button on the status bar and get me back into the normal mode for working on my 

presentation. 

So that’s it on the first presentation and it’s now your turn to do the next exercise.  What I’d like 

you to do is to do a presentation with four slides in it.  The first slide will be a title slide and the 

other three will be as follows.  Each slide will have as its title the name of one of the tabs on the 

PowerPoint 2013 Ribbon and then listed underneath in bullet list form, the same basic layout as 

we have here, will be the name of three of the groups on that tab of the Ribbon.  My answer to 

this example-03 in the provided files and you can use my example if you need to as a guide.  But 

as I say, it’s four slides in total, the first one will be the title of the whole thing, possibly with 

your name as the subtitle and the other three are the names of three tabs and for each of those 

three tabs three groups that are on that tab.  I’ll see you in the next section. 
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Chapter 9 – Views 

Video:  Adjusting View and Adding Notes in Normal View; Expand/Collapse in 

Outline View 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at views. Views are not only different ways of looking at a presentation, but 

they’re also different ways of working on a presentation, which means it’s very important to 

know which is the most appropriate view to use when you have a particular task to perform.  So 

far, generally speaking, we’ve done everything in Normal View and as you’ll see later in this 

section that’s not always the most appropriate view to work in. 

The presentation you can see in front of you is example-03 from the supplied files.  It’s a very 

straightforward presentation with four slides.  The first slide is the title slide and the other three 

contain details of three of the tabs on the PowerPoint 2013 Ribbon. 

So first of all, let’s switch to the View tab.  And on the View tab, you can see in the left a group, 

Presentation Views, and you can see that Normal is the one that’s currently highlighted here.  

Now don’t worry about Master Views, the second group at the moment.  We’ll come back to that 

later.  Presentation Views, there basically are five, although in fact there are more views than 

this, as we’ll see a little bit later on.  These are the five we’re concentrating on in this section.  

Now apart from those five alternative views in the third group along Show, there is a Notes 

button.  And if you look right at the bottom of the display here you can see a little rectangle, 

Click to add notes.  Now that is the area where we can specify the notes for a slide.  And 

generally speaking people refer to these as the speaker notes in that they will normally be the 

notes that somebody who is talking while the presentation is being run will use to explain points 

to the audience or in some cases they’ll be the notes that give the speaker, the presenter 

instructions about what to do or maybe give a little outline of a diagram to draw or a joke to tell 

or something like that.  As you can see at the moment, Notes is highlighted which means that the 

notes are shown.  If I click that button, then I won’t see the notes at the bottom of the display.  

And note that in general when you change a setting of that kind of button, something that affects 

the view, the size of the slides and the rest of the working window tend to resize themselves to 
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make better use of the available space.  Let me just show notes again and you can see at the 

bottom, Click to add notes. 

Within Normal View, there are several things we can do to actually adjust the view to our 

specific requirements.  Note that the view is separated into two halves by this vertical line.  On 

the left, we have the thumbnails of the slides; on the right we have the selected slide.  You can 

actually move this vertical line.  If you hover it, you’ll see a double headed arrow like that, click 

with the mouse, and you can make the left hand panel smaller in which case the thumbnails 

shrink or you can make the left hand panel bigger in which case the thumbnails grow.  Now 

exactly where you have that set is a matter of both personal preference and probably where you 

are in terms of a presentation.  If you’ve got a very simple presentation, you may only need very 

small thumbnails.  If you’ve got a complex one, you may need bigger thumbnails to be able to 

read what’s on each of the slides.  Now it’s also possible to split the area on the right of the 

screen where we can see the selected slide in the top part and the speaker notes in the bottom 

part.  On this occasion, I’m going to do this with touch.  All you really need to do is to touch the 

horizontal line that divides the two parts of the right hand side of the screen and then just pull it 

up or down with your finger.  So let me just do that with touch, pull it up, I think that’s far 

enough, and now I have a much better area that I can work on the speaker notes in. 

So speaking of speaker notes, let’s just click in that area.  Note whenever it says Click to, you are 

almost always dealing with some kind of placeholder.  So as soon as I click the words Click to, 

add notes have gone and I can start adding those notes.  I’m going to do a little bit of typing here.  

So get back to me in just a moment.  So what I’ve done here is to type several paragraphs of 

speaker notes and I’ve typed enough that you can’t see all of the notes with the current 

arrangement of this Normal View.  When you’ve typed more than that you get a scroll bar on the 

right of the note area which enables you to scroll through the notes. 

It’s worth pointing out here that people use speaker notes in different ways.  Some people have 

pretty much word for word notes and so the notes can be quite extensive and they really just read 

the notes out pretty much as they are when they’re giving the presentation.  Other people take 

perhaps a more casual or a more flexible approach and may just have a few bullet points to 

remind them of the main things they need to talk about and then the detail of what they’re going 

to say they pretty much make up as they go along.  This is very much a matter of personal style. 
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You should also be able to see that there is a scroll bar and a couple of additional buttons to the 

right of the selected slide here as well.  And in terms of the two buttons at the bottom, there’s a 

Next slide button and there’s a Previous slide button, and they basically let us step through the 

slides in the presentation.  As we step through the slides, let’s go next slide, then not only do we 

get the next slide but any speaker notes that go with that as well.  I’ve only done speaker notes 

on the first slide at the moment. 

So I can step through the slides in the presentation using those buttons.  I can also work my way 

through the presentation using this scroll bar.  Now the use of the scroll bars a little bit more 

complicated in this case because if you’ve got a very close up view of a slide in this panel, at the 

moment you can see the whole of this slide, but just imagine we were sort of zoomed into the 

detail, the scroll bar would also be used to help you to look at different areas of a slide where 

you’re very close up to it.  But at the moment, the way it works is this.  If I pull the scroll bar 

down a little way, you see there’s a screen tip there that tells you which slide you’re selected.  So 

that says Slide 2 of 4.  If I went down to Slide 3 of 4 and released, I’d actually have Slide 3 

selected and displayed and I’ve done that using the scroll bar rather than using the buttons down 

there. 

Now the next view I’d like to look at is Outline View.  So select Outline View on the View tab 

and essentially it’s the same as Normal View on the right hand side in that you see the currently 

selected slide and below that the speaker notes that you can switch on and off using the same 

button.  But here you see an outline on the left which is basically a structured list of the text on 

the slides.  Now again you can resize, you can change the division between the left hand part of 

the view and the right hand part of the view.  You can drag the notes area up and so on.  But it’s 

the view on the left that is essentially different.  And one aspect of Outline View that can be very 

useful is that in some situations it’s a very good way of inserting a new slide. 

So let me show you how that works.  Let’s suppose that having created this presentation with 

four slides with some details of groups on the Home tab, the Design tab, and the View tab, I 

decide I want to put in something about the Review tab.  So I’m going to click on the Review tab 

here just to remind myself what groups are in there.  To create a slide to contain that equivalent 

information, I want it to go before the View tab because I’ve at least nominally got these tabs in 

order:  Home, Design, View.  Click to the right of Customize, that’s the end of the slide for 
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Design, note that the cursor is in the outline on the left.  Press the Enter key.  I can now say, okay 

the name of the slide is Review and then what I do is to promote that to a top level heading.  

Now there’s two ways of doing this.  One way is to use the Ribbon; another way is to use the 

contextual menu.  So I’m going to right click there and one of the options on the contextual 

menu is Promote.  Watch what happens when I do promote.  What happens is that it 

automatically creates a new slide because I’ve now got an entry at the top level, Review, press 

Enter.  Here I’m going to put the first group on the Review tab, that’s Proofing.  Now I don’t 

want that as a separate slide.  That should be on the Review slide so let me right click there and 

this one I’m going to demote. and now you can see I’ve got a new slide overall called Review.  

I’ve got the name of the first group and I can go ahead and put the names of two other groups in, 

and you can see what a great way that is of adding a new slide to a presentation. 

I mentioned just now that there’s another way of doing what we’ve just done.  Let me just click 

within the word Language and then on the Home tab in the Paragraph Group, there are a set of 

commands that we’re going to see a little bit later on, they’re to do with bullet point lists.  And 

the two commands are decrease list level and increase list level, and those two are effectively 

promote and demote.  So if I have the cursor there in the word Language and I click the left hand 

one, decrease list level, it’s effectively promote.  It makes that particular line a top level heading 

if you like, a top level entry in a bullet list, and that makes it a new slide.  So as you see it’s 

created a new slide.  I can demote it again by clicking on the other one. 

Now there are some other useful things you can do in Outline View and if you’re primarily 

working with text like this in a structured form, this is a great place to do them.  If you say take 

the Design tab here and right click, one of the options is Collapse and really you collapse all of 

the text under that which makes it a little bit easier if you like to see the wood for the trees.  

Sometimes if you’re just looking at one or two slides or looking for particular text on a slide, 

being able to collapse the others can be very helpful.  You don’t always see all the text here by 

the way.  These are quite short phrases we’ve got here.  But if you had longer phrases, you’d 

only see part of the text.  If you’ve collapsed an entry like that you can expand it again just by 

clicking on expand. 

And the other thing that you can do here is to move the slides into a different sequence.  So if I 

wanted to put Design before Home, if I hover over the box there it becomes the move cursor, 
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click, you see how not only the Design but all of the text in the lower levels of the bullet list look 

selected there.  If I drag upwards I get a little horizontal line and that horizontal line shows me 

where that slide will go if I release the mouse button.  So release the mouse button and it’s there.  

Let’s put Home back at the beginning, click, hold the mouse button down, drag up, and Home is 

back at the beginning again.  So that’s a very brief look at Outline View. 

We have three more views to look at:  Slide Sorter View, Notes Page View, and Reading View. 

And we’re going to look at those in the next section.  So please join me for that. 
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Video:  Moving Slides in Slide Sorter View; Notes Page and Reading View 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to continue looking at the views that are available in PowerPoint 2013. 

The next view we’re going to look at is called Slide Sorter View and even if you’ve never seen it 

before, you may well be able to guess what we use that for.  Note that I’m currently in Outline 

View, click on Slide Sorter View, and I see the slides sorted into whatever order they are in all 

ready.  I can easily move slides around.  So if I click on that slide, the Design Slide, I can move it 

before Home.  I could put View in a different sequence.  It’s very easy just to drag the slides 

around to put them into whatever order you want.  You can see the numbers there, 1, 2, 3, 4, etc 

just to tell you the sequence.  When we look at Zoom later on you’ll see another little aspect of 

that that’s quite useful.  When in you’re in Slide Sorter View, if you want to be able to just look 

at one of the slides in more detail if you double click on it, you go back into either Outline View 

or Normal View depending on which one you were last looking at slides in. 

Now I should point out that if you’re in Slide Sorter View and you have a particular slide 

selected, right click on that, you still have options like New slide or Duplicate slide, another 

useful feature.  I’ve currently got the Home Slide selected.  If I click on Duplicate slide, what it 

does is to make an exact copy of that slide, inserts it after the one I had selected, and then I could 

use that as the starting point for another one of the slides naming three of the groups on a tab of 

the Ribbon. 

The next few we’re going to look at is Notes Page View and in Notes Page View you basically 

see the slide.  You can’t actually edit the slide in this view, but underneath that a placeholder for 

the notes or indeed that notes you’ve already typed.  So if I go back to the first slide using the 

scroll bar on the right, I can see the notes that I’ve typed about the first slide.  Notes Page View 

is a good one for actually entering your speaker notes.  You can see the slide on the page and 

then you’ve got space to just type in the notes.  You may remember much earlier on in the course 

we talked about the setup of a presentation and the orientation not just of the slides but of various 

pages and we talked about handouts pages and notes pages.  Well, this shows you one of the 

reasons why we chose portrait for some of the artifacts that we produce with a presentation 
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because having this in portrait view is a very convenient way of laying out the notes page even 

though the slide itself is a landscape slide. 

And another thing to point out about Notes Page View is that historically it’s very often been the 

view that a presenter has printed to put by his or her side whilst making a presentation because it 

gives visual access to the notes and also at the same time they can see exactly what appears on 

each slide.  Now although many people, in fact probably most people still do things in that way, 

the use of Presenter View can greatly aid the process of giving a presentation without the need to 

have a printed copy of the notes pages.  Now Presenter View we’re going to look at later on 

when we look at actually giving a slide show. 

Now the last one of these views that we’re going to look at in this section is Reading View and 

this was newly introduced in the previous version of PowerPoint, PowerPoint 2010, and it’s a 

sort of cut down version of the actual slide show.  When you present a slide show, it actually 

takes over the screen that you’re presenting it on.  With Reading View it still works within a 

normal window but it’s pretty close to looking at the actual slide show.  Now in this particular 

presentation which is setup as a widescreen presentation we have this letter box effect because 

the screen that I’m recording this on is a 4:3 screen.  But one advantage of Reading View is that 

you have some simple controls down at the bottom right where you can step through the slide 

show as though it were the real slide show.  So you have a Previous button and a Next button.  

Click on the Next button there and it takes us through the slides and you get a pretty good 

impression of what the show is actually going to look like. 

In the middle, between those two, there is a menu system.  And if you look at the menu, you’ve 

got some quite useful options there.  One of them is to end the show, that’s the bottom one.  The 

one up from the bottom is full screen.  That takes you effectively to how the slide show itself 

would look if it were occupying the whole screen.  But then you also have things like edit slides, 

copy slide.  You can zoom in.  We’ll talk about zoom later.  You can also go to a specific slide 

and rather than just giving you the numbers of the slides, it gives you normally the first line of 

text if there is text to give you a reminder or a hint about what that slide is.  So if I’m looking at 

this particular presentation in Reading View, I can say Oh! Let me go to the Review Slide and it 

takes me to that slide.  So that menu system between the Previous and Next buttons can be very 

useful. 
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And when I’m developing presentations I tend to use Reading View as a step just before the one 

where I run through the real slide show as a sort of dry run just to have a good view of the visual 

impact and the logical sequence of the slides in the show.  And when I finish using Reading 

View down in the bottom right, there are some buttons here to return to the alternative views.  

That is the icon you’ll soon recognize as the one for Normal.  I’m going to go into Slide Sorter 

View which is those sort of four little squiggly rectangles there and there I am back in Slide 

Sorter View.  I’ve incidentally put the right words on that third slide, Insert.  So I’ve now got 

details of the Insert tab.  So I’ve got Home, Insert, Design, Review, and View tabs. 

And we’re now all ready for your next exercise in which I’d like you to take what was in 

example-03 and on each one of the slides; I would like some speaker notes.  The speaker notes 

only have to be a sentence or two and if you say take the Design tab maybe just what you see as 

the purpose of the Design tab.  If you’re not quite sure what it is put in some other text.  Perhaps 

just say something like, well, the Design tab is between the Insert tab and the Transitions tab.  

But make sure you’ve got some notes on each of those slides.  My answer to that exercise is in 

example-04. 

In the next section, we’re going to look at Zoom so please join me for that. 
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Video:  Zoom 

 
Toby:  Hello and welcome back to our course on PowerPoint 2013.  In the last two sections we 

looked at the various views that are available in PowerPoint 2013, and in this section we’re 

going to look at a subject which is closely associated with the use of views and that is the use of 

zoom. 

Now the reason that we use and need zoom is to be able to take either a very close up view of 

something in a presentation or to take a long, a wider view.  When we get close up, we talk about 

zooming in and when we talk about taking the wider view, we talk about zooming out.  Now the 

tools that we use for zoom are the same whichever view you’re using, but there are some 

differences and I want to look, first of all, at what we call one of the single pane views.  We’re 

going to look at the Notes Page View that we saw earlier on. The Notes Page View only has one 

pane, that’s P-A-N-E, that type of pane, and let’s see how we can zoom into and zoom out of 

Notes Page View. 

Well, in some ways the simplest way to zoom in and out is to use the zoom controls at the 

bottom right hand corner of the workspace, at the right hand end of the status bar because here 

you have a zoom slider and a Fit to window button in the bottom right hand corner.  Let’s look at 

the zoom slider first. 

At any time, the slider shows the percentage of zoom.  So at the moment we’re on 60% zoom.  If 

I wanted to zoom in further, I would click the plus sign and I’m now on 70% zoom.  Now I’m on 

80%, 90%; 100% is the setting in the middle.  So I can actually go well beyond a 100% and 

under normal circumstances the maximum zoom is 400%, although for some views you cannot 

go above 100%.  Now to reduce the zoom, I can just click the minus sign, the zoom out button at 

the other end of the slider and that goes down in 10% increments as well. 

It’s also possible to use the slider itself.  So if I click on the slider with the mouse, I can actually 

slide on a sort of continuous scale and go in as close or to go out as far as I want to.  And as you 

can see at 40% zoom, this notes page looks very small.  And that’s really where the button on the 

right, the Fit to window button, works because if you click on that one, Fit to current window, 

whatever view you’re in it will fit what you’re looking at to the available space.  And in this case 

that means a 60% zoom to make that notes page fit in the available document window. 
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So let’s look at the other main single pane view which is slide sorter.  I’m going to do this with 

my fingers instead.  I’m going to do it with touch.  So, first of all, I’m going to touch on Slide 

Sorter as the command on the Ribbon to choose that view and then instead of using the zoom 

slider or the Fit to window button, I’m going to use a touch gesture which is pinch.  If you’re 

using touch you’ll understand pinch; that’s two fingers or finger and thumb on the screen and 

pull them together to pinch and when I pinch, then I’m going to get more slides into the Slide 

Sort View.  Obviously, that’s a good idea if I’ve got many slides in my presentation. 

So I zoom out with pinch, but to zoom in I use stretch.  So either finger and thumb or two fingers 

put together on the surface of the touch device and pull a little apart and PowerPoint 2013 does 

the rest.  It will rearrange them.  Obviously, I can adjust that as finely as my ability to do 

accurate gestures will allow.  But, of course, the sliders available and as we’ll see there is an 

alternative approach that will work with either touch or mouse and keyboard as well. 

Now let’s take a look at zoom in Normal View because this is a little bit of a different story 

really.  If I click into Normal, I now have three panes.  I have a pane on the left that has the 

thumbnails of the slides and on the right I have two panes. The upper pane has the currently 

selected slide in it and the lower pane has the speaker notes in it.  And this time I’m going to 

look at this using a different zoom control.  The zoom control I’m going to use is on the View 

tab on the Ribbon.  There is a Zoom Group.  One of the buttons in it is “Fit to Window” that does 

basically the same as the fit to window does at the right hand end of the status bar.  But the other 

one is a Zoom button that brings up the Zoom dialog. 

Now what I’m going to do in this case is I’m going to put the cursor into the speaker notes.  So 

it’s down on the lower right pane of the display and I’m going to click on Zoom and notice it 

says that zoom is at currently at 100% which sort of means that in the notes at the moment, I’m 

at the regular zoom level.  Supposing I set that at 200% and click OK, I’ve zoomed in to the 

words.  I’ve zoomed into the speaker notes, but I haven’t changed the level of zoom on either the 

selected slide or on the thumbnails on the left.  Note also that this setting does not affect and is 

not affected by the slider at the bottom.  The slider will affect the slide itself.  So if I use the 

slider now watch what happens.  It just affects the zoom on the slide itself not in the speaker 

notes.  So to adjust the speaker notes click in there, use the Zoom dialog, put it at say 50%, and 

my speaker notes are so small that I can barely read them. 
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And then similarly if I select something in the thumbnail pane on the left there, click on Zoom, 

this is currently at 58%.  If I wanted it at say 100%, a high level of zoom, zoom in more, click on 

OK, and of course each of the slides is now bigger and PowerPoint 2013 adjusts the working 

area to accommodate that zoom in to the thumbnails on the left there. 

So there we have it.  That’s the basics of using zoom and we’ve also looked at most of the 

available views.  We’ve still got to look at Presenter View and Slide Show View that we’ll come 

back to later in the course.  Let’s move on to the next section.  I’ll see you then. 
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Chapter 10 – Undo and Redo 

Video:  Undo and Redo Actions; Set Maximum Number of Undos 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

couple of very important tools when you’re working with PowerPoint 2013 and that’s the Undo 

and Redo tools. 

Now I’m sure that if you’ve used Windows software before, if you’ve used any components of 

Microsoft Office before, you’ll be familiar with Undo.  There are a couple of specific things in 

relation to PowerPoint that I want to cover in this section, but briefly Undo is straightforward 

enough.  Let’s suppose that I select this Home Slide here and then I press the Delete key to delete 

the slide.  It’s gone.  If I decide that that’s a mistake, I’ve accidentally deleted it, then I can undo 

it.  Generally speaking the Undo button is one of the ones that people tend to have on the Quick 

Access Toolbar and I’ve got an Undo button on the Quick Access Toolbar.  It’s this sort of curvy 

arrow here pointing up to the top left and it says Undo delete slide.  In fact, it’ll say Undo 

whatever I did last.  And very importantly and this is one of the keyboard shortcuts that I tend to 

remember, there is a keyboard shortcut Control-Z to do an Undo.  So if I click on Undo delete 

slide, my previously deleted slide is back again. 

Closely related to the Undo command is the Redo command.  I’ve restored that slide and I 

thought, no I did actually mean to delete that in the first place.  I could either do the delete again 

or I can use the other button which is normally to the right of the Undo which is the Redo delete 

slide; keyboard shortcut on Redo is Control-Y; Redo and it’s gone again. 

Now let’s suppose that having deleted that slide I didn’t immediately realize that I wanted to put 

it back again or indeed that I subsequently changed my mind yet again but I went and did 

something else.  So I went back to Slide 1.  I took the second sentence there and I decide, ah I 

don’t want to say “Your host for the day”.  I want to say I am the presenter for this first session.  

And then I said, oh I don’t want to say “Welcome to this presentation”.  I want to say “Welcome 

to our presentation”.  So I make a few other changes, in this case in the notes on the first slide.  If 

I now go up to the Undo again, I could undo those in reverse order.  So my first undo would get 

rid of the last change that I made.  The next undo would do the one before that and so on.  But 
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you may see that just to the right of the Undo button, there’s a little drop down and if I click on 

that drop down, it gives me a list of the last so many things that I’ve done.  Now it won’t tell me 

exactly what typing I did but it does know that the last thing I did was some typing and before 

that I did some typing and before that I did some typing.  Now as I go down that list it’s saying 

undo three actions, undo four actions.  If I get right back to the delete slide, they’re actually five 

actions.  Note that the typing does not necessarily imply one character or one word or one 

sentence.  It’s one sort of batch of typing.  If I wanted to undo right back to deleting slide, if I 

click now everything back to delete slide, so all of the subsequent changes, they would all be 

undone.  And there is a very important point here and that is that if I wanted to undo that delete 

slide, then I would have to undo everything since then as well because, of course, those other 

changes may have been affected by deleting the slide.  I cannot selectively go back and just undo 

delete slide and ignore the other four changes since.  So although this is a very useful facility to 

be able to go back and automatically undo several actions, I cannot sort of choose the odd action 

here and there to undo.  If I want to go back to delete slide I have to undo everything since then 

as well. 

So let me suppose that instead of that I just want to go back say three changes.  If I were to undo 

back to three changes, you can see the effect of that in the notes page.  Let me just go back those 

last three and undo that and you can see the very last change has been undone and part of the 

change to the second sentence has been undone, but not all of it.  So you can certainly undo the 

last action and you can undo back several actions using that drop down, but you cannot 

selectively take old actions and undo them.  You have to go right back to the first 

chronologically the first action that you took that you want to undo.  You have to undo 

everything since. 

Now there’s one other point to make here.  If I click on the File tab to go into Backstage View 

and then click on Options, go to the Advanced tab, then in the first section in the Editing options 

the last entry there, Maximum number of Undos.  This defaults to 20.  You can increase the 

maximum number of undos if you want to.  It has to be a whole number between three and 150.  

On some older or perhaps less powerful computers, having a very high number for the maximum 

number of undos can cause performance problems because there’s an awful lot of information 

for PowerPoint 2013 to keep.  But to be fair nowadays, you can set that at a much higher figure if 
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you really want to.  I’d say that confidently undoing more than 20 steps would be a pretty 

ambitious thing to do because you’d have to remember very well exactly what those 20 steps 

were.  So I tend to leave mine at this default figure of 20, but it’s another one of those settings 

that really only you can decide where you want it set for you own purposes. 

If like me you have a tendency to make mistakes or to change your mind, then I think you’ll find 

that Undo and Redo are pretty useful facilities and there should be enough there for you to be 

able to use them with confidence. 

I’ll see you in the next section. 
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Chapter 11 – Working with Text 

Video:  Adding and Formatting Text; Placeholder Textbox 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to start to look at working with text in PowerPoint 2013.  We’ve already added some text 

to some slides but we’re going to concentrate here on not only adding text but how to format it 

and some of the functions and facilities within PowerPoint 2013 that can help us to make the best 

use of text in our presentations.  So let’s get started. 

Now on this occasion we’re starting with another new presentation and as I pointed out to you 

earlier in the course, typically when you start a new blank presentation, you’re presented with an 

initial slide with a couple of text placeholders.  The top placeholder here says Click to add title.  

The lower one says Click to add subtitle.  If you click within the area of a placeholder, one thing 

you’ll notice apart from the cursor is that on the Home tab in the Font Group you will see which 

Font is in force at that point.  This is a version of Calibri Light and the point size that’s in force is 

60 point.  Now let me start to type in that title.  Now watch carefully.  When I got to the end of 

that line, it automatically turned a line.  I’m still on Calibri Light 60 point and I’m still able to 

type, carry on typing.  Now watch what happened.  When I got past a certain point there, 

PowerPoint 2013 realized that it could no longer fit what I was typing into the available space 

and so it dropped the point size down to a point size where it can now fit the text.  Now the 

behavior we’re looking at there is associated with what are called placeholder textboxes, and this 

is one of the things you need to be aware of when you’re typing text into a placeholder textbox 

and that is that the text will often be resized automatically to fit the available space.  So although 

we’re going to talk now about controlling text and entering text, be aware that in PowerPoint 

2013 some things are automated and may take you a little bit by surprise. 

So we’re going to be looking now at text and placeholder textboxes is a good place to start.  

We’ve already seen some behavior of one of the placeholder textboxes on this particular slide.  

There is also a lower placeholder textbox, one that says Click to add subtitle in it.  Let’s click in 

that.  Again, we could just type away.  Note that the textbox has sizing handles around it so we 

can change the size of that textbox, and it also has in fact a rotation control.  If you hover over 

that rotation control and just move with the mouse or with your finger, if you’re using touch, you 
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can actually rotate the text as well.  Now note when it’s in normal use when we’re entering text 

the perimeter of the box is a sort of dotted line.  If you click on the perimeter, you make it into a 

continuous line and you get that prompt back again that says Click to add subtitle which you get 

with a placeholder textbox.  At that point if you press the Delete key, you can actually delete that 

textbox all together and at this stage we’re not going to be using that particular placeholder 

textbox again for a little while.  Let’s concentrate on the text we’ve already typed. 

So, first of all, I’m going to make this box a little bit bigger.  I’m going to pull that control down 

there.  I’m going to put the cursor to the right of the word Long and now I’m going to go to the 

Home tab and I’m going to change the font from Calibri Light to Algerian.  And I’m going to 

change the point size from 60 to 36 and I’m going to do a little bit more typing.  Now note once I 

change the font and the size from that point onwards, as I typed what I typed appeared in the new 

font and the new size.  It did not affect the text that was already there in that textbox. 

Now one key feature of virtually every PowerPoint presentation that you see is the use of words, 

the use of text.  So being able to enter and format text is very important.  And there’s one 

particular area of the Ribbon that is really geared towards making sure that we get everything to 

do with text right.  It’s on the Home tab and it’s this Font Group.  Now I’ve already used a 

couple of controls in the Font Group to change the font and the font size, but there are several 

other controls there and it’s important to know how to use those as well.  In the bottom left hand 

corner of the Font Group we have that button that sets bold, that one that sets italic, that one that 

says underline, and then we have some others.  We have this one which produces a text shadow 

effect, another one that does a strikethrough effect.  Now let’s suppose that I’m going to carry on 

typing, but before I do I’m going to change the font size from 36 to 60 and I’m going to put italic 

and strikethrough on as well.  Now let me carry on typing.  And you can see the effect of adding 

those two additional features to the text that I’m typing in. 

So that’s very important from the point of view of being able to set all the features of text before 

we type it in.  What about text that’s already there?  How do I change that?  Well, the key to 

being able to change the text that’s already there is being able to make a selection.  And I 

mentioned selections once or twice already earlier in the course, but let’s look now a little bit 

more about how we make a selection and let’s start by making a selection with keyboard and 

mouse. 
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Let’s suppose that I’m going to change the text features of the phrase I am going.  Now to select 

that with keyboard and mouse I click to the left of I, then I hold the mouse button down and 

sweep the mouse to the right.  I’ll see what I’m selecting as I go there.  And when I’ve selected 

the area, I want I release the mouse button and the shading tells me that that particular phrase has 

been selected.  Now note also that I get that mini toolbar that we looked at earlier on and if what 

I need is on the mini toolbar, I could format this text now.  If all I wanted to do was to make it 

bold, I could click Bold now and that piece of text would be made bold.  Soon as I click away I 

deselect that piece of text.  So whatever I do next will not be applied to that piece of text. 

Let me select the same piece again, but this time I’m going to go up to the Font Group on the 

Home tab and I’m going to use that button and that is an increase font size button, the one to its 

right is a decrease font size button.  So let’s start with increase font size.  If all I want to do is 

make it bigger, I’ll make it bigger.  If I then want to make it smaller, again I make it smaller. 

Now let me make a change to the formatting of the top line there, “Here is a very long phrase”.  

Now to do this using touch, I need to make a selection using touch.  So first of all, tap to the left 

of the word Here.  Now the little circle there which denotes the beginning of the selection, I now 

drag that off to the right until I’ve selected what I want to select.  And as I drag, you’ll see that 

it’s shading each part of the phrase.  When I get to the end of the selection, release my finger 

again and I’ve got a selection and the ends of the selection are marked by that pair of little 

circles.  Now once I’ve made the selection, I can make the font change using the Ribbon.  I may 

choose to go into touch mode, so let me just touch up here; go to touch mode to spaces out the 

controls on the Ribbon and a lot more effectively.  Note that when I do that, although I basically 

have the same tabs on the Ribbon, I do get a different arrangement of buttons in many of the 

groups.  So if you look at the Font Group again, you’ll see that the buttons are now arranged in a 

different sequence.  So that’s something to be a little bit careful of.  And on this occasion, what 

I’m going to do is I’m going to make that line bold.  So let’s start with a B for bold.  But I’m also 

going to change the color.  So the button immediately below the B for bold on the Ribbon is the 

one where I can change the font color.  Tap there, that brings up a color picker and I’m going to 

choose a quite a strong reddish color.  I’m going to choose that one.  Now having made that 

color change, the other thing I’m going to do is to add a bit of shadow to it.  So the Shadow 
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button is three to the right of bold.  Let’s put that on as well.  Tap elsewhere on the screen and 

we’ll see the full effect of that particular piece of formatting. 

So that’s some of the basic rules of formatting text.  We’re going to look at some more options 

for selection a little bit later on, but I just want to show you one or two other very quick things in 

this section related to text.  First of all, if I click back within that box again I can see the 

placeholder textbox perimeter showing again.  If I click to select the whole of the textbox, I’m in 

effect selecting all of the text inside it as well.  And one of the buttons which is in the Font 

Group here, I’m still in touch mode by the way but I’m going to use keyboard and mouse, is 

Clear all formatting.  Watch what happens if I click on Clear all formatting; everything goes 

back to the original format.  It’s back to Calibri 60 point again.  I could also have done that by 

swiping across all of the text to select it rather than the whole box and then I could either clear all 

the formatting or indeed change all of the formatting.  So for instance, if I wanted everything 

now to be that red color and I wanted everything to have shadow and I wanted everything to 

have 48 point that’s how I do it. 

Now so far we’ve been looking at placeholder textboxes.  There’s another sort of textbox, what’s 

called a manual textbox, and there are a couple of other things to point out to you about the 

properties of textboxes and things we can do to improve the presentation of text.  And I’m going 

to cover those in the next section, so please join me for that. 
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Video:  Manual Textbox; Inserting Symbols 

 
Toby:  Hello again and welcome to this second section on working with text in PowerPoint 

2013.  In the previous section, we looked at some of the basic formatting of text and we talked a 

little about placeholder textboxes.  In this section, I’d like to tell you a little bit more about 

textboxes and the different types that are available and look at some of the other type of 

formatting we can do and what we can do in terms of text effects.  So let’s get started. 

So let’s start another blank presentation.  There’s a straightforward keyboard shortcut for that.  

It’s Control-N.  And with the blank presentation, as we saw before, you get a title slide with two 

placeholders on it.  Now it’s very important to recognize that when we’re working with any kind 

of template including this default one, the placeholders on it, the text placeholders in this case are 

positioned in a consistent way.  If I wanted to put on a new slide and I chose title and content, it 

gives me Slide 2.  Do the same thing again, new slide, gives me Slide 3.  Within each slide as I 

select it, I have placeholders that are accurately positioned based on a template.  And we’ll talk 

more about templates, layouts, and outlines later on in the course.  If when I get these I select 

those placeholders and start changing the size of them and I start, for instance, making that one a 

bit smaller, maybe making that one a bit bigger, then I’m going to change the overall consistency 

within a presentation.  And the basic idea behind the slides in a template and the placeholder 

shapes on those is to give consistency throughout a presentation.  So if I was doing one such as 

the one we looked at earlier talking about the tabs on the Ribbon of PowerPoint 2013, having 

developed each slide from a template slide means that the positioning, sizing, and so on is 

consistent.  So it’s a good idea to avoid resizing placeholders too much within a presentation. 

However, sometimes you need text where there isn’t a placeholder textbox.  And in this 

situation, you have to use a different type of textbox.  Now this different type of textbox behaves 

in a different way to the placeholder textboxes but also they have many features in common as 

well.  On this occasion, I’m going to add a slide to this presentation which is completely blank 

and if I click on a blank slide there is no placeholder.  There’s no where to put some text. 

So in order to put some text here, we’re going to insert a textbox and on the Insert tab in the Text 

Group, one of the options is Textbox.  Now this draws a textbox anywhere. In order to draw this 

textbox, we click that button and as you move the cursor over the slide, the cursor changes to 
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become a vertical line with the little sort of cross at the bottom.  It looks like something like a 

sword upside down, and you basically draw the textbox.  Now don’t be too confused by the size 

of that box at the moment.  But the first thing you must do is type something.  This is a manual 

textbox.  And a manual textbox behaves in a very different way to a placeholder textbox.  First of 

all, as you may have noticed there, it automatically resizes itself vertically to make space for 

what’s in it.  It doesn’t resize itself horizontally, only vertically.  The placeholder textbox, if you 

remember, was of a fixed size and you could change that size by dragging the handles, but the 

thing that the placeholder textbox will do automatically is to change the font size to fit the text 

into the box.  The manual textbox in a way works the other way around.  It adjusts its own size to 

fit the text.  So if I selected, say, the words Manual, A manual textbox, went in and changed the 

font size from 18 point to 80 point it automatically changes the height of the box.  It doesn’t 

automatically change the width.  You can change that manually.  But if you tried to change the 

height of it manually, it doesn’t change the font size, what actually happens is it refuses to do it.  

It insists on fitting the text inside itself. 

So there we have the very important distinction between those two types of textbox.  Now I’m 

really over simplifying here but let me just outline what the situation is.  When you’re working 

on a presentation and you want to line up text, headings, content, everything to be neatly aligned 

and standard throughout a presentation, try to stick to the placeholder textboxes.  By the way, 

you can create your own placeholder textboxes, but more of that later.  But if you need a textbox 

to do a particular thing in a particular place that maybe is a little bit different from the standard, 

it’s not part of the template, you’re maybe labeling a bit of a diagram, something like that, then 

insert a manual textbox.  But in both cases be aware of how each textbox works and the sort of 

thing that it can do.  Having said that the fundamental features of a manual textbox in terms of 

many of the things we need to do are just the same as they are for a placeholder textbox and I 

just want to run over one or two of those again. 

So here I have a manual textbox.  If I select part of the text, say, three letters and go to the Home 

tab, the Font Group, I can for instance change the color of just those three.  If I click within the 

text, say, between the U and the A in Manual so that I can a flashing cursor there and press the 

Delete key, I would delete the character to the right of the cursor.  If I select the whole textbox, 

so I click on the outline so that the outline of the textbox, the border becomes a continuous line 
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and go to the Font Group on the Home tab and change the font size to 24, it will apply to 

everything within the box.  It applies to the whole box because I had the whole box selected.  

Similarly if I press the Delete key when I’ve got the whole box selected, I will delete the whole 

textbox.  So there we are.  So they’re important things to remember about the difference between 

selecting a textbox and having a selection inside a textbox. 

Now I’d just like to show you one other thing in this section related to text.  Let’s insert a 

textbox although this will equally work in a placeholder textbox, and what I’m going to do is to 

insert a special symbol.  Supposing I want to put the character Pi in there; click on the Insert tab 

and in the Symbols Group on the right there is a button Symbol.  Now this gives access to a set 

of special symbols that we can insert.  It’s a very extensive range of symbols and if I want to find 

the Pi symbol, it’s actually here on the right. There’s a list of recently used symbols if you’ve got 

a new installation of PowerPoint this will be setup with a sort of default recently used set, but as 

you use your installation of PowerPoint, that will get updated.  So let’s have the Pi character 

there, click on Insert, click on Close, and I’ve got a Pi character in there now.  And also you can 

insert equations.  Now inserting equations is outside the scope of this course but worth knowing 

that you can do it.  There are also a number of other options associated with text such as inserting 

headers and footers, inserting WordArt, and a couple of other things that we can do.  One or two 

of those we’re going to come back to later in the course.  They’re special cases of text and I’m 

going to fit them into the appropriate parts of the course material. 

So that’s it on working with text at the moment.  As I said, we’ll be coming back to some special 

cases of text later in the course, but for now I’ll see in the next section. 

  



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

Chapter 12 – Copy, Cut and Paste 

Video:  Using Clipboard and Mini Toolbar; Paste Option 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to take a look at Copy, Cut, and Paste.  I’ve actually used copy, cut, and paste a little 

during the course already.  And if you’re an experienced Windows user and in particular if 

you’re an experienced Microsoft Office user, you’re probably pretty familiar with using these 

tools yourself.  So this is going to be quite a quick overview, but there are a few features of copy, 

cut, and paste which are particular to Microsoft Office and one or two that are very particular to 

PowerPoint as well.  So it’s worth spending just a little bit of time summarizing the main points 

and going over those particular features.  One or two aspects we’ll look at later on as well when 

we look at putting some drawings, etc into our slides. 

Now as I said at the beginning of the course, I’m assuming that you’re a reasonably experienced 

Windows user and so you’ve almost certainly used copy, cut, and paste before. But I am going to 

cover a couple of the basics quickly now.  The first thing I want to point out in relation to 

PowerPoint is that you can copy, cut, and paste just about anything that’s in a PowerPoint 

presentation.  So you could copy a whole slide, you could copy one word or one sentence, and 

later on when we move on to looking at images, you can copy, cut, and paste images.  The way it 

works is basically the standard way that it works in a Windows based application.  So for 

instance, if I wanted to make a copy of a sentence in the speaker notes, let’s say I wanted to 

make a copy of “My name is Toby and I am your host for the day”.  First of all, I select that.  

You should have no problem selecting a sentence.  And when it’s selected, it’s then a candidate 

to be copied or cut to the clipboard.  The main commands on the button for doing this are on the 

Home tab in the Clipboard Group, which is up there on the left.  The Cut button is the top right, 

the Copy button is the middle right.  Format Painter at the bottom; don’t worry about that at the 

moment.  The Paste button is the one on the left there.  The Paste button is in two halves.  It’s got 

a top part which is a straightforward part and a lower part which we’re going to look at a little bit 

later on. 

So let’s suppose at this point that I want to make a copy of that sentence.  If I click the Copy 

button, nothing appears to happen but it has actually copied that to the clipboard.  If I then click 
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with the cursor at some other point in the speaker notes and then go back up and click on the 

Paste button, I will have pasted a copy of that sentence into the location in the speaker notes.  

Now one thing that I might mention there that sometimes really annoys people and that is that if 

you take a sentence like this one “My name is Toby and I am our host for the day”, you copy and 

paste it, you think, well what happened to the blank line after that sentence?  Well, that’s really a 

matter of how you selected it in the first place.  And what I’m going to do is to undo that paste 

and now I’m going to go back to that first sentence again.  I’m going to select it but this time I’m 

going to select it and the blank line underneath it.  You’ll see how the selection mark now 

indicates I’ve got the blank line as well.  But this time instead of clicking copy, I’m going to do a 

cut.  Now one option for copy, cut, and paste is to use keyboard shortcuts and these are keyboard 

shortcuts that I use all the time because they’re just about universally consistent across Windows 

applications.  So to cut this, I’m going to use Control and X.  Note, when you do a cut what 

you’re cutting disappears.  It still goes to the clipboard but it’s gone from where it was before.  

When you do a copy, it stays there; you’re making a copy.  Now let me click down before the 

word You again and to do a paste using a keyboard shortcut it’s Control-V.  And with Control-V, 

I now get the blank line after it as well.  And there you have the basics of copy, cut, and paste 

using either the commands in the Clipboard Group on the Home tab or using the keyboard 

shortcuts:  Control-V to paste, Control-X to cut, Control-C to copy.  Now let’s do a copy, cut, 

and paste this time within a slide but let’s do it using touch. 

I’m going to take this second slide, click on that, and we’re going to move the first item in the 

list there, Slides, down to being below Paragraphs.  So we’re going to cut it from where it is and 

paste it before drawing. 

Now as we saw earlier, when we want to work in touch, there are various ways of making things 

easier.  I can certainly go into touch mode and I can do things like, for example, I can suppress 

the notes at the bottom.  So tap on the Notes button in the Show Group on the View tab.  Notes 

are gone.  And then I can use the zoom control, say, to fit this slide to the window.  So if I click 

on Fit to window again on the View tab but this time in the Zoom Group, my slide is a lot bigger 

for me to work with.  I could, of course, make it bigger still if I wanted to, but that should be 

enough for now. 
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So first of all, let’s select the word Slides, the cursor is in place.  We just pull the selection 

handle down one so that we get both the word Slides and the end of line after it and then we can 

either use the commands on the Ribbon, so we could go back to the Home tab and the Clipboard 

Group or, of course, we can use the mini toolbar.  And on the mini toolbar, I have commands 

buttons for cut, copy, and paste.  So on this occasion, I’m going to tap on cut.  Now I’m going to 

basically move the cursor down one, so I tap to the left of the word Drawing next and now I can 

do a paste.  So all I have to do is to tap on the word Paste on the minibar and I’ve moved that 

entry in the bullet list down to be in between Paragraph and Drawing.  So that’s how to do the 

equivalent operation using touch.  Now don’t forget whatever you’re doing, I really did that as a 

demonstration.  Don’t forget that you can always undo what you’ve just done and in touch mode, 

of course, you’ve still got the same buttons on the Quick Access Toolbar, they’re just spaced out 

a little bit more.  So let me just tap on Undo.  The undo there undoes the paste.  If I tap again, it 

undoes the cut.  So to go back to where I was I need to undo both operations.  Now just let me 

tap elsewhere and my slide is back to being the way it was before. 

Now I’m still in touch mode but I’m actually working with mouse and keyboard at the moment.  

A couple of things to point out here that are quite important.  One of them is that although copy, 

cut, and paste you’re going to use quite a lot while you’re working with PowerPoint, there are 

also alternatives.  For instance, let’s take that same slide again.  If I were to actually select the 

word Slides and then click within that selection with the mouse, I could actually drag it.  I could 

do what’s called a drag-and-drop instead of a cut-and-paste.  That will work with images, 

photographs, text, so on.  It takes a little bit of getting used to.  Of course, you may be using that 

already regularly in your use of Windows.  But that’s a good alternative to cut and paste.  And if 

I just do that back again, but this time after I’ve made the selection, I hold down the Control key, 

let me drag that up with the Control key held down and then released. You actually make a copy.  

So that’s worth knowing about as an alternative. 

And then one other thing, if I just go back to the Home tab on the Ribbon to the Clipboard 

Group, I mentioned the Paste button has a lower part.  Let me just click on that lower part.  It 

brings up a set of options, Paste special.  Now I’m not going to go into these in great detail now 

but let me just hover over one or two of those little icons.  If you have some text copied to the 

clipboard or cut to the clipboard and the text has some formatting such as say a font color or a 
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strikethrough or something like that, when you copy or cut and paste that into another location in 

your presentation you may or may not want to keep that formatting.  So if I say had a slide with a 

font color, a lot of text in that font color, but I wanted to copy the text somewhere else but I 

didn’t want to take the formatting with it, I perhaps wanted to apply a completely different type 

of formatting, then these options give me ways of deciding whether I want to paste the 

formatting as well as the content.  So if I hover over one or two of these and have you look at the 

descriptions.  The first one there says Use the destination theme.  What that really means is that 

if you’re copying something make the formatting the formatting of the destination.  This one 

says Keep the source formatting.  That says if you’re copying and pasting something, keep the 

formatting it had at the start.  So put that into its new location as well as the content itself.  Now 

a bit later on in the course, we should be able to try one or two of those to see the effect, but it’s 

important to understand some of those paste special options.  The bottom entry there, Paste 

Special, actually brings up a Paste Special dialog which covers the main options you have when 

you’re pasting.  And again, we’ll have one or two examples of that later on in the course. 

So finally in this section what I’d like to do is to show you how to copy and paste whole slides.  

It’s pretty straightforward.  If I selected, say, the Design Slide here on the left, the thumbnail of 

it, if you right click on the slide, on the contextual menu you have an option Duplicate Slide 

anyway.  But if I go further up the contextual menu there is a copy option.  Note when I’ve 

copied that slide to the clipboard, the slide itself is still selected.  So if I do a paste now with 

keyboard shortcut Control-V, it will be pasted after the selected slide.  So Control-V gives me a 

copy, another one exactly the same.  So that one’s Design, this one’s Design.  If I then wanted to 

make this my Transition Slide, which is the next tab on the Ribbon, I can then click in there and 

so on. 

And that leads us to a straightforward little exercise now for you to do.  We’ve been working 

from example-04 which had five of the standard tabs from the PowerPoint 2013 Ribbon on it.  

So we had six slides all together; title slide and then five one per tab.  I’d like you to complete 

that really and go up to the total of eight standard tabs which means there’ll be nine slides.  Each 

tab should contain three bullet points and the three bullet points are three of the groups on that 

tab.  My answer to that is saved as example-05 and I’ll see you in the next section. 
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Chapter 13 – Spelling and Grammar Checking 

Video:  AutoCorrect and Proofing 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at spell checking. Although it probably is more accurate to say we’re going to look 

at spell checking and grammar checking because optionally, as well as checking the spelling in 

your presentation, PowerPoint 2013 can check your grammar as well. 

For the vast majority of people who learn how to use PowerPoint 2013, the reason for doing so is 

to make presentations and when you’re making a presentation, I really don’t think you want to 

see spelling errors or grammar errors on the screen.  You don’t want your audience to look at 

work, you may have spent hours and hours on and think it’s a pretty shoddy piece of work 

because you haven’t even checked that the words are spelled correctly.  So I believe it’s very 

important to build in spell checking and optionally grammar checking into the production 

process you have for your presentations.  Now there are basically two approaches, although one 

might argue there are actually three.  But let’s say there are two approaches to checking spelling 

and grammar.  One approach is to have PowerPoint 2013 check it for you as you work, so as 

you’re actually entering text into your presentations, you can get PowerPoint 2013 to tell you if 

you’ve made any spelling mistakes or whether you’ve made any grammar mistakes or to be 

slightly more accurate, whether it thinks you have, because sometimes what it thinks is an error 

is not an error.  The second approach is not to have it check it as you go along but for you either 

at the end of your work or periodically during your work to run what is effectively a manual 

check of spelling and grammar in your presentation. And we’re going to look at both of those 

approaches in this section. 

Now one of the tabs on the Ribbon has some particular significance when you’re proofing.  I just 

want to quickly visit that now and that’s the Review tab because on the Review tab there are two 

very important commands.  One of them is right at the left in the Proofing Group and that’s the 

Spell Check command.  We’ll be coming back to that a bit later on in this section.  In the second 

group along which is the Language Group, there is a button that’s labeled Language and this is 

the one where we choose the language for proofing tools, such as running a spell check.  You can 

also set other language preferences here.  If I click on the drop down there, Language 
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Preferences, just go into the language page on Options, and you can see that my default language 

is set currently to English United States and I need to make sure that any proofing I do is 

according to English United States. 

Now while we’re in there, I also want to go to the main page for proofing options in PowerPoint 

2013 which is the Proofing Page.  Now there are really three sections on this page.  The top 

section says AutoCorrect options.  I’m going to look at AutoCorrect options a little bit later on in 

this section.  There’s then a second section which says When correcting spelling in Microsoft 

Office programs, again, I’m going to come back to that a little bit later on in this section as well.  

And the third section is the one we’re interested in first.  It says When correcting spelling in 

PowerPoint.  Now I mentioned a little while ago that you basically have two options in 

PowerPoint.  One of them is to have PowerPoint check the spelling as you go; the other one is to 

do it as a manual exercise and we’re going to look at that first option here.  The first option 

within this group, this third group on the page says Check spelling as you type.  So this is 

currently setup so that as I type text into a PowerPoint presentation, PowerPoint 2013 will check 

my spelling and it will warn me if it thinks I’ve made a spelling mistake.  If I don’t want it to do 

that, if I want to do all the checking myself as a sort of batch process later on, so do it manually, 

I need to uncheck this box.  If I do uncheck this box, it also causes this box, the one underneath 

to be ticked which says Hide spelling and grammar errors. So what that automatically means is 

that if PowerPoint 2013 thinks there are spelling or grammar errors, it won’t indicate them as I 

work. 

The last option here is very important.  Do I want it to check grammar as well as spelling?  Now 

at the moment, I want it to check spelling as I type and I want it to check grammar with spelling 

as well.  So I want it to check spelling and grammar.  So click on OK and let me show you how 

that works. 

So let me now deliberately make a mistake in the word Ribbon.  I’m going to misspell it.  I’m 

going to take one of those B’s out and I’m going to click on the N there and type.  Now what’s 

happened is that PowerPoint 2013 has spotted what it believes to be a spelling mistake, it 

underlines it with a sort of squiggly red line.  You can see it there.  That indicates to me that it 

thinks there is a spelling error or some other error and usually the quickest way to resolve this is 

if you put the cursor within the word, click there and then right click, you get a little contextual 
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menu but it’s a special kind of contextual menu because it’s associated with what it believes to 

be a spelling or grammar error.  Now in the top, we have a list of potential words that it thinks I 

may have meant.  It says did you mean Ribbon with two B’s or perhaps Ribbons with two B’s or 

Rib on as two separate words?  It also says do you want to Ignore All?  Now sometimes I might 

put in somebody’s name or the name of a place, a city, a country, and PowerPoint 2013 may not 

know that name and it may not be a name that I’m going to use again.  So I can just say, well, 

actually Ribon is somebody’s name and you can just ignore that potential problem.  If I click 

Ignore All, it just says, okay, you’ve told me its fine.  I’ll just ignore it.  If on the other hand 

Ribon was say the name of a place or the name of a person and it was somebody or somewhere 

that I was going to refer to elsewhere either in other presentations or perhaps in other Office 

documents, I could say I want you to add this to my personal dictionary and that means that from 

now on you wouldn’t flag this word as a potential spelling mistake.  So in that situation, I’d click 

on Add to Dictionary.  Now in this particular case, I recognize that it is a spelling mistake and I 

also recognize that the word I meant was Ribbon so I click on Ribbon, and basically two things 

happen.  First of all, the word Ribbon with two B’s is substituted for the word that I had and also 

PowerPoint 2013 removes the underlining.  So it’s happy with that.  Now I’m going to do some 

more typing and make some more mistakes. 

Now first of all, notice that the word And is underlined there.  Now that is clearly not a spelling 

mistake because that’s how you spell And.  There’s an And right next to it so why is it 

complaining about that?  Well, let me just right click in there and, of course, I can see the 

message gives me, tells me what the problem is.  It’s saying delete repeated word.  Now there are 

situations where you can repeat a word quite legitimately, but this is not one of them.  

PowerPoint 2013 Ribbon, tabs, and and there contents.  That’s not right.  If it was a valid case, I 

could say Ignore and it would ignore that problem.  If I wanted to delete the repeated word, 

which I do in this case, I just click on Delete repeated word and it’s gone.  And I can also now 

see a second problem and that is that I’ve got another word which is definitely spelled correctly, 

There, T-H-E-R-E.  There’s nothing wrong with the spelling there.  The problem in this case is 

that PowerPoint 2013 has detected a grammatical error because if you look at that phrase now it 

says, PowerPoint 2013 Ribbon, tabs, and there contents.  The There here it should be the 

possessive there.  It should be the contents belonging to them.  Now, that wasn’t flagged initially 

because some types of grammatical error only become apparent when you get far enough 
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through a sentence.  So in this case, “There” could’ve been a valid word; that spelling of There 

could’ve been valid until it managed to see some more of the sentence and then realized that I 

meant the contents belonging to them.  Now if I right click in this version of There, it suggests 

that I really mean T-H-E-I-R, the possessive Their, the one that means the contents belonging to 

them.  Again, if this was the correct spelling or if I wanted to force it to be wrong, then I could 

just say Ignore, but I realize here that it should’ve been the possessive Their, click on that one, 

and that error is also now corrected. 

So by now you’ve seen two or three examples of how to have PowerPoint 2013 help us to correct 

as we go and I want to now go back into the Options to talk about a couple of the things that I 

mentioned earlier on and said we’d come back to because they’re important as well. 

In the top section here, we have what are called AutoCorrect options and much earlier on, I 

mentioned that there are sort of three ways of working and this is the sort of third way.  And that 

is that you don’t have to stop at having PowerPoint 2013 point out what it thinks might be 

spelling and grammar errors.  You can also get it to correct certain things for you.  Now let me 

click on AutoCorrect Options and it brings up a dialog.  Now in this dialog, it’s actually quite 

extensive and I’m only going to look at it briefly here.  But you can actually tell PowerPoint 

2013 to correct certain mistakes automatically as you go. 

Let’s look at a couple of examples.  Let’s look at that one, Correct two initial capitals.  Quite a 

few people have a tendency to put two capital letters when they’re doing capitalization, just a 

sort of natural to them error that they make frequently.  Well, if you check this box PowerPoint 

2013 will correct that for you as you go.  Similarly if you tend to forget to capitalize, the first 

letter of sentences you can ask PowerPoint 2013 to correct those for you as you go as well.  

Similarly you can get it to capitalize the names of the days, this option here.  Now there are 

several of those and there are some special substitutions such as Replace text as you type, 

Replace open bracket-C-close bracket with the copyright symbol, Replace open bracket-E-close 

bracket with the Euro symbol, and so on.  Now there are many of these.  You can get it to do 

AutoFormatting such as substituting straight quotes with what are called smart quotes, the 66/99 

quotes and various other things that you can do.  As I say I’m not going to go through all of those 

now but that’s a good area to experiment with if you want it to do some auto correction or 

perhaps in some cases auto substitution as you type. 
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The other area I said we’d come back to and that we’re going to look at briefly now is this 

middle one, “When correcting spelling in Microsoft Office programs” and these are some 

general settings that the defaults are the ones that are set here and I generally work with these 

defaults, but you may want to check through them yourself.  For instance, the first one, Ignore 

words in upper case.  If a word is in all upper case, do not spell check it.  Ignore words that 

contain numbers.  If a word contains numbers, do not spell check it.  And then things like Flag 

repeated words that we’ve already seen and Ignore internet and file addresses.  So if you’ve got 

http://-something don’t try to spell check that.  Now just make sure that you’re happy with those 

and then change any that you need to. 

So finally what if I don’t want it to check spelling as I type?  What if I don’t want it to check the 

grammar as I type?  And I really want to do this as a sort of manual exercise when I believe that 

I’ve finished preparing my presentation.  Well, this is where I use the feature on the Review tab 

on the Ribbon which is right at the left in the Proofing Group and its Spelling.  And this is 

effectively a manual spell checker that will go through the whole presentation starting at 

whatever point I’m at; so in this case, at Slide 3 and it will do a spell check for me.  So I click on 

that, make sure I’ve got the proofing language set correctly here, English United States, and then 

it flags the errors.  The first error it finds which is on Slide 3, it finds the word Slidez with a Z 

and it presents me with a number of options.  It said do you want to ignore that?  Do you want to 

ignore that wherever it occurs, so Ignore all?  Or do you want to add it to your dictionary?  If it is 

a mistake, here are possible correct versions.  Should it be Slides with an S at the end?  Should it 

just be Slide or Slider or Slides’ with an apostrophe after the S?  If it’s say the first one I can 

click on Change to change that particular occurrence that it’s found or I can say Change All 

occurrences on this slide.  Now there’s only one occurrence here.  It should be the word Slides 

with an S so I’m just going to click on Change and it makes that change for me.  The next error it 

finds is again what is obviously a misspelling.  It’s got Paragwaph with a W.  It should be 

Paragraph.  If that had been a word which was a proper name I could always add it to the 

dictionary.  But again it’s a straightforward spelling mistake so click on Change.  And when it’s 

finished correcting everything that it thinks is incorrect you click on OK and you’re spell check 

is complete. 

That’s spell checking in PowerPoint 2013.  I’ll see you in the next section. 
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Chapter 14 – Master, Themes and Layouts 

Video:  Templates, Slides and Masters 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to start to 

look at the important subject of Masters, Themes, and Layouts and we’re going to begin by 

starting to create a new presentation based on one of the standard templates that’s available in 

PowerPoint 2013. 

For this particular part of the course, we’re going to start a new presentation and this presentation 

is going to cover in outline the structure of Parliament in the UK.  Now when we come to do the 

exercises based on this, you don’t really need to do them based on UK Parliament.  You can base 

them on either the government of your country or perhaps on another organization that you’re 

involved in; perhaps if you’re a college student, university student perhaps you could do it on the 

organization of university or department.  Or if you’re at work, perhaps the structure of your 

company, the Board of Directors of your company.  But on this occasion I’m going to use the 

UK Parliament and the standard templates that we’ve seen already on this start screen for 

PowerPoint 2013.  I’m going to look at one of those with a view to reviewing it for the purposes 

of this presentation. 

Now if I want to have a look at this template which is called Slice and click it once and I can 

preview the different slide layouts available if I use that template.  Now more images underneath 

this main preview here, gives me view of the layout of that with various content, give me some 

idea of what it would look like.  Well, actually that looks okay.  It’s fairly colorful but it’s not 

too overpowering so that’s fine.  I can also see the same layout with different color schemes on 

the right.  Note the different main colors on each of those slides and then associated with each a 

little sort of palette of colors that I’ll explain to you in a little while.  If I decide that maybe that 

isn’t the template for me, I can step through the other ones using these arrows to the right and 

left.  Now that’s definitely not something you’d look at Parliament with, maybe that one, maybe 

that one’s not so bad.  Anyway, I step through.  I look at the different options.  I think I’m going 

to go back to my first choice. And when I’ve made my choice, I click on Create and I have my 

first slide in place ready to use.  And of course, I have now saved that using a suitable title to 

make sure that I don’t use it.  I have AutoSave on and, of course, I’m setup to backup all of my 
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work at the end of each working day.  So I feel pretty safe carrying on working on this 

presentation. 

So let me put a title in.  So I click on Click to add title.  The placeholder textbox is now ready for 

me to type into and I’m also going to type in a subtitle.  Okay.  And I have my first slide.  So 

now I’m going to put in my next slide.  I’m quite deliberately doing this in a little bit of a 

haphazard fashion because I’m going to show you later on how to tidy this all up and put it into 

sequence.  But let’s suppose my next decision is to put in a slide about the House of Commons.  

So on the Home tab in the Slides Group, the New Slide button, the lower part.  We know that if 

we click on that, we’re shown a number of alternative layouts.  Note that there are quite a few 

layouts with this particular template.  I’m going to go for that one, Title and content.  Note the 

title’s at the bottom.  So I put down there “House of Commons” and then I’m going to type up 

here some information. The House of Commons is the, dot, dot, dot for the moment.  Okay.  

Now I’ve got two slides and those two slides are the beginning of my presentation.  But what I 

want to do now is to talk to you about what gives this particular presentation its design, its color, 

its style, everything you can see about it at the moment.  Where does all that come from? 

Well, the first thing I want to point out and this is really aimed at those people who have used 

only much older versions of PowerPoint, is that the way this works has changed in the most 

recent versions.  And in the very old versions, everything was based on a template and once you 

had a template that pretty much dictated everything about what was in your presentation.  Well, 

although we talk about these templates what they do and how much they do has changed quite a 

bit in the last two or three versions.  If we look at just the slide you’re looking at at the moment, 

the key thing about this slide is that it is based on a layout.  And let’s suppose I made five or six 

slides based on that layout.  If I change any one of those slides individually, the same change will 

not occur; will not be made to the other ones of the slides, the ones made from the same layout.  

So the principle is if I wanted to change this slide, let’s suppose for example that I thought well 

really I want to put this at the top and the text at the bottom and I wanted to do that to all of the 

slides based on the same layout, then what I would do is to change the layout or to create a new 

layout with that particular configuration.  So there is a strong element of what we would call 

inheritance here.  If you base a slide on a layout and you want to change the layout, you don’t go 

through each individual slide based on that layout and change the individual slides; you change 
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the layout.  Now there is then a structure above that that says my layouts are based on a Master 

and if I want to change something which is applied at the Master level, then I make that change 

at the Master level. So for instance, if the background color, the graphics that are used, the style 

used in the background for all of my slides and all of my layouts is based on the Master and I 

want to change that, then what I do is I make the change to the Master.  So when I’m making 

changes, I try to make changes at the highest level in that structure that I can. 

Now in order to illustrate the next two or three points, I’ve put in a third slide.  This is a slide 

with a short statement about what the House of Lords does.  I’ve also put in the function of the 

House of Commons on the second slide.  And the first thing I want to demonstrate is that you 

can, for any one of these slides, change which layout it is based on.  So let’s, for example, 

suppose that I choose the third slide, right click on the contextual menu one of the options there 

is Layout, and from layout I can see the gallery of the available slide layouts.  Now the one I 

used when I made this was Title and content.  You can see it highlighted there.  I could say I 

want it to be the two content layout.  Now watch what happens to the slide if I do that.  And I see 

that although the title is still where it was the first part of content which has got the statement 

about what the House of Lords does is in a differently configured placeholder textbox up here 

and then I’ve got a second placeholder textbox which is currently empty.  I can tell it’s empty 

because it says Click to add text.  Now note that in doing that, that did not affect the other slide 

that was created from that layout.  So even though I’ve created a slide using a particular layout, I 

can subsequently change the layout which is one important thing to be aware of. 

So let me undo that particular change and put that slide back to the layout that it was created 

from.  And now I want to go to the View tab.  And very early on in the course, I mentioned to 

you about the View tab that there are some Master Views here and the view we’re going to look 

at now is the Slide Master, Master View.  Master Slides control the look of your entire 

presentation, including colors, fonts, backgrounds, effects, and just about everything else.  Now 

let’s click on Slide Master and we get on the left a Master View.  Now the slide at the very top, 

the one with the larger thumbnail is the Slide Master and the popup tip there says, Used by Slides 

1 to 3.  This Slide Master is used by three slides, and that Slide Master has coming out the 

bottom of it dotted line and from that dotted line it goes into a succession of layouts.  Now let’s 

look at the first layout.  Let’s just hover over that.  That’s the title slide layout that’s used by one 
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slide.  Next one is the title and content layout that’s used by two slides.  Now none of the other 

layouts have been used at the moment, but basically these layouts derive most of their settings 

from the Master.  And in particular, the color, font, font size, etc. they all start life using what 

they inherit from the Master.  So for instance, if I change the color scheme on the Master, I 

change the color scheme on everything that derives from it.  But the Master doesn’t dictate 

exactly where their placeholders are.  If you for instance look at this one, the title and content 

layout, its placeholder here is an independent property of that layout.  So let’s suppose that I 

decided to put that at the top of the screen and to pull the other placeholder, the one with the text 

in it down.  So I’ve changed that layout. That has no effect on the Master.  I change the layout.  

There’s a button here on the Ribbon, Close Master View.  You need to click that button when 

you finish looking at Master View.  Now when I go back to my presentation, the two slides that 

have been generated from that layout have both had their layouts changed because they’re now 

linked to a layout which has itself been changed.  And that really is the relationship between the 

Master, the layouts, and the slides. 

So I think that’s enough for this section.  When in the next section we’re going to carry on with 

this particular subject and we’re going to look at how themes fit in and how we can change and 

customize what’s there and how we can introduce additional Masters.  So please join me for that. 
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Video:  Background Color, Themes and Layouts 

 
Toby:  Hello again and welcome to the second section on Masters, Themes, and Layouts in our 

course on PowerPoint 2013.  In the previous section, we looked at the relationship between 

Masters, layouts, and slides. And just to start this second section, I’d like to look at another 

example just to show clearly how that works, and what I’m going to do is to change the 

background color of a slide.  Now I’ve got the House of Lords slide selected at the moment, so 

let’s change the background color of that. 

I’ve chosen a specific slide, Slide 3, and we know which layout it was built from but if I select 

the specific slide and then right click, one of the options is Format background.  Now I can 

change the background of this slide to a solid fill, a gradient fill, a picture or texture fill, a pattern 

fill.  I’m going to change it to a solid fill and I’m going to choose one of the theme colors.  I’m 

going to choose this green one here and that’s it; that’s the color of that specific slide. 

Now I’m going to go to the View tab, the Slide Master, and I’m going to find the layout that that 

slide was built from.  It’s actually that one, and I’m going to change the background color of the 

layout.  So again, right click, Format background.  I think I’ll go for solid fill again and again 

this time, I think I’ll choose a sort of, that sort of purply color, I think.  Okay.  So I’ve changed 

the color of the layout. 

Now if I close the Master View, what colors will the three slides in my presentation be?  See if 

you can work that out.  And the answer is they’re all three different colors.  The first slide is 

based on a layout which hasn’t changed and that layout will inherit its background from the 

Master and the color of the Master is the gradient that you can see in that slide.  The second slide 

was built from a layout whose background is pink.  The third slide was built from a layout whose 

background was pink as well, but the third slide has also specifically had its background color 

changed to this green color.  And that really demonstrates how inheritance works.  It basically 

means you start at the top, so that’s what everything starts with, whatever the background color 

of the Master is, then individual layouts can be changed, and slides built from those layouts will 

inherit what’s in the layouts except where the individual slides have things changed.  Now this 

doesn’t only apply to background color.  This applies to colors in general.  It applies to fonts, 
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effects on objects, and so on as we’ll see later on.  So this inheritance covers a wide range of the 

stylistic features of each slide, each layout, and each Master. 

Now the next thing we’re going to look at would appear possibly to turn all of that on its head.  It 

doesn’t really.  It’s just a little bit unnerving when you first see it.  The principle factor that 

determines how a presentation looks is the theme, and the theme of a presentation can be 

selected from a large number of themes that are provided with PowerPoint 2013.  You can 

download themes.  You can even create your own themes.  We’re going to restrict ourselves to 

the built in themes here.  And if I say chose that second slide and went to the Design tab, I can 

see available themes.  There’s a group called Themes and if I click on the drop down, there is a 

gallery of themes.  And I can scroll down and live preview applies here so I can hover over each 

of those and look at the affect on my slides. 

Now let’s suppose I choose one of those themes.  Let’s say I choose that one and apply it, watch 

what happens.  Now unfortunately, it doesn’t only apply just to that one slide.  It will be applied 

to all of the slides in this presentation that are based on the current Master, and that’s because a 

theme is applied to a presentation via the Master, not by individual layouts, not by individual 

slides but via the Master.  So if you apply a theme to a slide, you get that theme on everything 

built from that Master. 

Now the good news is as we’ll see later on, you can have more than one Master.  But in 

PowerPoint 2013, there is now an additional factor.  It doesn’t really affect fundamentally how 

that works, but it’s a very useful thing and that is that along with themes you get variants.  Now a 

theme is not just made up of colors.  It’s made up of many things.  It includes colors, but it also 

includes fonts.  It includes effects and certain aspects of background style.  And if I click on the 

drop down next to Variants, I can see that there is a choice of colors on the left.  So I can go 

down and choose a color scheme.  I can look at the available fonts and there are a range there of 

compatible with this theme.  There are effects.  I can choose between the available types of 

effect.  This will affect graphics more than just straightforward text.  And then I can choose 

background styles.  You can see a preview of each of these by hovering over and you can see 

variations on these.  There’s even a format background option here.  So the extent to which I can 

fine tune the theme that’s used in PowerPoint 2013 is really very detailed.  You can really go in 

and make something look exactly the way that you want it to.  But it’s very important to 
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understand that you’re applying a theme and a variant to the Master Slide and you’re not going 

to have this different on individual slides or individual layouts.  You’re talking about it being 

applied to the Master.  So when you’ve chosen your theme and your variant, you can say okay 

that’s the one that I’m going with. 

Now I’d like to cover a couple of things next that are really outside the scope of this course, but I 

think it’s important that you’re aware of them and they’re certainly a good area for research and 

probably experimentation on your part.  Let’s suppose that I want to create a presentation where 

I really do have a very drastic stylistic change in the middle of it.  I’ve done this sort of thing 

myself in the past where I prepared a presentation covering perhaps a couple of key topics. And 

as I go into each of those topics, I want the look and feel of the presentation to change quite 

dramatically.  If I go to the View tab here and then into Slide Master, I mentioned a couple of 

times that you can have more than one Slide Master.  The Slide Masters are numbered.  The one 

we’ve got here is actually numbered one to the left of it.  You can insert a new Slide Master.  So 

if I click on Insert Slide Master, I get a new Slide Master, number two, and it gets a default 

layout and it also gets a set of layouts that are linked to it and each of those has name and a 

particular structure and so on.  And as you’ll realize by now, we can go in and change each of 

these.  So we could either stick with these, make changes, and so on.  But also we can go in and 

start to format that Slide master.  So for instance, if I went in and right clicked on it, I could say 

format background.  I could say well I’m going to apply solid fill for this.  Let’s go for say that 

color, a blue, and that’s a background color for this Slide Master.  Now note because I’ve got 

two Slide Masters and each has its own set of layouts every time I put a new slide into the 

presentation, I can choose whether I want the sort of Master style 1 slides or the Master style 2 

slides.  And to each of those, I can apply its own theme and make all of its own stylistic settings 

and changes.  So that’s a pretty useful facility within PowerPoint 2013. 

The second thing I’d like to point out to you here is that we’ve already seen that you can edit a 

layout when we were looking at the slides about the House of Lords and the House of Commons, 

I showed you how we could move the title from the bottom to the top; basically swap that with 

the text placeholder textbox there was.  So we’ve already seen editing a layout.  You can also 

actually create your own layout.  So if I selected, say, this second Master, in the Edit Master 

Group up on the Ribbon there’s an Insert Layout option.  And if I click on Insert Layout, it 
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inserts a layout at the bottom; select that and I can then go in and edit that layout.  So I could, for 

instance, move that placeholder or even delete that placeholder.  And in fact up on the Ribbon, 

there is a Maser Layout Group on the Format tab and that’s got Insert Placeholder and in there I 

can insert placeholders for text, pictures, charts, tables, so on.  Now many of these we haven’t 

used yet and we’ll be looking at those later on in the course.  But as a matter of principle, it 

means you can create your own layouts or change the layouts that are provided by default to 

make a particular layout that you can use for as many slides as you like.  And, of course, you can 

do these separately for each of the Masters in your presentation. 

Now that’s another topic I’m not going to go into in any detail.  Hopefully by the end of the 

course, you should actually be able to work this out for yourself, particularly when we’ve looked 

at some of these other placeholders later on.  But it’s a very valuable way of saving yourself time 

by letting you create your own Masters and layouts, and then customizing those to your own 

requirements, not only in terms of things like the themes, the colors, background colors, and so 

on, but also in terms of what’s actually on each slide. 

So we’re coming to the end of this particular section now.  We’ve made quite a few changes to 

our presentation and I’ve just got one other topic that I want to cover under the general heading 

of Masters, Themes, and Layouts and that is you may have noticed a little footer, the word 

Footer here and there and you may have noticed the date here and there.  You may even have 

seen a page number here and there, and you may be wondering why none of our slides seem to 

have those on them; that’s what we’re going to look at in the next section.  So please join me for 

that. 
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Video:  Header and Footer 

 
Toby:  Hello and welcome to this third short section on Masters, Themes, and Layouts in our 

course on PowerPoint 2013.  I mentioned at the end of the last section that although we appear to 

have footers and page numbers and dates on our Slide Master, they’re not appearing on the 

slides.  So in this section, we’re going to see how to make those work. 

Now the behavior by which these things don’t appear is actually an intentional behavior.  And 

the idea behind this is that you can control very quickly and easily whether to show these things 

on the slides at any particular time.  You may, for example, want to show things in a presentation 

but not show them in a printed copy of the slides and the notes or vice versa, of course.  And it is 

actually very straightforward to control and you can control it at either the Master level, the 

layout level, or the individual slide level.  Let’s go and take a look at the Master for this 

particular presentation, the UK Parliament presentation that we’ve just started working on. 

So View, Slide Master, go to the Slide Master, and then on the Insert tab, click on Header and 

Footer.  And what you’ll see in Header and Footer is that there are three categories:  Date and 

Time, Slide Number, and Footer of items that may or may not appear on every slide depending 

on these three check boxes.  So if I wanted to show the date and time, I’d check there, slide 

number check there, footer check there and actually put a footer in, in that case.  So let me put as 

my footer. 

Now let’s quickly look at each of these in turn.  Date and time; we have a choice.  We can either 

say “Update automatically” in which case it will show whatever date we are looking at the 

presentation on.  So whenever we’re linked electronically to this presentation, it will show the 

date at that time.  We can say which language we’re using, English United States because 

obviously that will govern the format of the date and time.  So English United States will say 

month, day, year; English United Kingdom would say day, month, year.  And then we can also, 

depending on the language, reset or set the calendar type.  If instead of that we wanted to put a 

fixed date on, say the date we’re aiming to give the presentation or the date the presentation was 

prepared; we can switch to a fixed date and enter the fixed date here.  The slide number is 

straightforward enough although it is possible to format that number in whatever way we want.  

And then for the footer, I’ve really just put a test in there.  Normally, you’d put a more realistic 
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footer in there.  Now having clicked that and bearing in mind that we’re doing this to the Master, 

we click on Apply, and having applied that to the Master it will appear on every slide.  So let me 

go back to the Slide Master tab, close the Master View, and let’s have another look at our slides. 

So I’m going into Reading View now and I’m going to step back through the slides.  I’m on 

Slide 3.  Note where the slide number appears in that sort of black angled bar there.  And on the 

first slide, it appears down there in the black angled bar down there.  Now there was a setting in 

the dialog whereby you can suppress the page number on the first slide, the title slide, if you 

want to. 

Now when you’re looking at these, you may look at something like the date there and think, well 

that’s a bit on the small side really.  And I’ve seen people try to reformat that on individual 

slides, but the point about this and what we’ve been covering in the last couple of sections is that 

if you want to change the size of the footer, the formatting of the date, the size and formatting 

say of the slide number, you need to go to the highest level you can to change them unless you 

have a specific reason to change them, say, on a specific layout or on a specific slide.  So let’s go 

back into Normal Mode and let’s go back to the View tab, Slide Master, and let’s on this 

occasion, say, go to the layout that was used for two of the slides, that’s this layout, click that 

layout.  There you can see the page number where it appears down here.  You can see the 

placeholder for the footer.  Now having selected that placeholder for the footer, if on that 

particular one I said, right, I want that to be a bigger size.  Instead of 10 point, I want 16 point 

and I want it bold and italic.  Now back on to Slide Master, close, back into my presentation.  

You can see the footer on the title page, the first page, but look now at the second page which is 

built from that alternative layout.  On pages built from that layout, it will all appear much bigger.  

And again that’s the principle of inheritance of the style down through the structure from the 

Master through the layouts to the individual slides. 

So we’re going to be using these principles throughout the rest of the course and just one other 

thing to mention here.  If you go back on to the View tab again, you may have noticed in the 

Master Views Group we’ve been using Slide Master a lot.  There is also a Handout Master and 

you can adjust the Handout Master.  We’ll look at handouts a little bit later on in the course.  But 

although you don’t quite have the flexibility that you have with the Slide Master, there’s quite a 

lot you can do with the Handout Master.  And similarly, again if I go back on to the View, there 
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is also a Notes Master and you can customize the Notes Master as well.  Both of those you 

should be able to follow through fairly swiftly and simply.  I’ll look at them briefly later on in 

the course. 

That’s it now for Masters, Themes, and Layouts.  I’ll see you in the next section. 
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Chapter 16 – Lists 

Video:  Bulleted and Numbered Lists 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

Lists, Bulleted and Numbered lists and we’re going to start by taking a look at one of the slides 

that we have in our presentation about the PowerPoint 2013 Ribbon. 

Now probably the most important thing to point out here is that when you are creating a bulleted 

list like this one or adapting or customizing, modifying a bulleted list like this one, you need to 

make sure that you are making it at the correct level.  What I mean by that is that I’m going to 

demonstrate some of the features of bulleted and numbered lists here on an individual slide, but 

in fact you may want to work on the layout that this and other slides were created on or maybe 

even from the Master Slide so that any changes you make to a bulleted or a numbered list are 

carried forward into either the equivalent slides in the same presentation that are built from the 

same layout or indeed all of the slides in the presentation.  So although I’m going to demonstrate 

this on an individual slide, for the moment we’ll look at applying those changes to a layout or a 

Master a little bit later on in the section. 

You may already have noticed that most of the templates that are available in PowerPoint 2013 

and maybe most of the ones that you’ve tried using already feature bullet point lists very 

strongly.  And traditionally with PowerPoint, bullet point lists have always been a major feature.  

In fact, if you look at PowerPoint presentations nowadays, it’s still usually the case that many of 

the slides feature bullet point lists.  This is very often because the slides are used to accompany 

perhaps a talk, description, a speech where the speaker, the presenter wants to be reminded of the 

main points and the bullet point list is a very convenient way of doing this.  I would anticipate 

that you’ll probably want to incorporate bulleted or numbered lists into your presentations.  So 

it’s worth spending a little bit of time talking about how to customize them and how to use them 

to good effect. 

On the slide we’re looking at now which is for the Home tab on the Ribbon and with the names 

of three groups:  Slides, Paragraph, and Drawing.  Let’s look at how we can actually customize 

the bullet list.  First of all, if I select the three lines, note that many of the commands on the 
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Ribbon become available and if I go up to the Paragraph Group, the top left command is the 

Bullets command.  And to the right of that, there’s a little drop down.  If I click on that and that 

gives me a list of the default bullets that are available.  Now at the moment, I’ve got filled round 

bullets.  If you select the one to the right of that, note you have live preview, hollow round 

bullets.  Then we have filled square bullets, hollow square bullets, and so on.  You can quite 

easily change the bullets that are used in a bullet list. 

And in fact note that I’ve still got these three lines selected.  If I click on that same drop down on 

the Bullets button in the Paragraph Group again, go down to the bottom Bullets and Numbering, 

there are two further options down here in the bottom right hand corner.  One of them is 

Customize; one of them is Picture.  If I click on Customize, first it gives you access to the 

symbols that are available.  So you can use any of the available symbols as a bullet point.  So for 

instance, if you wanted to use the Pi character, click on OK, click on OK, you’re bullet point list 

is now made up with the bullets as Pi characters.  I’m just going to undo that particular change.  

And again back into there, Bullets and Numbering, click on Picture, and you can actually choose 

a picture from a file on your own machine or you can go to Office.com ClipArt or do a Bing 

Image search or even go to your SkyDrive.  So you can put your own picture in there if you 

wish. 

Now one of the things to notice about a bullet list, I’ve put the cursor to the right of the word 

Drawing. If I press the Enter key, the bullet list automatically continues and if I want to end it, 

there are a couple of ways of doing it.  One of them is if I press Enter, so I’m continuing the 

bullet list but then I press Enter again, I actually get a gap in the bullet list.  If I want to switch 

the bullet list off, all I need to do is to press the Bullets button in the Paragraph Group.  Click 

that on the button not the drop down and we no longer have a bulleted list.  So I could now just 

start typing things in a regular kind of way.  So if I now type the word Clipboard, for example, 

it’s not a bulleted item. 

So having typed the word Clipboard there, what I’m now going to do is to show you numbered 

lists and there’s a button to the right of the Bullets button in the Paragraph Group.  There’s a 

number one that’s called Numbering.  And if I click on Numbering, what happens is Clipboard, 

the word I just typed, becomes part of a numbered list.  And again the numbering is an automatic 

system, unless I cause it to stop and, of course, it counts upwards.  So if I now type in Slides, 
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that’s item two in the list; Font, that’s item three in the list; and so on.  And the numbering is 

automatic.  And, of course, the way you would stop the numbering is the exactly the way that we 

stopped the bulleting just now. 

Now for both of these types of list, bulleted and numbered, I can easily insert another entry 

within the list.  So if I take the bulleted one to begin with, it goes Slides, Paragraph.  If I wanted 

to start it at Clipboard, if I click to the left of the word Slides and type in Clipboard and press 

Enter, it automatically sorts out the bulleting.  And if I go to the end of the word Slides, press 

Enter, and then it automatically gives me a line that I can type Font on to.  So in that way I can 

insert within the list as well.  Well, it’s exactly the same way with a numbered list. 

So what I’m now going to do is to remove the numbered list from this slide.  So let me just get 

rid of Clipboard, Slides, and Fonts, select them all, press the Delete key, and now I’m going to 

select that list.  The list now with the six group names in it.  And I’m now going to press the 

Numbering button and it just turns the whole list into a numbered list.  Similarly, to turn it back 

to bulleted, very straightforward.  Note that when I do that it goes back to the default bullets 

again. 

Now let’s suppose that I want to put into here the names of some of the commands.  I’m going to 

put in the names of three of the commands from the Slides Group.  So I’ve got Slides there.  I’m 

going to go to the end of the word Slides, press Enter, and then I’ve got New Slide is one of the 

buttons, Layout is another one, and Reset is another one.  Now what I want to do next is to give 

this some structure.  So what I want to do is to indicate that those three buttons, those three 

commands I’ve just entered the names of are actually within the Slides Group, and the way I do 

that is to select those three and then in the Paragraph Group, if I move along to the right, there’s 

a couple of buttons we’ve used already in another context.  There was Decrease list level and 

Increase list level.  In this case, I want to increase the list level for those three.  Watch what 

happens.  What I now have is the beginning of a structured list, a structured bulleted list, where 

three items are indented.  Now similarly, if I wanted to put in three items in the Clipboard Group, 

if I pressed Enter after the word Clipboard, what I could do is do the indenting first and then type 

the names.  Well, you can’t see the names there at the moment but hopefully by now you know 

what they are anyway.  You’ll also notice that as I do that, PowerPoint 2013, because it’s using 
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an intelligent placeholder for this text, will resize the font to make sure that it can fit everything 

in. 

Now I’ve selected the whole of my list again and it’s obviously a bulleted list with a bit of 

structure to it.  I should point out that I can carry this structure to many more levels if I want to.  

But if I now go into the Paragraph Group and go back to the numbering list and click on 

Numbering, watch what happens.  I finish up with a two level numbered list.  The top level 

items, Clipboard, Slides, Fonts, the names of the Groups are still number 1, 2, 3, 4, 5, 6, but 

within those, the individual commands within each group are also numbered 1, 2, 3, and so on. 

Now that may not be the most convenient way of numbering and I can, in fact, go in and 

customize that.  So for instance, if I took the first three here:  Paste, Copy, Cut.  They’re the 

commands within the Clipboard Group, select those, click on the drop down next to Numbering 

and say went for the ABC option.  Again, note the live preview.  I could structure that in that 

way and that maybe with the next group same thing as well.  So in that way I can give myself a 

nice numeric structure to the items in a list on a slide. 

So you can see how flexible this numbering and bulleting system is.  Let’s suppose that I want to 

setup all of my slides in this presentation that have tabs, groups, and commands on them in this 

way.  I’m not going to go through each of them individually.  As I mentioned at the beginning of 

the section, it will be a much better idea to go the specific layout or even to the Master and setup 

this structure. 

Well, let’s choose on this occasion to use the appropriate layout because I’ve used the same 

layout for all of the slides in this presentation except the very first one.  So click on View, click 

on Slide Master.  Now let me find the layout that’s used for these.  That’s the Master.  That’s the 

title slide.  That’s the one.  It’s the one that’s used.  And if I look within the placeholder, note it’s 

actually got a picture of the levels of the bulleting or numbering structure here.  If I click in the 

first one, the top level, what I want there is numbering; so if I click to the Home and then select 

Numbering, that will show up as numbering.  Now let me go to the second level.  Remember, 

I’m working on the layout here, not on individual slide.  Let me now go and choose the lettering 

and that’s it.  So I want one at the top level, lettering A, B, C, and so on at the second level.  If I 

don’t intend to use the other levels, I don’t need to do anything with them because they’ll never 
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appear.  So let me go back to Slide Master and close that.  Now let’s look at the other slides.  

Clearly, that’s the one we did manually.  Let’s go to another slide, say the Insert Slide.  Let’s 

look at the Images Group within there.  Let me do Pictures as the first command and then, of 

course, I have to indent it, increase the indent level to make it appear at the second level and, of 

course, it becomes an A.  So if I go back to Insert, I can then say Online Pictures.  That will be a 

B and so on.  And you can see there the advantages of working on the layout because all of the 

other slides inherit the same structure and you don’t have to keep resetting numbering at the top 

level, ABC at the second level, and so on.  It’s all done for you automatically by applying it to 

the layout.  If in fact you wanted to use that same style throughout the whole presentation, you 

could exactly the same thing on the Master Slide. 

So that brings us to the next exercise for you to do.  I would like you to extend the presentation 

on the tabs on the PowerPoint 2013 Ribbon so that for each of the tabs you still have a list of 

three groups, but within the groups you have up to three commands.  With some of the tabs there 

are not that many groups and commands on the tabs.  So for instance, the Transitions tab that you 

can see here the Preview Group only has a Preview command, the Transitions to this Slide 

Group only has a gallery and then a single command, although the Timing Group has a number 

of commands and options in it.  So do your best to make each of them up to three and three.  I’d 

also like you to include date, footer, and slide number on each of the slides except the title slide.  

I’d like you to apply a theme and a variant of your choice and, of course, run a spell check to 

make sure that you’ve spelled everything on all of your slides correctly.  I’ve saved my answer to 

that as example-06.  I’ll see you in the next section. 
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Chapter 16 – Paragraph Formatting 

Video:  Alignment, Line Spacing, Ruler and Tabs 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

formatting paragraphs. 

So I have here a slide about the House of Commons in the UK.  It’s got three bullet points.  Each 

of the bullet points is a paragraph.  If I right click on the overall selection of all three bullet 

points, all three paragraphs, I see in the contextual menu there is bullets.  If I hover over that and 

click on None, then I’ve removed the bullets from the three paragraphs and I can look at the 

three paragraphs now independently of those. 

Now when you’re doing paragraph formatting in PowerPoint 2013, it works differently from text 

formatting in that if you just have the cursor somewhere, say, somewhere within the first 

paragraph, any paragraph formatting commands that I execute will apply to the whole of the first 

paragraph even though I haven’t got the paragraph selected.  For paragraph formatting, you only 

need to have the cursor in the paragraph, you don’t need to actually select the paragraph.  If I 

wanted to apply a paragraph formatting command to the first two paragraphs though, I would 

need to select the two paragraphs; just sort of swipe over them with the mouse, something like 

that.  Similarly, if I wanted to apply a command to the three paragraphs, I’d select the three 

paragraphs like that. 

Now in order to demonstrate these commands, I’m only going to use one paragraph in this 

section.  So let me just delete the other two paragraphs and then the paragraph formatting 

commands we apply will apply to the first paragraph as long as I have the cursor somewhere in 

that paragraph. 

So the first thing I want to do is to look at the horizontal alignment of the paragraph.  So if I go 

the Home tab in the Paragraph Group, you can see that one button is highlighted.  It’s the one 

that says Align Left, and align left means that that paragraph has the left edge of each line 

aligned in a vertical straight line.  So you’ve got a sort of tidy edge on the left.  Conversely, the 

right hand end of the paragraph is untidy.  The lines are different lengths.  A printer would say 

that this paragraph is ragged right.  So it’s straight on the left, but ragged on the right.  And with 
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horizontal alignment controls, we change that from align left to, for example, the second setting 

which is center.  And center is ragged on the left and ragged on the right because for each line, 

the text on that line is center aligned on the individual lines.  This paragraph is in effect center 

aligned on the text box that it’s in.  The next horizontal alignment setting is align right.  And 

with align right, the right edge is straight, the left edge is ragged.  By ragged we mean the lines 

are different lengths so it looks a bit sort of untidy on the left.  And then the fourth horizontal 

alignment setting is justify or justified, and what happens here is with the exception of the last 

line every other line is aligned on the left and aligned on the right.  So this is if you like the 

tidiest setting.  And the way that PowerPoint 2013 achieves this is by varying the amount of 

space between the words on each of the lines so that each of them is padded out to fit the 

available space on the line exactly.  Justified setting traditionally has been used for things like 

newspapers and magazines and you do see it quite a bit on web pages, particularly ones where 

there are several columns on a page and the person who’s designed the page is trying to keep it 

looking as neat as possible.  So they’re the four possible settings for horizontal alignment. 

There’s also a choice of settings for vertical alignment for a paragraph within its textbox.  And 

within the Paragraph Group, there are three buttons on the right.  The middle one is Align Text; 

click on the drop down, and you have three options there.  These have live preview.  So if I 

hover over top first, that’s top aligned, middle aligned, and bottom aligned and you can see how 

choosing one of those causes the vertical alignment of the paragraph within its textbox to change. 

Now incidentally there’s also a setting at the bottom, More Options, that brings up what’s called 

the Format Shape Pane where not only can we set the vertical alignment for the text in the box 

but we can do things like adjust the margins; tell PowerPoint 2013 how or whether to do AutoFit, 

and several other things.  We’re going to come back to some aspects of this later on, but for the 

moment, just be aware this Format Shape Pane can be applied to a textbox.  Let’s close that and 

let’s stick with the middle alignment for this paragraph within this textbox. 

Now apart from the vertical alignment within this textbox, each paragraph has its own line 

spacing and the line spacing really states how much vertical space each line within the paragraph 

has.  Now I can best show you what this means by showing you the line spacing in this current 

paragraph.  Still in the Paragraph Group, we had the Align Text button there.  If you go left from 

there and up a bit, there’s a button labeled Line Spacing. And if you click on the drop down, it’s 
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currently set to one which means that each line in that paragraph, there are three lines in that 

paragraph, each line has one unit of vertical spacing.  Now using live preview, look what 

happens if I go to 1.5, look at the paragraph; 1.5 gives each line in the paragraph more vertical 

space.  It doesn’t make the text, it doesn’t make the individual characters any bigger, the 

characters are the same size but they have more space.  So it tends to give the whole paragraph 

more space.  In some situations, it would probably make it a little bit easier to read.  If I go to 

two, even more space, 2.5 and so on.  So you can set line spacing to suit the particular 

requirements.  I’m going to stick with one here.  But just while we’re here let’s have a look at 

this line spacing options at the bottom because that brings up a Paragraph dialog that we’re going 

to look at in a minute or two’s time.  The Paragraph dialog includes not only this line spacing 

setting down here which is currently single, that’s the same as 1.0, but it also enables us to 

specify how much space we want before a paragraph and after a paragraph.  So if you want to 

move a paragraph down the page, leave a bit of space between it and the paragraph before or put 

some space after it, then you can use these settings to change the spacing before or after.  The 

line spacing is the spacing within the paragraph itself.  So I’m going to stick with single. 

Now there are situations when you’re dealing particularly with text in a paragraph that you need 

to position and space the text carefully as well as deal with issues like alignment.  And in order 

to show you one or two of the tools and techniques here, I want to introduce you to the Ruler.  

Now on the View tab, there is a check box for Ruler.  We’ve not used the ruler so far, so click on 

Ruler and you get a pair of rulers.  You get a horizontal ruler at the top of the slide pane here and 

another ruler down the left hand side.  Now the ruler is graduated in whatever your regional unit 

settings are.  If you’ve used the ruler in other components of the Microsoft Office Suite in some 

of them, you can change the units from within the Office component itself.  In the case of 

PowerPoint, it doesn’t work that way.  In the case of PowerPoint, the units used are the ones you 

have set for your region in your Control Panel settings in Windows.  So in this case, my machine 

is set to English United States.  The units I’m using are inches.  If I wanted to work in 

centimeters, I would have to go into the regional settings in Control Panel; in this case, in 

Windows 8, and change the settings to metric from inches.  But for the moment, I’m going to 

assume we’re going to continue to work in inches. 
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And I want to look, first of all, at what are called the indent settings for this paragraph.  Now the 

indent settings can be done in two completely different ways.  One of them is to use this little 

pair of controls here.  They’re like the old metal controls you used to get on very old style 

typewriters where you have two little wedges that you slide along.  Now if you look at the 

paragraph itself “The UK elects”, I’m going to drag the first, the top one of those wedges along 

to the one inch mark and watch what happens.  I’ve left the other one where it is and the first line 

is now indented by one inch; the sort of old style beginning of a letter.  But I could have not 

moved that one at all, but instead moved the lower one, and then I would’ve had this situation 

where the first line isn’t indented but the second and subsequent ones are.  So that’s how you can 

control paragraph indents using the ruler. 

Now there is an alternative way of controlling paragraph indents using the Paragraph dialog.  

And if we go back to the Home tab, click on the Dialog Box Launcher in the bottom right hand 

corner of the group, it brings up that dialog and as you can see now we have the settings that 

have been set using the slides on the ruler.  So indentation before text one inch, special, and it’s a 

hanging indent.  So we’ve got a one inch hanging indent.  If I change that to be a first line indent, 

click on OK, we’ll see what happens.  What we have now is that we have an overall indent of 

one inch, but in addition on the first line we have a one inch indent.  So you can actually adjust 

the indents using either method: either using the dialog box or by using the ruler directly. 

So I’m going to use the ruler to put those indents back, both of them back to zero and I’m going 

to look now at tabs because many people use tabs in order to align text.  And with the cursor 

where it is before, the word “The” at the beginning of the paragraph “The UK public”.  If I press 

the Tab key, it will take me to the first tab position.  Press it again takes me to the second tab 

position, third tab position, and so on.  Now by default and this is the case with most of the 

templates for PowerPoint presentations that you’ll see, there are no tab sets so they default to 

being at half inch intervals if you’re using Imperial that’s inches style measurements.  But you 

can set tabs as well.  So let me just delete the three characters that I just typed.  Let’s go back 

into that dialog again and this time use tabs in the bottom left hand corner.  Now there are no tab 

stops set here, so as it says at the top right there, the default tab stops are at 0.5 inch intervals 

which you can actually change.  You can make them at a different interval.  But supposing I 

want to set some tab stops, let’s suppose I want to set a tab at two inches. So type a two for tab 
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stop position, click on set. I want to set another one at say five inches but I want this to be a 

center tab, set that.  And let’s suppose I want to set another one say at eight inches and I want 

that to be a right tab.  So I’ve now set three tabs; two is a left, five is a center, and eight is a right 

tab, click on OK, click on OK.  Now watch what happens when I press the Tab key from the start 

of the paragraph “The UK public”.  Press Tab once; that takes me to the two inch mark.  Press it 

again; it takes me to the five inch mark.  Press it again; it takes me to the eight inch mark.  Now 

take a look at what’s on the ruler because those tab marks are now set on the ruler and by the 

shape of the tab mark you can tell that two inch one is a left tab, tell by the shape; five inch one 

is a center tab, eight inch one is a right tab.  And in fact, you can move those about.  You don’t 

have to use the dialog.  So if I wanted to move the center tab, I could literally drag it to a 

different position.  Again, with the eight inch one, drag it to a different position and you can 

setup and use tabs much as you would in any kind of word processing program as well. 

And of course, it’s very straightforward to go back into the dialog again, into the Tabs dialog 

again, and then if I wanted to clear a particular tab, I just select it and click on Clear. Or indeed if 

I click on Clear All, then everything’s back to the default tab stops every half an inch. 

So they are the main aspects of paragraph formatting in PowerPoint 2013.  I’m going to briefly 

look at textbox formatting a little bit later on, but for the moment that’s it. But for one thing, and 

that is generally speaking, paragraph formatting is also something that you would apply at the 

appropriate level.  So if you wanted all paragraphs to be left aligned, you would apply that at the 

Master level.  If you wanted a particular style of textbox on a particular style of slide for which 

you were using a particular layout, you may for instance do middle vertical alignment on that 

layout Master.  It’s not a good idea to rely on doing all paragraph formatting at the slide level.  

So as with the other aspects of the use of Masters, layouts, and slides that we’ve looked at, make 

sure you apply this to the appropriate level. 

So that’s it for this section.  I’ll see you in the next one. 
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Chapter 17 – Working with Images and ClipArt 

Video:  Inserting Pictures 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to start to look at putting pictures into your presentations.  If you’ve used PowerPoint 

before in an earlier version, even quite a recent version, you’ll find that in PowerPoint 2013 the 

way that this works has changed quite fundamentally in one or two areas so it’s probably worth 

paying attention to this section and the next one just to see the scale and nature of those changes.  

What I’m going to do first in this section is to show you some of the most straightforward ways 

that you can include pictures and I’m going to put some pictures into the presentation we’ve been 

looking at on the way that the UK Parliament works.  Now, when you come to do an exercise 

later on in the course, you may want to apply the same principle to a description of how your 

own government works or how an organization that you know of or are involved in works.  So 

let’s put some pictures into this presentation. 

So first of all, I’ve got the title slide here, the UK Parliament, an overview.  Let me insert a slide 

after this one.  If I go to the Home tab and click on New Slide, one of the layouts that’s available 

to me is Title and content. So let me, first of all, put that one in, and that lets me put in text as we 

saw before.  By default, we get a bullet point.  But I also mentioned that we can put in here any 

one of a number of other types of object; insert table, insert chart, SmartArt, graphic, video.  One 

of those options is online pictures.  So what I want to do now is to click on Online Pictures.  

Now when I click on Online Pictures, I get this dialog and this really gives me three options.  

One option is to insert ClipArt from Office.com.  There’s a very important note there, Royalty 

free photos and illustrations.  I’ll come back to that in just a moment.  The other option is to do a 

Bing Image Search, search the web.  Another one is to go to my SkyDrive and use an image 

from there.  Now one of the things you need to be very aware of when you’re preparing 

presentations is copyright and royalty issues.  I’m certainly not going to go into those at length 

here but you should be aware that most of the material that you can acquire online will be subject 

to some kind of copyright or royalties.  If you’re only ever going to look at it on your own 

computer, I guess nobody else is going to find out about it.  But if you’re going to publish a 

presentation or give a presentation in public, other people may see an image.  You need to be 
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aware of the consequences of breaching somebody else’s copyright or not paying somebody else 

royalties on the use of their photos and illustrations. 

Now clearly, the material I may have in these situations can be very different.  If I’ve got my 

own photos or my SkyDrive, I may own copyrights on those.  There’s absolutely no problem 

including those in my presentations.  If I do a search, Bing Image Search, let’s suppose I did a 

Bing Image Search on Parliament.  Type in the word Parliament and click on the Search button, 

then with PowerPoint 2013 what happens is you get results that are images licensed under 

Creative Commons.  Now Creative Commons really comes in a number of different versions and 

depending on which version of the Creative Commons license agreement a particular image has 

operating on it, you may or may not be able to use that image.  Now you need to check what the 

conditions are for any particular image and then if you plan to use that, you need to make sure 

obviously that you satisfy those conditions.  If you go outside Creative Commons and you do 

that by clicking here, Show all web results, you’ll get even bigger selection of images to choose 

from and you’re going to need to be even more careful about copyright and royalty issues.  In 

many cases, you’ll get images on a search which will be available from one of the commercial 

image sources who will charge you a certain amount of money to use one of their images.  It may 

be just a flat fee.  It may be related to how you’re going to use it or for how long you’re going to 

use it.  In the case of the Creative Commons, one here for Parliament and bear in mind this isn’t 

just the UK Parliament; this will be any Parliament around the world.  There are over 47,000 

available images.  If I did a search on the whole of the web, I’m sure there would be many times 

that many.  But there are almost always many images available for any purpose that you might 

want to use it, but you need to be careful about those copyright and royalty issues. 

Now in the case of Office.com ClipArt, the story’s a little bit different in that Microsoft as you 

can see there make the point that it’s royalty free.  There are conditions associated with using 

these images to do with you owning valid and legitimate Microsoft licenses.  Again, I’m not 

going to go into those now; you need to check those yourself.  But once you’re sure that you’ve 

satisfied those conditions, you can use what’s called the Office.com ClipArt.  ClipArt used to be 

thought of purely as cartoons, but nowadays ClipArt includes photographic images as well.  So 

let’s find some ClipArt for Parliament. 
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So again type in the term into that box and click on the Search button and I found some ClipArt.  

Let me try to find a picture of the houses of Parliament.  Well, there we are; there’s one.  All I 

need to do is to select it.  I can either double click or I can click on Insert and that image is 

inserted into my slide.  I could then of course, for instance, just type in a heading for it and then 

let me just center align that heading within its title box.  I could actually make the title textbox 

smaller on this particular slide and that’ll enable me to make the photograph itself bigger, which 

we’ll come back in just a moment. 

Now there are a couple of things to point out here.  One of them is that inserting an image pretty 

much is what you’ve just seen happen.  It’s a very straightforward process.  Whatever the source 

of the image, it rarely involves more work than that. But choosing an image is another matter all 

together.  For example, very often the images that are available tend to be of that fairly square 

4:3 type of size and the presentation we’ve got here is a 16:9 size of presentation.  So where 

you’ve got a widescreen presentation, you maybe need to use those squarer types of image a 

little bit more carefully.  Again, I’ll come back to that point in a moment. 

The other point to make here, although this is more to do with actually giving the presentation, is 

that I might at this point switch on the notes, go a few panel stick on the notes pane, and actually 

type in now some notes about what I’m going to say in my presentation at this point.  So The 

British Houses of Parliament, and then maybe talk about that picture and the sort of image that it 

conjures up before we get into the relatively dry subject of the presentation.  Now, of course, at 

this point generally I might put some much more detailed notes there and talk about the river 

Thames or whatever.  So this is a good way, if you like, prompting yourself in the presentation 

and having those notes written and thought about what you’re going to say is a great way of 

making sure that your presentation goes well. 

So let me now go to the third slide, the one that says The House of Commons and you may recall 

that we created this from a layout which we’ve used on a couple of slides.  What I want to do 

now is to change that layout.  Layout, title and content was the one that was used.  I’m now 

going to change that to be two content.  Now note that I’ve still got a title area at the top, but I’ve 

now got two content areas.  Watch carefully what happens.  When I’ve got two content areas, the 

text that occupies the only content area on the original layout now occupies the first content area 

here and the second content area is empty.  So if I now go into this second one, hover over and 
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choose Online Pictures, I’m now going to search in there again on Parliament.  I could even use 

the same picture if I wanted to.  Let’s see if there’s one that I prefer.  I think I might choose that 

one, click on Insert, and you see that what’s happened here is that I’ve used a different shape of 

picture alongside the text to go with this presentation.  Now that isn’t actually a picture of the 

House of Commons.  It’s a picture of Big Ben.  But I’m sure you can see the general idea there 

of incorporating an image on the same slide as we’ve got some bullet text as well and also the 

way that I’ve changed the layout of this slide from a slide with just title and content to a slide 

with title and two pieces of content. 

Now there are another couple of options for inserting pictures into a presentation.  I’m going to 

come back to those a little bit later on.  I’m going to look at the general Pictures and then at 

Photo Album later on.  But in the next section, I want to take a look at formatting the pictures 

we’ve inserted into this presentation already.  So please join me for that. 
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Video:  Formatting Pictures 

 
Toby:  Welcome back to our course on PowerPoint 2013.  This is the second section on pictures 

in PowerPoint 2013.  In the previous section we inserted a couple of items from the ClipArt 

library on Office.com, and in this section we’re going to look at different ways of formatting and 

presenting those pictures. 

Now the first thing to note is that if you click on a picture and select it, first of all, you’ll see the 

selection handles that tell you that that picture is selected and at that point you get an additional 

tab on the Ribbon.  So Picture Tools and you have a Format tab.  Click on the Format tab and 

you have a number of options available both in terms of making changes to that picture and in 

terms of how it’s formatted and presented. 

So let’s start with the size of the picture.  There’s a group at the right hand edge of the Ribbon on 

the Format tab called Size.  When it comes to resizing a picture, there are basically two options.  

One way of doing it is to do it visually by dragging on those sizing handles.  The other way is to 

use a couple of controls in that Size Group.  Let’s do it visually first.  You may well realize that 

if you pull the picture, say, by this sizing handle in the middle on the left, you’ll actually distort 

it.  You’ll change the aspect ratio of the picture and distort it.  Of course, in some situations that 

may be what you’re happy to do, but that’s not what I want to do here so I’m going to undo that 

change.  On the other hand, if I pull the picture using one of the sizing handles in a corner, then I 

maintain the aspect ratio of the picture.  So in this case, if I say pulled it that way, then I would 

maintain that aspect ratio.  Now if you look at those controls in the Size Group, one says 4.13 

inches, that’s the height.  One says 5.17 inches, that’s the width.  Watch what happens when I 

release the picture.  They are reset to that new size that I’ve set; the shape height and the shape 

width.  And I could, of course, have used those to do the resizing anyway.  So if I knew exactly 

what size I wanted, then I could use those.  Note that they maintain the aspect ratio.  I’ll come 

back to that point in just a moment.  So they’re basically the two ways of resizing that picture. 

When I’ve resized, I can reposition it if necessary again either visually or using a control that 

we’ll come back to.  Let’s do it visually first.  Hover over the picture, click with the mouse, and 

then I can just move it around to put it visually into the position I want.  You may just see there a 
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little vertical dashed line appearing which is an alignment facility that, again, we’ll come back to 

a little bit later on.  So I’m going to just release that picture there. 

And, of course, if you’re a touch screen user, that works pretty much the same way.  If I tap on 

the picture, I get sizing handles, differently shaped but basically sizing handles, and then I can 

either tap and hold one of the sizing handles to resize the picture or indeed I can just tap and hold 

within the picture and pull it around on the slide.  And those guide lines that we’re going to talk 

about later on will help me to position the picture visually as well. 

The other important option to do with the size of the picture is the ability to crop the picture, 

which basically means to remove part of it either from one of the sides, the top or the bottom, 

and there’s an option within the Size Group which is Crop.  If I click on the Crop button, what 

happens is I get a differently shaped set of markers.  Now these appear as black markers just 

inside the edge of the picture, and on the corners, they are these sort of right angle shape markers 

on the sides of those straight lines.  If I pull the middle top marker down, for example, I would 

just crop from the top of the picture.  So let me just pull that down and you’ll see what happens.  

And the dark area is the area that would be cropped, the area that would be cut from the picture if 

I cropped now.  Similarly, if I did, the same at the bottom, wanted to remove a bit of the river 

Thames, hover, pull, I could crop that.  Now as you can see in this example that is one way of 

completely changing the aspect ratio of the picture without actually distorting it.  I haven’t 

changed the aspect ratio from the point of view of distorting the picture there, but I have changed 

the aspect ratio of the overall resulting picture because when I click Crop, I’ll actually finish up 

with what is more of a widescreen sort of image which I could then manually, or using the 

controls that we looked at just now, extend out to be a bigger size.  I’ve cropped the picture but I 

haven’t distorted it. 

Now as we’ll see for many of the things that we can do to photographs, ClipArt, and so on, there 

is a particular pane that contains most of the controls that you’re going to want to be able to use.  

In the Size Group here in the bottom right, there’s a little Dialog Box Launcher.  If I click on 

that, it brings up the Format Picture Pane and that actually contains the tools and others that 

we’ve used so far.  So for instance, here we open it at the size options.  Now with the size 

options, we’ve got controls there where we can change the height and the width, either type in a 

height and width or use the little tumbler controls.  But note also just below them, there is a lock 
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aspect ratio option that’s currently checked and all the time that’s checked, we’re going to lock 

the aspect ratio when we’re working on the size of this picture.  We can also look at things like 

how the height and width have been scaled and we can look at the original height and so on.  So 

and we can reset to the original height, width, etc.  So there’s a lot of flexibility and a lot of 

power in that Format Picture Pane and we’re going to come back to that from time to time. 

Well, there’s something to point out here that I think is quite useful to know about.  If you 

consider this Format Picture Pane, for example, that pane is actually movable.  If it would suit 

you to put that somewhere else and possibly make the image you’re working on a little bit 

bigger, if you click with the mouse and you can drag it and hover it over some other part of the 

working area.  In this case, that makes the image you’re working on much bigger.  Sometimes 

it’s a little bit easier to see what you’re doing.  And then when you finished with that, you can 

just grab it again, pull it back, pull it over to the right, and then it basically snaps back into 

position. 

Now let me look at some of the other options on the Format tab and let’s start in the Adjust 

Group.  There are a number of adjustments you can make to a photographic image.  There are 

actually many of them.  Let’s take Corrections as an example.  Click on the drop down, and we 

have some sharpen and soften options and some brightness and contrast options.  Now these are 

all live preview.  So let me hover over sharpen and soften first and look at the impact on that 

image.  You can see that at the soften end, it becomes more blurred, and then at the sharpen end 

it becomes much sharper.  The default setting, the one we’re starting with, is right in the middle.  

Similarly, below that we have brightness and contrast.  The starting point is the middle one.  

Brightness with a 0% change, contrast with a 0% change.  And then by moving to the left, we 

can reduce brightness.  Moving to the right, we increase brightness, and then contrast, we adjust 

by moving up and down the list.  So you’ve basically got a gallery to choose from.  If you want 

finer controls than that, then you won’t be surprised to discover that if you click on Picture 

Corrections options, it brings up the Format Picture Pane again with a different page selected.  

These icon tabs here give you the different pages of the Format Picture options.  Open at the one 

we’ve got, Picture Corrections, and then it lets you choose sharpen/soften presets, 

brightness/contrast presets, and then to set the relevant controls, sharpness/brightness contrast on 
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a slider scale.  So you can get a very fine level of control over adjustments to your pictures using 

that approach. 

So let me just close the Format Picture Pane one more time.  Now what I want to look at is a 

couple of these other groups.  Picture Styles, again, that’s a very useful one because if I click on 

the More corner drop down button there, I can see a number of styles and if I hover over these, 

live preview as usual, I can see different ways of presenting that same picture.  Note that in 

producing those different ways, what PowerPoint 2013 is doing is applying a number of different 

things.  It’s applying different types of border, different types of picture effect, different types of 

picture layout.  And apart from the fact that you could go over the live preview gallery here and 

perhaps choose the one that you like, you also have buttons here Picture Border, Picture Effects, 

Picture Layout, each of which takes you into the Format Picture page for that particular aspect, 

and then you have a fine level of control over what you can do.  So really this set of format 

commands is a very powerful way of processing photographs within your PowerPoint 2013 

presentation. 

So when you come to work on your equivalent presentation to this one, I want you to try as many 

of those different ways of presenting images as you can.  I just want to show you one other thing 

in this section and for that I’m going to go back to the first slide in the presentation and I’m 

going to look at the background of that slide again. 

So if I right click on that slide, as you may recall, one of the options if Format Background, and 

up comes a Format Background Pane.  And this time instead of putting in solid fill or gradient 

fill, I’m going to use a picture fill.  Now watch what happens with picture fill.  Don’t be put off 

by that texture there because what I’m going to say here is insert picture from and then I’m going 

to insert picture from online.  I’m going to go back and find that same picture again that we’ve 

already used, and I’ve inserted it and it is now the background on that initial slide.  Now 

although it’s a background it’s pretty much dominating the slide, you can barely see the title.  

But what I want to do is to change the transparency of that picture.  If you look a little bit further 

down here, you can see that entry there, transparency 0%.  Let me try a transparency of 50% and 

you can see what happens.  I finish up with a sort of slightly misty masked semi-transparent 

background image with a picture of the houses of Parliament and Big Ben on.  Let’s try 80%.  

Now what you can see is a much more faint background.  And if I made that 90%, that may be a 
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very good background for every one of the slides in my presentation.  Now, of course, because 

I’ve applied it to a specific slide it’s only going to appear on that first slide, but I could apply it to 

a Layout Master or indeed to the overall presentation Master if I wanted that consistently as a 

background.  I’m going to leave that in place at the moment for this one.  You may want to 

experiment with something like that on your presentations. 

So that’s it on this section.  In the next section, I’d like to look at photos a little bit more and very 

specifically we’re going to look at creating Photo Albums in PowerPoint 2013.  So please join 

me for that. 
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Video:  Photos and Photo Albums 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, I want 

to look at photographic images and in particular at the facilities for making a Photo Album in 

PowerPoint 2013.  This is going to be quite a short section because many of the things that you 

need to know about we covered already in the earlier sections about pictures. 

Now in those earlier sections, we were doing insertion of online pictures, and the pictures might 

be ClipArt; so drawings done with a colored pen, for example, or could’ve been photographic 

images, which is where we got most of the images from that we used.  Now at that time we 

weren’t particularly troubled about what format those pictures were.  In this section, we’re going 

to look a little bit more closely at picture formats. 

I’ve got here a new presentation that currently only has a title slide.  Let me insert a new slide 

and the new slide is a title and content slide.  And this time, in the choice of content in the 

middle instead of online pictures, I’m going to choose the pictures option.  And if I click on the 

pictures option, I get an Insert Picture dialog and this time instead of taking me to the web to 

either look at Office.com for ClipArt or perhaps to do a Bing Search, it’s taking me to a default 

folder on my PC where I have a number of images. And in fact, I have a couple of folders with 

even more images in them.  And what I’m doing here is inserting a picture and by default it looks 

for pictures with a number of different file extensions.  If I click on that drop down, I’ll see what 

the range of available file extensions is and PowerPoint 2013 supports a lot of different file 

extensions. 

Now if you’re used to working with photographic images, you’ll be used to many of these file 

extensions and some of them are the ones that most people use most often.  For example, one of 

the file extensions is JPEG in fact in its various forms J-P-G or J-P-E-G or even J-P-E and this is 

typically the file format that’s used by digital cameras and so on.  And very often when you’re 

putting together a PowerPoint presentation and you’re using photographic images, you’ll be 

using JPEG files.  Many of the images that you get from the web will be in Portable Network 

Graphics format, PNG format, and some of the simpler ones, the ones that are small graphics 

with a limited number of colors but which therefore occupy very small amounts of space will be 

in Graphics Interchange format, GIF format.  For the maximum, in terms of definition, you’ll 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

very often get files in Bitmap format, BMP format or sometimes DIB format, Device 

Independent Bitmap format.  You’ll also often see WMF format, Windows Metafile format.  

And as you can see there are many others as well.  Some of them like Word Perfect Graphics, 

WPG, are not used so often nowadays.  Others such as TIF format are quite often associated with 

scanned images.  PowerPoint 2013 supports all of these formats.  You can actually also get 

converters to support other formats.  But I’ll assume, for the purposes of this section, that all of 

our images are in one of these formats and in fact virtually all of the images we’re going to use in 

this section are in JPEG format, J-P-G format; although you will see that there are a couple of 

images there such as the butterfly picture which is in GIF format and a couple of diagrams, one 

of them is in TIF format.  All I need to do to insert one of these photos is to choose the photo and 

let’s suppose I want to include that picture of some kangaroos and click on Insert and the 

photograph is inserted into my presentation. 

Now once I’ve inserted an image into a PowerPoint 2013 presentation, if I select that image, then 

I have all of the same picture tools available to me on the Format tab that you saw me use in the 

previous section where we were working on one of the images we got from Office.com as 

ClipArt, photographic ClipArt.  So we can go in, we can carry out corrections, color, artistic 

effects, pictures styles, we can put a frame on it, background to it, shadow.  Everything we can 

do we can do exactly the same as we did in the previous section to improve that photo.  And so if 

for example I wanted to put together a presentation of photographs, I could create a number of 

slides in a presentation, put a photo in each one or maybe a couple of photos on some of the 

slides and put my presentation together.  But within PowerPoint 2013, there is a particular 

function that you can use for putting together a photo album and I’d like to quickly show you 

that function now. 

Now if I click on the Insert tab, one of the options in the Images Group is Photo Album, and I 

can select New Photo Album and that brings up a Photo Album dialog.  Now within that dialog, 

there are a number of options which I’m going to come to in just a moment.  But I generally find 

the best to start this is to choose the photos first, if possible.  You can actually add or remove 

photos later on, but let’s start by choosing four or five pictures.  So click on File Disk first, the 

first button on the left there.  That takes us into this Insert New Pictures dialog.  I’m going to go 

into a folder Pacific Night there.  I preview a number of JPEGs and let me choose some of those 
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pictures, just say four or five of those pictures.  So choose the first one, hold the Control key 

down and then choose; that’s five in total.  They’re all in JPEG format, click on Insert, and my 

pictures are listed here in this control which contains the pictures in the album.  So having 

selected my pictures, I can put in optionally between two or three of the pictures; I could, for 

instance, put in a textbox.  So if I say click on that one, click on new textbox, I’ll get a textbox 

between three and five.  I’ll show you what that looks like in just a moment.  If I select a 

particular picture like that, I have the option to move it backwards or forwards in the playing 

order.  And I also have the controls over here for doing things like increasing or decreasing the 

brightness with the controls on the right or rotating the picture in either direction.  So when I’ve 

made those selections in terms of the pictures to include, I can also select options for the album 

layout.  So, for instance, do I want to generally fit each picture to the slide?  Yes.  Alternatively, 

I can say do I want one picture on a slide or two pictures or four pictures on a slide?  Let’s go 

with fit to slide.  Frame shape where it can be changed.  I can choose a different frame to 

rectangle, and then I can also choose a theme for the presentation.  Now this browse uses themes 

as THMX files which we haven’t looked at, but basically if you know the names of the themes 

by now, you can choose one.  Let’s go with say the Slice theme.  We’ve used Slice theme so 

select that.  So we’ve made all of our selections, click on Create, and our photo album is built. 

Now if you look at the thumbnails on the left, you will notice that five seems not to have a 

picture on it.  That’s the textbox I inserted.  So I could click in there, perhaps put some 

appropriate text in there.  And then if I go into say Reading View, I can do a little preview of the 

presentation; so Photo Album by Toby Arnott.  I could, of course, give it a more informative 

name if I wanted to.  When it finishes click on another key and that is my photo album. 

So after that quick look at photos and photo albums in PowerPoint 2013, in the next section I’d 

like to take an even quicker look at ClipArt.  So please join me for that. 
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Video:  ClipArt 

 
Toby:  Hello again and welcome to the fourth section on pictures in our course on PowerPoint 

2013.  Earlier on, we inserted a couple of photos into this presentation about the UK Parliament 

and on the fourth slide, I’d like to insert a different type of picture all together.  This is still going 

to be inserted as an online picture but this is ClipArt.  So if I hover over the options in the middle 

of the placeholder there, Online Pictures is one of them.  So I’m going to click on Online 

Pictures.  As before I’m going to search on Parliament in Office.com and one of the images there 

is that photographic image that we’ve already inserted.  But this time I’m going to go down to a 

different type of image all together.  And the one I’m going to use is this one, so click on Insert, 

and I’m going to make that image a little bit bigger and a little bit bigger still, and I’m going to 

look at what I can do to format that image. 

Now this image is not a photographic image; it’s a drawn image.  And because it has a different 

format, some of the things we can do with a photographic image we cannot do to this type of 

ClipArt.  So for instance with the picture selected, if we look at the Adjust Group, if you look at 

Corrections, you can adjust brightness and contrast but there isn’t anything to soften and sharpen.  

Also although we can go into color and we can recolor the picture, I cannot apply artistic effects.  

And you can see all of this more clearly if you click on say the Color drop down and go to 

Picture Color options which opens up the Format Picture Pane.  You notice that with sharpen and 

soften, there’s no controls available whereas with brightness and contrast, you’ve got the 

standard controls available. 

So when you’re working with a drawn image, what is effectively the traditional type of ClipArt 

there are some things that you can do and some things that you can’t.  You can still have picture 

styles for example.  So in fact, I could present the picture like that, but I can’t go in having 

selected that and apply artistic effects. 

So as you can see, inserting ClipArt into your presentations in PowerPoint 2013 is very 

straightforward.  Because of the way that the picture information is stored in this drawn type of 

ClipArt, there are restrictions as you can see on what you can do to format the ClipArt within 

your presentations, but there’s still a lot you can do.  And the other thing to point out for 

particularly for those of you who you have PowerPoint 2010 or another earlier version of 
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PowerPoint is that the ClipArt Organizer is no longer supplied in PowerPoint 2013.  Microsoft 

has discontinued it.  There is an explanation for the reasoning behind that on Microsoft.com, but 

there’s no ClipArt Organizer in PowerPoint 2013. 

So that’s it on ClipArt.  In the next section, we’re going to have a very quick look at screenshots.  

So please join me for that. 
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Video:  Screenshots 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the last few 

sections we’ve been looking at ways of inserting and formatting pictures in PowerPoint 2013, 

and in this final section in this sequence we’re going to take a quick look at inserting screenshots. 

Now it can happen that you’re running a particular application on your computer and there’s 

something on the screen and you’d like to include that in a presentation.  It may be a single 

image; it may be some text; it may be a whole page.  This may also be the case where you’ve 

seen something on the internet and rather than just having one image, you may have a whole 

page that you’d like to include in a presentation.  Now, first of all, you do need to be aware of the 

copyright issues that I mentioned earlier on. But assuming that those are dealt with, there is a 

pretty straightforward way of including a screenshot into a PowerPoint 2013 presentation. 

Now in order to demonstrate this I’m going to use this page which is the result of a Google 

search on the House of Lords.  So I’ve got this page open on my PC and I’m going to include all 

or part of this page into a presentation.  So I go to the Insert tab and on the Insert tab in the 

Images Group one of the options is Screenshot.  Now if I click on Screenshot, I can see a picture 

of the page that I’m thinking of including in here and if I click on Screen Clipping, it shows me 

that page sort of ghosted over.  And what I can do is to cut out the part that I want to include in 

my presentation.  Now I’m not going to worry too much about doing that very accurately; I just 

want to show you the principle of this at the moment.  So let’s suppose that I take this part which 

has a small picture of part of the House of Lords together with a map and the postal address, cut 

that, and that part is included into my presentation.  And, of course, once that screenshot is there, 

or rather that cutting of the screenshot is there, it’s just another graphic within my presentation.  

It can be moved around in the same way as any of the others.  So that’s how you take a 

screenshot from one of the other applications that’s running on your machine.  

And that brings us to the next exercise for you to do and this is to produce a PowerPoint 

presentation of just four slides.  I don’t need a fifth slide like the one I’ve got here with a 

screenshot on it.  But I’d like your four slides, let me just go back into this presentation into 

Reading Mode, to have a title slide with a background graphic set fairly transparently like that 

one.  The theme can be your choice.  The variant can be your choice.  I then like a second slide 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

with the name of the organization or team or government structure or government department 

that’s the subject of the presentation together with a nicely presented photographic image.  And 

then I’d like two pages like these two.  So these are slides with some bullet point text in one part 

and some ClipArt or photographic images in the other part.  Now the subject of that is entirely up 

to you, but I’d like you to incorporate all of those features.  If you’d like that background graphic 

for example, the one that I’ve got on the title slide on all of the slides, that’s fine.  But don’t do it 

on individual slides.  Make sure you apply it to the Master or to Layout Masters.  And my 

answer to that question is example-07.  I’ll see you in the next section. 
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Chapter 18 – Working with Shapes and Drawings 

Video:  Drawing and Formatting Shapes 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to start looking at drawings.  We’ve already looked at images including photographic 

images, but with PowerPoint 2013 you also get a good set of drawing tools. 

Now the first thing I’d like to show you is basically how to add a shape to a presentation.  So I’m 

going to use Control-N to start a new presentation, and then I’m going to insert a blank slide and 

on that blank slide, I’m going to insert some shapes.  Now if we go to the Insert tab within the 

Illustrations Group, there is a command Shapes with a drop down and from that drop down we 

have a whole gallery of shapes that we can include into a presentation.  Now the shapes are 

divided into categories.  So we have lines, rectangles, basic shapes, block arrows, and so on.  

And right at the top we have recently used shapes and although you get a default set of content 

for this category when you first install PowerPoint 2013, you’re list of recently used shapes will 

obviously vary as you use PowerPoint.  This is a very convenient way of getting at the shapes 

you’ve most recently used in your presentations. 

Now in order to get us started, let’s try this particular shape here.  It’s called a pie.  Click on pie.  

What you get is a cursor, a cross hair cursor, no apparent pie.  But the reason you can’t see one is 

you have to draw it.  So if you’re using keyboard and mouse, you click with the mouse and you 

draw your pie.  And there we have a shape drawn on a slide and as you can see when you first 

draw it, it is selected.  Once you have a shape selected, then you will see a Format tab appear on 

the Ribbon.  This is under the heading Drawing tools.  It’s similar in function to the Picture 

Tools Format tab.  There are some commands and groups that are similar and some that are 

different.  On the right there is a Size Group that we can use to resize the selected object.  We 

can also resize the selected object using the handles. Now as with pictures the handles in the 

corner, resize without changing the aspect ratio.  The handles in the middles of the size, top and 

bottom, can be used to resize the object and upset the aspect ratio at the same time.  In addition, 

we have a rotation handle here.  Hover over that so that it becomes a sort of round arrow, and 

then by twisting round with that you can achieve various rotations of that object. 
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Now something you also get with a drawn object like this or with most drawn objects anyway 

are these types of adjustment handles, yellow ones like this.  Now what an adjustment handle 

does depends on the particular shape.  But if you take this pie, watch what happens if I click on 

that adjustment handle and turn it round; you see how the slice of the pie varies.  Now exactly 

what the adjustment handles do, of course, will depend on the individual shape. 

To delete a shape is very straightforward.  Select it or just make sure it’s selected, press the 

Delete key. 

Now I’m going to insert another shape.  This time, I’m going to insert a circle or I should say an 

ellipse really.  Again, I’m going to do it the same way I did it before.  I’m just going to click and 

drag out to the elliptical shape that I want.  That’s absolutely fine.  Now let me undo that again 

and repeat that exercise.  So, again, I’m going to do Insert Shapes, choose the same one, the 

elliptical shape, but this time I’m going to hold down the Shift key.  If I hold down the Shift key 

when I’m drawing a circle or in fact a square for that matter, then I will always get a regular 

circle or square.  I can’t get an irregular one, an ellipse or a non-square rectangle.  It will keep it 

circular in the case of circles, square in the case of rectangles.  So that’s a way of making sure 

that you get exactly the same height and width when you’re drawing circles or squares. 

And one last aspect in terms of drawing these kind of shape, let me move that one over to the 

side rather than delete it.  If I click on Insert again, Shapes again, and this time I’m going to 

choose the elliptical shape again.  Instead of dragging, if I just click on the drawing surface 

somewhere, so a single click, I would get in this case a circle at a default size which happens to 

be one inch by one inch.  And having drawn it at a default size, I can either use the controls in 

the size box at the right hand end of the Format tab on the Ribbon or, of course, I can resize it 

using the sizing handles as normal.  And if I want to keep it a circular circle rather than an 

elliptical one, I can hold the Shift key down while I resize it. 

Now one thing to be aware of when you’re working with shapes is that these shapes can also 

hold text.  If you take the circle on the right here, the one that’s selected, all I need to do is make 

sure it’s selected and if I start typing text, it will appear in that shape.  So if I want to call it Big 

blue circle, I can just type in there and it is Big blue circle.  I could’ve adjusted the choice of font 

and the font size before I started typing. But if not, if I just swipe over with the mouse, go to the 
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Home tab, I can choose a different font.  I could, for instance, go for Algerian font, different font 

size, say, 36 point, and if I click away, I can see that I’ve got the text inside that shape.  The 

shapes have a textbox effectively built into them. 

Now with that circle selected and with the Format tab selected, there’s a group there Shape 

Styles and in shape styles, there is a More button which opens up a gallery of shape styles.  This 

has live preview.  So watch what happens as I do live preview now and just look at Big blue 

circle.  It adjusts the fill color in the shape and the color of the text.  So I’m on white text there 

but down here, I’d be on black text and I have a number of options there for the style for that 

shape.  Now the colors that are in use there are basically the theme colors.  The bottom there’s a 

selection there, Other theme fills, and I could go in there and try those other theme fills 

corresponding to variants on the theme.  And using that approach, I can get whatever effect, 

whatever color scheme, and so on I want.  I’m going to go for this one I think. 

Now in terms of the shape styles, we can also break this down into the individual components of 

the style.  So, again, within the Shape Styles Group here, we have a button up there Shape Fill 

that lets us choose a color we can use to fill that circle.  Now there are many possibilities here.  

We have the theme colors at the top, choose from one of those.  We can go for standard colors.  

But down here we also have options such as texture where you could fill that with a texture like 

that.  We have options to fill it with a gradient.  So we could go for that sort of gradient where 

we have darker blue in the middle.  We can even fill it with a picture.  So you can select a picture 

and fill the circle with that. 

There is a new feature also in PowerPoint 2013 which is Eyedropper, and with eyedropper what 

you can do is to pick a fill color by clicking within the window and just you click on the color 

you want, come back here, and you can basically fill the circle with a color that you picked up 

with the eyedropper. 

Now the number of options you’ve got there for fill are extensive, a great area for you to 

experiment with.  We don’t have time to go into all of them here, but as you can see when it 

comes to filling a shape, you can pretty much achieve whatever effect you want in PowerPoint 

2013. 
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Now to demonstrate one or two of the other aspects of shapes, I’m going to turn my attention 

now to Small red circle which is the one here.  We can work on shape outline.  There are many 

options for shape outline.  We can decide what sort of outline we want around the shape both in 

terms of the weight, how thick an outline would you like.  Let’s suppose you want a really thick 

six point outline.  Also with the outline, let’s suppose that we want to instead of having a 

continuous line, we’d like a dashed line around the outside.  And apart from working on the 

outline and applying any shape effects, which I’ll come to in a moment, don’t forget that down 

here we’ve got the Dialog Box Launcher which would bring up the Format Shape Pane. And 

with the Format Shape Pane on the right, we can look at fill.  We can look at line.  We can look 

at shadow, reflection, glow.  So, for instance, these are the shape effects.  Why don’t we try a 

reflection?  Look at the presets.  Let’s try that preset reflection there and you can see now a 

reflection of that shape.  The reflection actually goes off the bottom of the slide.  So we’d 

probably have to do a little bit of work on that one.  But with a combination of all of these, 

possibly using the Format Shape Pane as well, you can achieve a wide variety of effects on any 

shape that you draw in PowerPoint 2013. 

So there we have the basics if you like of shapes.  In the next section, I want to cover one or two 

particular things.  I’m going to leave these two circles in place because they’re the two that we’re 

going to use to demonstrate these other points.  So I’ll see you in the next section. 
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Video:  Creating Complex Shapes 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the previous 

section, we looked at how to add shapes to slides in a presentation and in this section we’re 

going to look at ways of combining shapes together to make more complex shapes. 

Now generally speaking, I can tell that a shape is selected by the selection rectangle around it.  In 

this particular case, I’ve got two circles selected on a slide.  To cancel the selection of those two, 

I can press the Escape key, neither is now selected.  If I click on the blue one, I can drag it 

around independently of the red one.  Note that it goes in front of the red one.  Now let me select 

the red one instead, move that around, note that it goes behind the blue one.  I could do exactly 

the same thing using my fingers and touch.  So there I’m moving the red one round, tap on the 

blue to select it, now I’m moving the blue one round. 

Now let me leave the blue one overlapping the red one.  The blue is still selected but it’s 

overlapping the red.  On the Format tab under Drawing Tools, there is an Arrange Group, and in 

the Arrange Group, we can arrange the order in which the objects are visible on the slide.  Now 

the blue is currently selected.  If I were to click Send backwards watch what happens.  The blue 

is now behind the red, click on Bring forward, the blue is now back in front of the red again.  

Now I can do this with any number of shapes and I can arrange the sequence in which they 

appear on the slide using Bring forward which has got a drop down of bring forward and bring to 

front.  So if I’ve got more than two shapes and I want to bring a particular one to the front, I 

select it and just click on Bring to front.  And then similarly, with Send backwards there is send 

to back.  So that’s the way in which I can make basic arrangements of separate shapes on a slide. 

Now sometimes I may want to be able to take two or more shapes and combine them from the 

point of view that I want to be able to move them around together.  I may want to keep them 

looking as separate shapes, but I want to be able to move them on the slide as though they were 

sort of glued together.  Think of it if you like as gluing a couple of paper shapes together and 

being able to put them somewhere on a picture, on a collage or something but treating them as a 

combined object where I can still see the individual ones but they move together.  Now in order 

to do that, I select them both; at the moment, the blue one is selected so let me hold the Control 

key down and select the red one as well.  Then in the Arrange Group on the right, the middle 
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button there is a Group Objects button.  If I click on that with more than one object selected, 

click on Group, those two objects are now a group.  Note the difference in the selection 

rectangle.  Instead of two separate selection rectangles, I have a single selection rectangle which 

has got both shapes inside it.  Now watch what happens if I click on the big blue circle and move 

it around.  The two move as one.  They move as a single object.  I can even resize them as a 

single object.  So the blue and the red are grouped.  If I use the bottom right sizing handle watch 

what happens.  I can make them smaller together.  They still maintain their separate identities.  

So they have different fonts in their text, different borders, different fill colors, but they move 

around and can be resized and have various other things done to them as one. 

Now let’s look at some of the other things we can do with this group.  First of all, let me just 

make the group a little smaller again and pull it back into the middle of the slide.  In the Arrange 

Group, the bottom right button there gives us some options for rotating and flipping.  So rotate 

right does that; rotate left does that; flip vertical, flip horizontal.  These are very useful if you’ve 

got almost the shape that you want but you just need a flip or a rotate.  If I click on More rotation 

options, it brings up a Format Shape Pane again, and within the Format Shape Pane, you have a 

number of options you can use that you can apply to the grouped object.  Most of the things that 

you can do to a single shape you can apply to a group as well. 

And another very useful facility is the Selection Pane.  Now if I click on the Selection Pane, note 

you can get two panes at the same time.  On the Selection Pane, this shows me a group and the 

constituent shapes within the group. When you add a shape to a slide in PowerPoint 2013, the 

shapes given a name; so with these are Oval 6 and Oval 7.  And when you look at the group, you 

can see what shapes make up that group, Oval 6 and Oval 7. 

So let me just close those panes and just one other thing to make a note of here.  When you’ve 

got objects grouped together like this back to the Arrange Group, back to the second button, the 

middle button there, Group Objects, there is an ungroup option.  Now once you’ve got a group 

selected, you can click on Ungroup and we once again have two separate objects; so I can select 

one and I can move them around independently again. 

Now just one other thing to show you specifically about these two separate objects, something I 

said I’d come back to.  If I select the big blue circle, one of the options on the Home tab which I 
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mentioned very early on in the course, in the Clipboard Group, bottom right hand button there, 

Format Painter.  Let me just click on that.  That basically copies the format on the selected 

object.  Let me now click in the small red circle, watch what happens, and there I now have the 

small red circle has now got the same format as the big blue circle.  So that’s how the Format 

Painter works. 

Now the small red circle is back to being a small red circle again.  What I’d like to do now is to 

show you what is effectively a new feature of PowerPoint 2013 and that is what’s called Merge.  

Now we’ve seen how to group two shapes together and treat them as one from the point of view 

of moving them around, rotating them, and so on.  What merge does is really quite different.  

Now, first of all, let me select that shape, go to the Format tab, the button I want is in the bottom 

right hand corner of the Insert Shapes Group.  In order to merge shapes, I need to select it.  So 

what I’m going to do is to take the blue shape here, drag it over the red one.  So that’s the first 

one selected.  Hold Control key down to select the second one and then I’m going to click on 

Merge.  Now there are five options, and what each of these options does is quite different.  Let’s 

start with Union.  You need to watch carefully what happens if I preview union.  What happens 

with union is that the first selected shapes format is used to combine the two shapes and also the 

text that’s in the first shape is used as well.  Let me go back to the start again, let’s select small 

red circle first, then let’s select blue, back there again, try the union.  Now we get small red 

circle’s text and small red circle’s format.  Now that shows what happens in the case of union.  

Each of these other options produces a different effect.  So for instance, if I look at Subtract, the 

last one, what that does is to take the first selected shape and subtract from it the other selected 

shape or shapes.  You can do this with more than two shapes, if you want to at the same time.  So 

let’s go down to subtract and now you can see small red circle has had a bite taken out of it 

which corresponds to the part of blue that was overlapping.  Just above subtract is Intersect 

which will just select the intersection between the two shapes.  So intersect is just that bit in the 

middle.  Now when I’ve decided which of those I want, if any, I can click to select that particular 

option.  Now if I don’t want to I can just click away. 

Now watch what happens if the shapes are not actually overlapping.  So let me put blue over 

there, select the second shape, click on the Format tab, go back here, and do union and, of 

course, with union the shapes are still combined but I lose a chunk of text in the middle because 
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the text in the middle is over the white background and it’s white text.  The intersect, of course, 

is completely empty because they don’t overlap, and the subtract means that I can only see the 

blue because the red doesn’t subtract anything from it.  Now clearly when it comes to combining 

shapes, merging shapes in that way, you can build up some pretty sophisticated shapes and 

effects using that merge feature in PowerPoint 2013. 

So we’ve covered now pretty much all the basics you need to know on shapes in PowerPoint.  

The next thing we need to look at is a very sophisticated aspect of dealing with shapes and that’s 

the use of SmartArt, which we’re going to cover in the next section.  So please join me for that. 
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Video:  SmartArt 

 
Toby:  Welcome back to our course on PowerPoint 2013.  In this section, we’re going to look at 

SmartArt.  It’s a relatively new feature.  It was actually introduced in PowerPoint 2007 and it is a 

good way of showing information where you need a fairly complex diagram in order to represent 

the information fully.  Now to some extent, you can draw complex diagrams using the shape 

drawing procedures we’ve looked at already together with merging and grouping of shapes.  But 

with SmartArt, a lot of the hard work is done for you and in addition to that hard work being 

done for you, it’s done in a way that makes SmartArt a very flexible facility.  So let’s take a look 

at a straightforward example. 

First of all, to insert SmartArt, go to the Insert tab on the Ribbon and in the Illustrations Group 

one of the options is SmartArt.  Now when you click on Insert SmartArt, you get a dialog, 

Choose a SmartArt graphic.  The graphics you can use are categorized and the categories are on 

the left.  So you have list, process, cycle, hierarchy, etc. and selected at the top is All.  So we 

have all of the types of SmartArt graphic in the gallery in the center. 

Now let’s suppose on this occasion that I’m going to enter a hierarchy SmartArt graphic.  So 

click on hierarchy and one of the most common types of hierarchy, it’s the sort of hierarchy you 

get in a business organization.  So I’m going to choose the first option there, an organization 

chart.  Now when you choose one of these options on the right, you get a representation of what 

you will get to begin with.  So the initial graphic will look like that, and then below that there is a 

description of what that particular SmartArt graphic does.  Now one of the key points about 

SmartArt graphics is that you’re going to start from that initial one there with somebody at the 

top of a hierarchy, and then something sort of sticking out the side here, and then three at the 

bottom.  But the smart part of SmartArt is that to change that to your exact requirements should 

be a very straightforward job, as we will see.  So I’m going to choose this one.  Let’s click on 

OK and customize it to our specific requirements. 

Now the first thing to note here is that we have two additional tabs on the Ribbon.  We have 

under SmartArt Tools, we have a Design tab and a Format tab. Now very roughly speaking the 

Design tab lets us change the shape, the layout, the overall style of the SmartArt graphic we’re 
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creating.  The Format tab lets us go in and change some aspects of the format both of the overall 

graphic and of the individual elements that make up the graphic. 

First of all, I’ve inserted this SmartArt graphic on to a blank slide and one of the objects in the 

graphic is selected.  It’s the individual box at the very top of the hierarchy.  But also you can see 

selection handles for the whole graphic.  The group of objects that are actually sort of glued 

together in this SmartArt graphic have a selection box around them and sizing handles. Watch 

what happens if I pull on one of those corner sizing handles.  I’m going to pull on the top left 

one.  Look not only at the size of the overall graphic but at the individual boxes within it.  Let me 

pull up to the top left, release.  Now you should have noticed that not only the whole graphic got 

bigger but the individual elements within it grew as well.  Let me do that again at the bottom 

right and again you can see the individual boxes getting bigger.  One aspect of SmartArt is that it 

automatically resizes the elements within a piece of SmartArt to fill the space available. 

Now let me click back on the top item in that hierarchy again and I can treat that item as an 

individual graphic as well.  So if I wanted to make that individual graphic larger or smaller, let’s 

pull it by one of its corners.  I can make the individual graphic bigger as well.  And the others 

will make themselves smaller if they need to in order to keep the overall shape, legibility, and 

usability of the SmartArt graphic. 

Now let’s turn our attention to that Design tab.  One of the groups on the Design tab is the 

Layouts Group, and within that there is a gallery of layouts that are relevant to the type of 

graphic we’ve got.  In fact, you get the same gallery for the hierarchies that we saw right at the 

beginning, and you can basically change the current chart to one of these other options just by 

selecting it from that gallery.  And of course, as you can see, you get live preview.  So if you’d 

prefer things to be like that or like that or like that, it’s straightforward enough to do.  Some of 

these are more complex than others.  So for instance, the second option there includes not only 

the hierarchy of the organization but there’s a space in each of the smaller boxes there to put a 

photo.  So if you wanted to put together an organizational chart for your company or your 

department or even for your family if you like, you can put the individual photos in there as well. 

So for the moment, for this example I’m going to stick with the layout that we started with.  Now 

let’s look at SmartArt Styles which is the next group on the Design tab.  With this given the 
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current selection of layout, we get different styles.  So for instance, if I wanted to go a little bit 3-

D, I could go like that; Brick Scene that is or like that or I can add a little bit of depth by going 

into cartoon style or, of course, I can stick with one of the 2-D styles as well.  So you can choose 

the one that suits the particular style that you want to achieve. 

Now one of the options over on the right here in the Reset Group is Reset Graphic.  Discard all 

of the formatting changes made to the SmartArt graphic.  If you get partway through changing 

the layout and style and other formatting changes, you can always reset it to the original format 

by using that button. 

So now let’s suppose that I want to actually make this SmartArt graphic show the organizational 

structure in a department.  To put the text in the boxes, they really are just placeholders so you 

can click within there.  Let’s say that at the top of the hierarchy we have, note that as I type this 

person’s name, SmartArt will resize the font to fit the name in.  So that’s the person at the top of 

the hierarchy.  Let’s now go down to the person who is the PA for the boss, and then we can start 

working on the people in the department.  Now I’ll put those three names in and then we’ll make 

a couple of changes. 

Now there is my initial departmental structure.  Note that Li Nang, the box for Li Nang is the 

selected individual box at the moment.  Let’s now suppose that a new person is joining the 

department.  So this will be a person that operates at the same level as Li and Victor and Sue.  I 

go to the Create Graphic Group on the Design tab.  Top left hand corner there’s an Add Shape 

command, click on the drop down, and I get a number of options for where to add a shape.  Now 

add shape after will add somebody effectively to the right of Li Nang.  So it’s a person at the 

same hierarchical level, but to the right of Li.  Add shape before, it will be somebody at the same 

level before Li on the left.  Add shape above will mean somebody else that Li Nang is going to 

report to.  Add shape below will be somebody reporting to Li.  Add an assistant will give Li an 

assistant.  Let’s go for add shape after and watch what happens when I click that to the overall 

departmental structure.  I get a fourth person at that sort of bottom tier in the departmental 

hierarchy, but everything resizes to accommodate that. 

So I’ve added the name for that new person and you can begin to see here really what we mean 

by SmartArt because as I add to this structure, the overall structure adjusts itself and the 
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individual elements within it to accommodate the changes I’m making, in this case to a 

hierarchy.  So again, if I and now have Joe selected, Joe is going to have a person reporting to 

them, not an assistant but somebody that works for Joe.  Again, make sure Joe’s selected, click 

on the drop down next to Add Shape, do add shape below, and I’ll get somebody who’s going to 

report to Joe. 

And just one other thing here, let’s suppose that somebody leaves the organization.  So let’s 

suppose that Victor leaves.  If I click Victor’s shape within the departmental structure diagram, 

all I need to do is to press the Delete key.  Victor’s taken out of the departmental structure and 

everything else adjusts itself accordingly. 

Now exactly what you can do in a SmartArt graphic depends on the graphic itself.  So some 

graphics, processes, cycles, and so on although they’ll have some of the same functions, 

particularly in relation to this Create Graphic Group, some will allow some things, some others 

depending on exactly what the graphic is.  The organization chart like this is one of the most 

common and popular ones that people use in PowerPoint presentations.  But some of the others 

that you don’t see so often can have different kinds of operation that you can perform on them. 

Let’s now take a look at a couple of things on the Format tab.  If I click on Format, you notice 

we have a Shape Styles Group here, similar to the equivalent group that we’ve seen before when 

we were looking at shapes in general.  One of the things to be a little bit careful of here is when 

you’re looking at a SmartArt graphic be aware of whether you’ve got the whole graphic selected 

or an individual component in it.  At the moment, I’ve got a whole graphic selected and with a 

whole graphic selected if I say went to shape fill, I wouldn’t be filling the shape of one of those 

boxes; I’d be filling the shape of the whole thing.  So for instance, if I go down to gradient and 

maybe choose one of those light blue types of gradient, what I’ve done there is to fill the 

background if you like of the graphic, the overall graphic.  Whereas if I chose an individual 

shape like Emelia Sanchez and went into shape fill for Emelia, maybe again went to gradient, 

one of the darker gradients, clicked on OK.  I would be filling one of the individual graphics 

within the overall SmartArt graphic. 

And so again at the moment, I’ve got Emelia Sanchez’s box selected.  If I click somewhere in the 

graphic, not in that specific box but in the overall graphic, then I have the whole graphic selected 
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and if I say went to shape outline and chose an outline for the overall shape, maybe a nice thick 

black line and then again for the outline, I chose a color of that sort of dark color.  Click outside.  

You can see how I’ve put a border around the overall graphic. 

So finally I have an exercise now for you to do.  I’ve gone back to my presentation on the UK 

Parliament.  I’d like you to go back to your presentation of your government or your club, 

society, company, department, whatever one you’ve been working on so far and I’m going to 

insert a slide explaining graphically some of the functions of the House of Commons in this case.  

Now what I’m going to do is to put in a kind of hierarchy chart.  I’ve really divided the functions 

up into five groups.  So what I’m going to do here is click inside the box where the charts going, 

click on Insert, then I’m going into SmartArt, and I’m going to choose a hierarchy.  I’m going to 

choose a very straightforward hierarchy.  I’m just going to use that one, the organization chart 

again.  Now in this case, I don’t need an assistant.  So select that and delete it.  And I do need 

five boxes at the lower level to accommodate the five main functions.  So at the top I’m going to 

put House of Commons.  The first of these is going to be Legislation.  The next one of them will 

be Executive Scrutiny, there are five of those.  So I’m going to do that.  I’m going to do a little 

bit of work on the style, the presentation of that, and that’s going to produce example-08 from 

the supplied files that come with the course.  What I’d like you to do is to add a similar slide to 

your presentation.  So it can be any kind of SmartArt graphic.  It can illustrate somebody’s 

responsibilities.  It could even illustrate the reporting lines, the executive structure, boss at the 

top, vice presidents in the middle level, employees below, whatever you like, but at least one 

SmartArt graphic.  As I say, my answer to that is example-08 and I’ll see you in the next section. 
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Chapter 19 – Saving a Presentation 

Video:  Save Options, Create PDF/XPS Document, Change File Type 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at alternative ways of saving a presentation.  Now, so far, whenever we’ve saved a 

presentation, we’ve saved it in the current .pptx format, but there may be situations in which you 

want to save your presentation in other formats to satisfy particular requirements. 

So, first all, if I go into Backstage View by clicking on File and then clicking on Save As and 

choose, say, the exercise files folder that I’ve been using.  I am presented with a file name box 

that defaults to the current file name and then below that there is a Save As Type which I’ve got 

setup as defaulting to PowerPoint presentation .pptx.  Now if I click on the drop down at the 

right hand end of that Save As Type control, I’m given a very long list of options.  Now you 

probably can’t even see the end of this list of options, but you only really need to look at the first 

few.  We did briefly look at this list very much earlier on in the course. 

Now amongst the options that you’ve got available here, if you look at the third one, we have 

PowerPoint 97 to 2003 presentation and let’s suppose that you have a colleague to whom you 

want to give a copy of a presentation but they only have an older version of PowerPoint; so that’s 

97, 2000, 2003, then by saving your presentation in that format, the person will be able to open 

your presentation.  Now there is a piece of free software available from Microsoft whereby 

somebody who only has an old version of a presentation can open the newer format in an older 

copy of PowerPoint.  I’m not going to cover that here, but that’s an alternative way of enabling 

people with older copies of PowerPoint to open presentations in the new format.  The problem 

whichever of these two approaches you choose is that if you’ve put any new features of 

PowerPoint into your presentation then those features won’t show up in the old version of 

PowerPoint anyway. 

So that’s an example of one of the other formats that you may want to use.  There are many 

others here so what I’m going to do is to just talk about the main two or three that might be of 

use to you.  And to help me to do that, I’m going to cancel this Save As and instead I’m going to 

go to the Export option in Backstage View, and one of the options in Export is Create PDF or 
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XPS document.  Now this is one of the most likely things you’ll want to be able to do and it has 

a couple of really good advantages.  One of them is that if you save a PowerPoint presentation in 

PDF format, that’s Adobe Portable Document Format, then the layout, the formatting, etc are all 

preserved, but somebody can open that PDF document who doesn’t have PowerPoint.  All they 

need is a piece of software that’s available to open PDF documents.  Now the vast majority of 

PC users handle PDF documents because they come in all sorts of situations.  So if you just want 

people to be able to see your presentation but perhaps there’s nothing particularly interactive in it 

or you’re not worried about people being able to change it or step through it in any particular 

way, you just want people to be able to see the content of your presentation, then saving it in 

PDF format is a good option.  In fact one of the great advantages of PDF format is that generally 

speaking unless somebody has a sophisticated piece of software, they can’t actually change the 

content anyway because most people will have reader software whereby they can’t make 

changes to a PDF document.  And if somebody doesn’t have a viewer or a reader for a PDF 

document, then there are several free viewers readily available on the web. 

Now note that this option also includes the option of generating an XPS document which is the 

Microsoft equivalent of the PDF format.  So that’s another option you may find useful as well. 

But let’s suppose I’m going to save the current presentation in PDF format.  I click on that 

button, Create PDF/XPS, and it takes me into that Save As dialog.  It gives me the same file 

name but this time with an extension of PDF and I can save it somewhere on my device.  There 

are some options.  Let’s just click on this Options button here and we’ll see that the options we 

have for saving as PDF include saving all slides or just the current slide or a selection of slides.  

And then we can publish the slides, this is in a drop down or handouts or notes pages or Outline 

View.  Remember, we looked at Outline View earlier on.  And then we have various options for 

deciding what we want to include in the PDF document; things like whether we want the 

document properties included.  So I’ve checked a couple of options there.  I’m going to click on 

OK.  Having done that, I’m happy with the file name so I’m going to click on Publish and that 

will now save that document as a PDF and I can open the PDF and take a look at it.  And what 

you can see now is my presentation in Adobe Reader.  So there’s Page 1.  I can step through the 

pages in the usual way, say, using the scroll bar on the right or by using the toolbar options here 

to step through the pages, arrows, Page 3, Page 4, so on; go backwards.  And really for many 
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people that make presentations and want to distribute them say via website or via their blog, this 

is very often how they do it.  They save the presentation in PDF format and then publish the 

presentation on the blog possibly as a download and this gives you the maximum safety in terms 

of people being able to change your presentation but gives a very good scope for people to be 

able to read it because the vast majority of people can open PDF documents, and most people 

understand how to read a document in Adobe Reader. 

Now let me go back into Backstage View again, and again I’m going to Export.  We’ve looked at 

Create PDF/XPS document.  Right down at the bottom we have another option, Change file type.  

And if I click on Change file type, most of this corresponds to a few of the particular file types; 

Save As file type options that we looked at towards the beginning of this section.  So we’ve got 

the PowerPoint presentation format, that’s the current one that’s been in force since PowerPoint 

2007, and then we’ve got the older one that I talked about earlier in the section and we’ve also 

got a couple of other formats.  Now a couple of these I’m not really going to talk about very 

much.  The open document presentation, if you’re familiar with or a user of Open Office, you’ll 

know that there is a presentation format, an ODP format, and you can save a PowerPoint 

presentation in ODP format.  You can also save a presentation as a template for other new 

presentations.  The next option, PowerPoint Show is another interesting one because it basically 

saves the PowerPoint presentation in the same format as the normal format for saving it. But if 

somebody opens it who has a full current version of PowerPoint, it opens in slide show format.  

So by default somebody will be running the slide show rather than going into what we’ll call edit 

mode, normal mode, or reader mode.  They’ll actually be running the slide show.  Now 

somebody who’s got a full copy of PowerPoint can switch to normal mode and could, in fact, 

make changes to the presentation. But by default when they open it, it goes into slide show 

mode.  So if you want to send this to somebody just so they can run through it and have a look at 

it but keep open the option of that person being able to edit it as well, then that’s a pretty good 

option to use as well. 

So in this section we’ve covered the main options for saving a PowerPoint presentation.  One 

other thing to point out here, in the PowerPoint Options on the Save Page right near the top, Save 

Presentation, you actually specify here what your default format for saving presentations is.  By 

default it’s set to PowerPoint presentation.  Mine is set to PowerPoint presentation.  You can 
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choose from these alternatives, such as PowerPoint Macro Enabled presentation if you start to do 

some programming or to default to saving in the old format.  And then other formats available 

include the open document format as well. 

So that leaves us with another exercise to do.  You should have your equivalent of my example-

08.  That’s the presentation with five slides in it, including the most recent slide which has the 

organization chart, the hierarchical chart in it.  In my case, showing the main functions of the 

House of Commons, but you may well have produced a PowerPoint presentation with your 

equivalent to that.  This exercise is very straightforward.  I’d really like you to save that as a PDF 

document.  Mine is saved as example-08.pdf in the files that you got as part of the course.  I’ll 

see you in the next section. 
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Chapter 20 – Tables 

Video:  Creating and Formatting Tables 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at adding tables to slides in PowerPoint 2013.  The facilities for handling tables of 

data are very good in PowerPoint nowadays. And what I’m going to use as an example in this 

section is I’m going to go back to my presentation about the UK Parliament and I’m going to put 

in a table about the breakdown of the members of Parliament by party in the House of Commons 

as it is today as I’m recording this section. 

So let me insert a new slide.  So I’m going to select Slide 3 and New Slide and I’m going to do 

title and content.  I’m going to say MPs by Party as the title on the slide.  I’m going to center that 

in its textbox so I’m going to click on the Center button in the Paragraph Group on the Home tab.  

And then here in the second content placeholder, if you hover over these, you’ll find the first 

entry is Insert Table.  Click on Insert Table. 

Now one of the options you have with Insert Table is this one.  You get a dialog saying how 

many columns would you like?  How many rows would you like?  It may initially be a little bit 

tricky for you to work that out.  You may not quite be certain.  Don’t worry about that because 

you can change the number of columns and the number of rows later on.  I’m pretty sure that I 

only need two columns on this on and I’m only going to need maybe half a dozen rows.  I’ll say 

six rows.  Click on OK and what I now get is a table inserted into the second content holder on 

the slide with a space for me to put my numbers in. 

Now, by now you may be seeing a bit of a pattern developing here in that we’ve inserted yet 

another different type of content, tables are a different type of content in PowerPoint.  And when 

you’ve done that and you’ve got a table selected as we have here, you can see the selection 

handles on the corners, then we have table tools on the Ribbon, two more tabs.  We have a 

Design tab and a Layout tab.  They are specifically the table tools and we’re going to take a look 

at those now and we’re going to start with the Design tab. 

Now, first of all, when I inserted this table, I said two columns and six rows.  If you’re not 

familiar with tables, then the vertical lines there that the numbers are going to go into are the 
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columns.  So I’ve got two columns.  That’s column one.  Let me just select column one with the 

mouse and that’s column two.  Each of the rows is one of these horizontal lines within the table 

and there are six of them.  Now one of the simplest controls that we have on the Design tab is the 

one in the top left corner of the Table Style options because it’s checked at the moment and it 

says Header Row.  If I unchecked it, then I would not have header row.  The header row is 

different from the rest of the table.  Let me click it back on again and I’m going to type in the 

header row now the data that I want.  On the left column that’s going to say Party and the right 

column is going to say Number of MPs, Members of Parliament, and that is the purpose, 

normally, of a header row.  It enables you to name the attribute, the property that you’re putting 

into that column on the table.  And in this case, you’re saying that the first column contains the 

party, the second column contains the number of MPs.  So let me put some actual data in just to 

illustrate that a little bit more fully.  If I put in under Party Conservative and under Number of 

MPs, I said 303.  That would be correct as of today. 

Now the data I’m entering here is going into these individual what are called Cells, and in the 

cell that I’ve currently got selected, I’m going to type in the second party.  Note that when I’ve 

entered the data in a cell, I can either press the Tab key to go to the next cell which in this case 

would be the next cell in the second column and then I can type in the number of Labor MPs or I 

can just click into the cell where I want to put data in.  So if I wanted to do these in a completely 

different order, I can click in any cell now and enter the data in that cell.  So let me put in the rest 

of the data. 

Now if I get to the end of the cells, so I’ve used all six rows in my table, header row and five 

data rows and I realize that I need another row or another couple of rows. There are two or three 

ways of putting in extra rows.  The simplest way when you’re in the last cell in the table is to just 

press the Tab key and you get another row.  So I’m going to put in this other row a total for the 

other members of Parliament which at the moment is 21. 

So I’ve entered my table of data.  One other option here if I press the Tab key to put another 

blank line in there, up in the Table Style options we also have a Total Row option that’s 

currently not checked.  So if I wanted to put in the total number of MPs, I could do that and it’s 

shaded similarly to the header row.  I’ve also got checked in the Table Style option banded rows 

and the banded rows effect that you can see here.  Let me just uncheck that and you’ll see what 
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banded is.  That is un-banded.  That’s banded.  Banded rows apart from the sort of stylistic side 

of it can be very helpful for readers to sort of read across the numbers. 

Now let’s look at the Design tab again.  In the middle of the Design tab, there’s a group called 

Table Styles that includes a gallery of available table styles.  Now the gallery shows that there 

are quite a few stylistic features that you can use or choose not to use for tables.  The styles here 

are divided into light, medium, and dark and, of course, you’ve got live preview.  Now as you go 

through the various options that are available, you have some styles where there are horizontal 

lines.  Let me select one or two of these just to show what they look like.  If I click on that first 

one in the light category, let me just click away so that the tables not selected, you see that what 

you get are you get these horizontal lines above and below some of the rows.  You also have 

options where the whole of the table has borders.  Borders around it and borders within the rows 

and columns.  Let’s try one of those.  So click within the table again to bring up the Design and 

Layout tab, click on the Design tab, go down there; let’s choose say one of these medium options 

here.  Click away and with this particular medium option, you have a border right round the 

table.  You can, of course, again back into the same gallery, choose different color schemes.  The 

color schemes towards the left here are more like the ones we started with, but you could go for a 

completely different color scheme and if you scroll through the available gallery, look at the live 

preview, you may go for something more like that. 

So finally on the Design tab at the right hand end, there is a group Draw Borders and with this 

group you can actually draw the borders to your exact requirements.  So you can select a row or 

a column or a cell, draw borders with sort of thick at the top and thin at the bottom, any 

combination of borders that you may require. 

Now let’s turn our attention to the Layout tab and take a quick look at some of the commands 

available there.  Well, first of all, you don’t always only need to add rows at the end of a table.  

Suppose you’re in the middle of the table and maybe you’ve missed a row out, you need to 

include an additional row somewhere in the middle of the table.  Well, if you select a row as I’ve 

got here, the table that begins Liberal Democrats selected.  One of the options in the Rows and 

Columns Group is insert above.  If we do insert above, I get a blank row above that one.  There’s 

also an option insert below.  I may need to insert an additional column.  So if I tick here in the 
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Conservative cell and say insert right, I get a whole column on the right of the cell that I had 

selected. 

Now I don’t always want to insert rows and columns.  Sometimes I might want to delete them.  

So in this case, for example, supposing I want to delete the empty column that I just inserted, all 

I need to do is select the column.  I can either do that by dragging down with the mouse, say, or, 

for example, on the Layout tab towards the left there is a Select button, click on the little arrow at 

the bottom there and it will let me select a table, a row, or a column.  At the moment, I’ve got a 

column selected so all I’ve got to do is to click on the Delete button here, the drop down, delete 

columns.  That column has gone. 

Now when I delete a column as you’ll see, it doesn’t necessarily resize the whole table and now 

I’ve got a table that’s a bit narrow and it’s a little bit offset.  Although to be fair, it’s narrow 

enough to contain the information that’s in it.  So if I wanted to center the table itself on the 

slide, one way of doing that if I go back to that Select button and say Select table and then go 

over to Arrange, click on the bottom of the Align button and say align center, I finish up with the 

whole table aligned center on the slide.  I may then, of course, want to change my header to align 

that better with the table.  So again if I click here in this blank row, go back to select, click on 

select row, click on delete rows, and that unused row is gone as well. 

So I’d just like to point out a couple of other things on the Layout tab.  One of them is that there 

is a group Table Size here next to Arrange.  Table Size Group lets you set the size of the table.  

And you also have this Alignment Group and the Alignment Group here is really more geared 

towards aligning single cells or rows or columns.  So for instance, let’s suppose that I wanted the 

headers to be aligned center in their cells.  If I select that row only, so I could do that with select 

row, and then went to the Alignment Group here and clicked on center, I would center the 

headings only because I only had that row selected.  Similarly, if I wanted to center the numbers 

here, I could select the cells that have got the numbers in them; perhaps just drag with the mouse 

like that, center those, and those numbers are centered as well.  I would probably keep the party 

names left aligned. 

So that’s it on the basics of handling tables.  I’ll see you in the next section. 
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Chapter 21 – Charts 

Video:  Creating Charts using Excel; Editing Data, Chart Type and Chart 

Element 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  Earlier on in the 

course we looked at inserting tables into slides in PowerPoint 2013 and as an example we created 

this table showing the number of MPs representing each of the major parties in the UK 

Parliament.  As an alternative to showing numeric data in a table, we can show numeric data in 

the form of a chart or graph.  And in this section, we’re going to look at presenting this same data 

but in graphical, in chart form. 

One important point to realize when you are inserting charts into PowerPoint 2013 presentations 

is that the charting that is used in the software is based on the chart in for Microsoft Excel by 

default.  And what I’m going to demonstrate in this section relies on the fact that you also have 

Excel 2013 installed as well as PowerPoint 2013.  Now if you don’t have Excel installed, as well 

your approach to charting needs to be slightly different.  Most of what you’ll see in this section 

will appear to work in exactly the same way, but you need to setup a way of establishing the 

data.  That’s outside the scope of this course.  So for the rest of this section, I’m assuming that 

you also have Excel installed as part of your Microsoft Office 2013 installation. 

So first of all, insert a new slide just with title and content, enter a title.  Now, of course, earlier 

on I may have taken the opportunity to adjust the size of the placeholders on this slide either as 

an individual slide or on the Slide Master or on the Layout Master, but I’m going to put my chart 

just in the placeholder here as it is.  If I hover over the placeholder, the top middle option there is 

Insert Chart so I click on that. 

Now there are several different types of chart available in PowerPoint 2013.  If you’re used to 

using Excel, you’ve got pretty much the same selection and I’m not going to go into great detail 

here of why you would use each type of chart, but let me just choose one or two of them and 

point out one or two features of this Insert Chart dialog.  One important thing to bear in mind is 

that if you change your mind about the choice of chart, it’s generally very straightforward to 

change the chart type later on.  You certainly don’t have to start again.  One of the very popular 
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formats of chart is a column chart and I’ll show you what our data looks like as a column chart 

later on.  Column is selected here on the left and then the subtypes are along the top here.  Now 

with these subtypes, they each have a name.  As you hover over it, you’ll see a screen tip with a 

name.  So there’s 100% stacked column, a 3-D clustered column, a 3-D stacked column, and so 

on.  And if you want to preview one of those, you just click on it to see the type of chart it is.  

Closely related to column charts are bar charts which pretty much show the same sort of data but 

pointing horizontally instead of vertically.  And again there are quite a few subtypes for bar 

charts.  One of the most straightforward and common types of chart you’ll see is a pie chart.  

These are very often used in PowerPoint presentations.  You specifically use a pie chart when 

you’re showing how something is divided up; the whole of something is divided up in 

proportion.  And in fact in relation to the membership of the Houses of Parliament pie chart here 

would actually be a good approach because we’re looking at a total of 650 members of 

Parliament and this would show how the membership of the main parties is divided up very 

visually.  So I’m going to use the pie chart option.  Just before I do, let’s look at one or two of 

the others.  Align chart is more of a traditional kind of graph showing something increasing, 

decreasing, varying over time.  And then you have, for instance, a stock chart which shows how 

the values of stocks or shares have varied over a period of time.  Now there are various other 

types of chart such as radar chart, area chart, and so on, but in this case, we’re going to go for pie 

chart.  There are some subtypes there and we’ll look at the subtypes after we’ve created the 

chart.  So the first thing we do is to click on OK. 

Now this is the point that some people find rather confusing because what happens is that 

PowerPoint presents you with a little section of an Excel spreadsheet in effect and it invites you 

to enter the data for your chart.  Now if I just move this little spreadsheet out of the way for the 

moment, it’s already inserted a chart and it’s inserted a chart with this; let’s call it this dummy 

data.  So it’s called the chart Sales.  It’s put a title on the top.  It’s put a legend underneath, first 

quarter, second quarter, third quarter, fourth quarter.  And it’s based on the data that I’ve got 

here.  Now all you have to do is to change the data here to actually include your real data.  So all 

I would need to do, for example, if I go into the cell that says first quarter first, so click in there 

and type in there Conservative, and then click in the next cell down.  Notice that already 

PowerPoint 2013 has replaced the first category name which was first quarter with Conservative.  

If I want to actually specify that it’s not Sales, it’s Number of MPs.  Let me just type in here 
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Number of MPs.  And now I find if I just move the data out of the way again that I’ve got a title 

that says Number of MPs.  Now that is not really quite right as you’ll see a little bit later on, but 

what I’m going to do now is go back into this spreadsheet and type in the rest of the data.  There 

are only four categories here, what were originally the four quarters of a year.  The fact that we 

have more than four categories is not going to be a problem because PowerPoint will cope with 

the larger number of categories.  So let me type in the rest of this data and I’ll join you again in 

just a moment. 

So I’ve entered the rest of the data.  If you’re not familiar with working with Excel and you’re 

typing data in here it’s a bit awkward.  Let me just point out one or two key things.  One of them 

is that the little sort of spreadsheet you get here tends to be quite small.  You can easily make it a 

bit taller or a bit wider just by dragging on the edges, maybe pull down to make it a slightly 

bigger sheet; give you a little bit more space to work with.  You can similarly pull it to the sides 

to make it a little bit wider.  And for the individual columns, if you take column A here, the first 

column which is too narrow to show all of the party names, if you hover over the header, you get 

the vertical bar with an arrow sticking out either side, click, drag to the right, you can make a 

column wider.  Similarly, for column B because of the words Number of MPs at the top, you 

need that a little bit wider.  So you can give yourself a little bit more working space.  When 

you’ve finished entering the data, you’re going to close this.  Now that might be a bit worrying 

and you think, well, where’s my data going to go, but don’t worry about it because PowerPoint 

keeps your data safe as we will see in a moment.  So close the spreadsheet and there is the pie 

chart updated with the data that I entered just now. 

Now once the chart is in place and selected, you won’t be surprised to that you get a couple of 

extra tabs on the Ribbon.  These are the chart tools tabs.  There’s a Design tab and a Format tab. 

I want to look at the Design tab first.  One or two key things there; if you need to change the data 

then the button here, Edit Data, if you click on that, it brings back your spreadsheet.  So if you 

need to go in and change the numbers, perhaps break the other category down into more details 

for the smaller parties, you could do that here and the chart will be updated automatically.  When 

you finish making changes to the data, then close it and you’re able to carry on as normal. 

I mentioned before that it’s easy to change chart type.  The button on the right of the Ribbon on 

the Design tab in chart tools says Change chart type.  Click that button.  It brings up the Change 
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Chart Type dialog.  Now it’s almost always the case that there are some types of chart that will 

work with given data and some that won’t.  Let me just look at the column chart for the data we 

have here.  Let me click on column and then for a chart type I’m going to use the 3-D column, 

the one over on the right there.  It gives me a little preview there.  Click on OK and you can see 

what a difference that makes.  It’s using exactly the same data and, of course, the relative 

strengths of the parties are indicated by the heights of these columns.  I could achieve the same 

sort of effect maybe using a bar.  So, what about a clustered bar?  Let’s see what that does.  Click 

on OK.  So it’s pretty straightforward to experiment with the different options once you’ve got 

the data setup.  I’m going to now go back to our pie chart.  

Still on the Design tab, there is in the middle of that tab a Chart styles drop down gallery.  If I 

click on the More button there, I can choose from one of the available styles for this particular 

type of pie chart.  So for instance, I could choose that one which has a lot more depth in the color 

and so on.  And as usual I can go into great detail in formatting and presenting that using 

different background colors, fill colors, put a border on it, and so on.  Many of the commands for 

doing that are on the Format tab which we’ll look at briefly in just a moment.  The other 

important button on the Design tab is right over on the left; that is Add chart element.  This is 

where you can add or remove the legend.  You can change the chart title.  For instance, here the 

chart title Number of MPs as I mentioned earlier just picked that up by default from my 

spreadsheet.  If I wanted to change that, if I hover over chart title, then I can determine whether 

there’s a title at all.  So the top option says None, the next one says Above chart, the next one 

said Centered overlay.  So the title is actually over the chart slightly.  Or if I go into More title 

options, it gives me a pane, a Format Chart Title Pane with a lot of options for fill, border, and so 

on.  So that’s a great way that I can go in and really format that chart title with a great deal of 

precision if indeed I want to.  If I just want to change the words once, the chart title’s selected, 

click in there and I can give it a different title, which is what I’m going to do now.  And then I 

just click away and my title is now in place. 

Now the other chart tools contextual tab is the Format tab and whilst this chart is selected, I can 

use that to set the size of the chart and to do various changes to shape fill, shape outline, shape 

effects.  I can choose the text style.  So, a huge range of possibilities there for formatting or 

reformatting my chart. 
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So I think that gives you a good flavor of what you can do with charts in PowerPoint 2013; 

plenty there for you to try.  And that leads us to our next example. 

If you’ve been working on your own equivalent of my UK Parliament presentation, one for your 

own government, your company, department, maybe a local club or society you belong to, then 

I’d like you to add two slides to your presentation.  If you haven’t been doing that you can use 

example-08 from the supplied files.  And the two slides, one of them needs to have a tabular 

presentation of some data on it in the form of a table, and the other one needs to have a graphical 

presentation of some of the data on it.  It doesn’t have to be a pie chart, any kind of chart or 

graph that shows that data is absolutely fine.  They don’t actually have to be the same samples of 

data.  I’ve used the same in my answer to this exercise which is in the supplied files as example-

09, and it’s actually the data we’ve been using here during the last two sections.  So it’s the 

breakdown of MPs by party in the UK House of Commons in January 2013. 

But before I go, just one other little point that you may find useful.  Having produced this slide 

including a pie chart is not necessarily the final layout that I’d use. But if I go over to the 

thumbnails here, right click on the thumbnail for this one, and just say Copy, I can then close this 

presentation and now I’ve opened the presentation that is part of the supplied files and if I go to 

say Slide 4 there, right click and select one of the paste options.  And if I use in particular the one 

Use destination theme my copied chart appears in the other presentation, in the second 

presentation, and it uses the theme of that second, the destination presentation.  So if you’ve 

prepared a slide that you’re happy with in one presentation, you want to use it in a different 

presentation, that’s one very straightforward way of doing it. 

That’s it for this section.  I’ll see you in the next one. 
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Chapter 22 – Animation 

Video:  Basics of Animation 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section we’re 

going to look at Animation, a very important feature of PowerPoint and one that can really add to 

the impact of your presentations.  I should warn you that in my experience, a lot of people 

overdo animation, they use it too much.  And to a large extent, I think it’s one of the features of 

PowerPoint where less is more as the saying goes.  But what we’re going to cover in this section 

is really what animation is, how you set it up, how to use it, and then we’ll look at a couple of 

specific examples in the next section.  So in this first section, let’s just look at animation in 

relation to these two shapes that we had in a sample presentation earlier on. 

At the moment, I’ve got the small red circle selected.  Click on the Animations tab and on the 

Animations tab, I have a number of groups.  One of the groups is the Animation Group.  Now 

with the Animation Group, if I look at this gallery, there’s a More drop down in the corner.  The 

available animations are divided into categories, and the one that’s in use at the moment is 

selected.  So for the small red circle, at the moment, the selected animation is None.  The 

categories are then really basically three.  We have entrance animation, emphasis animation, and 

exit animation.  We then also get something called Motion Paths. I’ll come back to motion paths 

a bit later on.  Let’s start with the middle one, emphasis. 

And what I’m going to do is first of all is to select the first emphasis animation which is pulse.  

Now you’re going to have to watch this section quite carefully but if I select the pulse, you may 

just have seen the red circle pulse there.  If you want to see what an animation looks like, then 

you can click on the preview button, the left of the Ribbon there, and you’ve just seen the small 

red circle pulse.  Now that’s a very simple kind of animation. 

Now let’s select the big blue circle.  Again, we’ll go into the animations here.  We’ll use an 

emphasis animation and we’ll try the grow/shrink.  Now notice that these objects appear to be 

numbered now with these little rectangles with the numbers in, one and two.  It’s actually the 

animations that are numbered.  But watch what happens now if I do a preview.  So just click on 
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Preview again, left had end of the Animations tab, and basically I get those two animations in 

sequence. 

Now let me add something else.  I’m going to click on small red circle again.  I’m going to go 

back into animation again and, this time, I’m going to choose one of the entrance animations and 

I’m going to choose float in.  Now watch what happens when I preview.  That animation has in 

effect replaced the previous one. 

Now on any given slide, the set of the animations can be seen in what’s called the Animation 

Pane.  And in the Advanced Animation Group, there’s a button there that switches on the 

Animation Pane.  And what the Animation Pane gives you is a timeline for all of the animations.  

Now as I’ll explain in more detail in just a moment, you have basically two choices when it 

comes to animation and they are basically that you can either start an animation using an action, 

usually click of the mouse or the equivalent, or you can arrange animations on the basis of 

timing.  So for instance, you can say that one animation should happen five seconds after 

another.  Now if you look on the Animation Pane, you can see numbered corresponding to the 

numbers in the rectangles here the current animations on this slide. 

Now let’s look at the way that we can control these animations using the Animation Pane.  Let’s 

start with the second one, the one that’s currently on big blue.  If I click on the drop down, then I 

can choose, first of all, on what triggers this animation.  I can say Start on click which would 

cause this to start when I click.  But I can also say Start with previous or Start after previous.  

Now if I say Start after previous, it will become part of the same animation as the first one.  So if 

I click Start after previous, I now have one animation that covers both of these objects.  And the 

animation on big blue begins after the animation on small red circle. 

Let’s go back into the drop down there for big blue and now I’m going to look at timing.  If I 

click on the timing option, there it brings up a Grow/Shrink dialog that is the dialog related to the 

specific animation that I have on big blue.  It’s starting after previous, which is fine, but I can 

specify here a delay, and the delay I’m going to specify just to make it more noticeable is three 

seconds.  I can also specify how long the animation should take.  In this case, the affect is two 

seconds, that’s medium length.  Supposing I change it to five seconds which is very slow and I 

also have the option of specifying a repeat.  So with repeat, I could say let’s do it twice.  So what 
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I’ve said, I already established that this animation is going to start after the other one, but there 

will be a three second delay before it starts; it will be a very slow animation that will repeat.  So 

let’s click on OK and preview that animation now.  There’s the delay, there’s the very slow, and 

there’s the repeat.  Now let’s preview the whole thing.  Bear in mind its one animation.  It has 

two objects involved, Oval 6 that has an entrance animation and Oval 7 that has an emphasis 

animation.  So click on Preview, in comes small red circle, three second delay, and then twice 

big blue circle does a grow and shrink.  And that’s basically how we make up a sort of composite 

and more advanced and complex animation. 

Now as I’m sure you realize by now you can build up some pretty complex animations using this 

approach.  I just want to look at one more thing in this section before we move on.  If we take 

Oval 6, small red circle again, let’s look at its animation.  If I go to the Animation Pane and click 

on the drop down and go into Effect Options, I get the Fly In Animation dialog.  Now as we’ve 

already seen you get a different dialog, or a rather a different set of options within a dialog, 

depending on the animation that’s selected and in this case, for instance, in the settings on the 

Effect tab, direction from the bottom.  Supposing I wanted to have it come in from the left, I then 

have options for smooth start, smooth end, bounce end.  What about putting a little bounce end 

on it?  Let’s just say about a third of a second bounce end.  I could add a sound if I wanted to.  

So I could have it come into the sound of applause.  I’m going to leave sound for now.  And one 

of the other options which is a common option but pretty good one, animate text.  It currently 

says bring all the text in at once.  What about bringing the text in a letter at a time?  And delay 

between letters.  Let’s have a bit of a delay.  Let’s say a 20% delay, 25% delay between letters.  

Now when I click on OK, you’ll get a preview of that.  Don’t forget it’s coming in from the left, 

bounce end, coming in by letter, and there we are.  That’s that full effect now.  Preview from the 

beginning again and then, of course, I also get the shrink and grow for the big blue circle as well.  

So I’ve built up a much more complex animation.  Now I’m sure I’ve completely overdone that.  

But what I tried to do is to show you some of the main options and how they work and also to 

show the sequencing of the animations as well. 

In the next section, we’re going to look at putting those kinds of animations into the context of a 

presentation, how to control it, and how to use it with for example SmartArt.  So I’ll see you in 

the next section. 
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Video:  Controlling Animation; Motion Path 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the previous 

section, we looked at animation for the first time and we looked at animating a couple of 

straightforward shapes using some of the basic types of animation in PowerPoint 2013.  I’d like 

to do a very quick recap now and make a couple of small changes and then we’re going to look 

at animation more in the context of a presentation. 

Now you may recall that the Animation Pane on the right here gives us details of the existing 

animations.  If I look at the second one, this was an animation of the big blue circle, click on the 

drop down there and look at the effect options.  What I’m going to do now is to speed up the 

animation to save us a little bit of time and I’m not going to have a delay of three seconds.  We’ll 

just have a delay of one second and then I’m going to remove the repeat.  And what I’m going to 

do now is to add an additional animation.  Now I’m going to add an animation this time to small 

red circle, but in fact it will become a separate stage in the animation and I’m going to make it a 

float out animation.  So that’s an exit animation.  Now note that when I do that, it becomes the 

last in the sequence.  So I’m going to have Oval 6 coming in, Oval 7 shrink and grow, and then 

Oval 6 floating out.  So let’s preview that, and that’s the full animation. 

Now what I want to do is to look at that in the context of a presentation.  So I’m going to go to 

Slide 1 for this presentation and I’m going to go into Reading Mode.  So I’m on Slide 1 in 

Reading Mode.  Now if I go to the second slide, what do you think will happen?  So go to Slide 

2.  Nothing happens.  You just see big blue circle.  So why do you just see big blue circle?  Well, 

although I’ve been testing that animation, the thing to remember is that for the first stage in the 

animation it was on click.  So until I click, nothing will happen.  So let me click.  It doesn’t 

matter where, just click, and in comes small red circle, and then big blue circle does grow and 

shrink because it is setup to do that after the animation of small red circle.  But note that small 

red circle doesn’t now float out because that’s also been setup as an on click animation.  So again 

if I click, then that goes out.  So if you like the process of manually invoking these animations, 

it’s only really evident when you come to look at the slide show itself. 

And one important aspect of this is that you need to plan how you want your animations to work.  

So let’s suppose that I’m working on a presentation about circles and really what I’m doing as 
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I’m giving my presentation and perhaps this is all written into my speaker notes, is to say 

something like, well, here is big blue circle all on its own.  It’s a very lonely circle.  Wouldn’t it 

like a nice little red circle for a friend?  And then at that point saying for a friend, I click and in 

comes small red circle.  I can then talk about the happy times that small red circle and big blue 

circle have together and how big blue circle grows in partnership with small red circle.  And then 

I can say but, of course, as with all stories there’s a very sad ending and in the end, small red 

circle goes away.  I’m controlling that in this case with the mouse and depending on the audience 

reaction I may find that to say those things takes more or less time, but the animations 

themselves are not timed.  They are controlled, in this case, by clicking the mouse. 

Once you’ve built an animation sequence, it’s not at all difficult to change it.  So let’s suppose 

that I decide in this case that I basically like my animation but I really want to make blue appear 

at the beginning of the story as well.  So all I need to do is select blue, go to the Advanced 

Animation Group and click on Add animation.  Let’s have blue appear, let’s say use random 

bars.  We’re going to see it appear like that.  By default, new animations get added to the end of 

the sequence.  It’s quite straightforward once it’s selected to use this pair of buttons here, there’s 

an up button and a down button, to move the animation to be earlier in the sequence.  As you do 

that, PowerPoint 2013 changes the numbering sequence over here in the little rectangles.  Let’s 

just check that first animation where big blue appears.  That’s start on click.  That’s fine.  I could 

check it’s settings if I wanted to. And then maybe I want big blue doing its shrink and grow and 

stay automatic so the settings for that will stay on Start after previous and then red will exit.  

Maybe I’ll have blue exit at the end as well.  No maybe I’ll just leave blue there.  Okay.  Let’s go 

into Reading Mode and see how that works.  Click once, in comes blue, start telling my story, 

click again in comes red, blue gets happy when it sees red, click again, red goes away, and blue 

stays there and then back into Normal View.  So there we are.  I’ve developed my animation 

sequence. 

Now you’re not restricted to animating simple shapes like circles.  You can animate textboxes, 

images, ClipArt, and so on in PowerPoint 2013.  So what I want to do now is to show you 

animation of a piece of ClipArt and in this particular piece of animation, I’m also going to show 

you something called a motion path as well.  So let’s put another slide in.  We’ll have a new slide 

which is blank, go to that blank slide, and what I’m going to do is to insert a piece of ClipArt.  
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So I’m going to go to Insert Online Pictures and click there, and I’m going to search for a mouse.  

Not the four legged type, the computer type.  There we are.  That mouse there will do, click, 

insert.  Now let’s change the size of that mouse and I’m going to put it down in the bottom 

corner of this slide.  Now let me click on the Animations tab and add an animation for this 

mouse.  So click on Add animation.  Down at the bottom below the exit animations, you have 

motion paths.  There are some standard paths and then you have a custom path.  We’ll look at 

custom path in a moment.  Let’s start with a loop; so click on loop and you can see the mouse do 

a little loop on the slide.  Now you’ll also see this little shape here with a selection rectangle 

around it.  That shows the actual path, the locus of that loop.  And if you wanted to change that 

loop to be bigger or smaller or a different direction, you can use the sizing handles on this little 

rectangle to reroute it.  So, for instance, let’s suppose I make it a much bigger loop, more or less 

filling the slide.  Note that the starting point for the mouse is the darker copy of the ClipArt and 

the grayed out version is the lighter copy.  Now watch what happens if I do a preview.  The 

mouse draws a great big double loop on the slide and then, as I said, you can still see this 

rectangle here with the locus of the loop in it and you can customize that if you want to.  So 

that’s a pretty straightforward case of a motion path animation. 

I’ve got that mouse selected again and what I want to do now is to choose a different animation.  

So I had loops before.  I’m going to go for custom path this time and with a custom path, I can 

map out whatever route I like on the page.  So starting there I can go up to there, across to there, 

down to there, up to there.  I can pretty much go anywhere I like really and finish up in the top 

left hand corner say.  Double click and it does that strange route all around. 

The other thing that I can do with this animation is that I can say what is the trigger for the 

animation going to be?  Now the trigger could be a click of the picture itself.  And one of the 

differences between that and the standard on click is that this will only perform the animation if I 

click specifically on that picture.  So if I got say three or four bits of ClipArt on a slide and they 

each animated or did different things, then what would happen would depend on which of them I 

clicked on.  Obviously, if you’ve only got one on click command, if you click everything’s going 

to react to it.  But you can actually specify with the trigger that you have to click on that 

particular object.  So let me just go into Reading Mode, Reading View for this one.  Watch what 

happens if I click specifically on the mouse; it does that strange route all around the slide.  Watch 
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what happens if I click not on the mouse, it ends my show because it’s the last slide.  So in that 

case I’ve specifically said that the animation is triggered by clicking on that mouse. 

So in this section we’ve looked at some of the types of animation, more on how to control 

animation with specific reference to controlling it in an actual presentation.  There’s one more 

particular topic to look at in relation to animation now and that is to look at animation of 

SmartArt and that’s what we’re going to do in the next section.  So please join me for that. 
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Video:  Animation of SmartArt 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to conclude our look at animation and we’re going to look specifically in this section at 

animation of SmartArt, and then one or two more general aspects of animation as well.  You may 

recall earlier on in the course that we produced this departmental structured chart which is a 

pretty straightforward piece of SmartArt and I’m going to use that to demonstrate the animation 

of SmartArt. 

Now once you’ve got the basic ideas of animation sorted out and it’s pretty straightforward, 

make sure that the SmartArt is selected and then on the Animations tab choose an animation.  

Well, let’s have an entrance animation.  What about swivel?  Now when you’re dealing with a 

piece of SmartArt and you’re dealing with an animation, you don’t necessarily want to animate 

the whole thing.  You would normally want to animate components of the SmartArt and we can 

use the effect options here for that.  So PowerPoint 2013 says to you if you click on the drop 

down at the bottom of effect options, do you want this swivel to be as one object?  Do you want 

everything at once?  Do you want the items in it one by one, a level at once, or a level one by 

one?  Let’s say we’re going to do level at once.  This then shows you how that appears.  Now 

one of the things that some people are concerned about is these connecting lines.  The connecting 

lines between the shapes are not included in an animation.  They’re not animated individually 

and they’re always associated with the second shape that’s going to come in.  So when you’ve 

got two things connected by a line, the first one comes in with no line and then the line comes in 

when the second one comes in.  So let me just preview that again and now let’s do that in 

Reading Mode as though we were actually presenting this.  Click once, there’s the departmental 

head, click again, there is the assistant and the next level of management, click again, and you’ve 

got the member of staff that reports to Joe.  So pretty much, that’s SmartArt graphic animation.  

Let’s go back to that slide; you could, of course, choose to say have an exit animation instead.  

So something like fly out and then, again, you can choose the options that go with that.  You 

have the options with fly out that we had before.  So as one object all at once and so on.  But 

because the options depend on the actual animation, here you get the option of what direction 

you’d like them to fly out in.  So if you said to top right, now let’s go into Reading View, click 

once, and they go. 
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So having seen how straightforward it is to do animation of SmartArt objects, let’s look at one or 

two other aspects that are closely associated with that.  I’m returning to part of my Parliament 

presentation here.  I’m going to go to the slide about the House of Commons and I’m going to 

select the placeholder here that’s got those three paragraphs of text in it.  Now with that selected, 

if I go to the Animations tab, I could actually apply an animation to that placeholder.  Let’s have 

Appear and then for the effect options I’m going to choose by paragraph.  Now let me go to 

Reading View.  I’ve got to that paragraph.  What do I do?  Click once, I get the first paragraph; 

click again, second paragraph; click again, third paragraph.  And that is a very common and 

straightforward way of animating the text in a presentation where you just click with the mouse 

and the paragraphs appear one by one.  Of course, you can have them leave one by one as well 

and, of course, we could build in animations such as bringing this photograph in as well. 

And I hope that by now you’ve got the general idea.  Let’s return now to one of the graphical 

representations of the split of the members of Parliament in the UK by party.  Let’s select the 

chart there.  Go to the Animations tab.  Let’s again choose an entrance animation.  Let’s go for 

zoom, and in the effect options, we will say the vanishing point will be the object center and 

we’ll have them come in by category.  Okay, let me just go into Reading View for that, and click 

away.  So members of Parliament by party January 2013 and I’m doing this in a presentation so 

I’m talking about, for instance, explaining what my chart says.  I can explain that we have the 

names of the main parties at the bottom, the numbers of MPs that are on a scale on the left there.  

Click to see the Conservative party, number of MPs, Labor party, Liberal Democrat, and as I 

click, I can talk about each of those parties and their representation in the government. 

So I think by now you can see the power of animation and you’re really not restricted to either 

straightforward text or SmartArt.  You can apply it to many types of object that you can put into 

a PowerPoint presentation. 

So that’s it on animation for the moment.  There is a related topic which is called Transitions 

where we talk about the transition between slides when we’re doing a slide show.  But I’m going 

to come back to that towards the end of the course.  For now that should be plenty for you to 

experiment with in animation.  But now I’ve got an exercise for you to do. 
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Now I hope that you’ve been working along with this exercise and producing your own 

presentation on your own government or whatever, but if not you can use example-09 for this 

exercise.  And I really want you to put animation on at least three of the slides.  So first of all, the 

third slide which has got the text you saw before, I’d like you to put animation in there.  Don’t 

use the same one that I did, find a different way to either make the text enter or exit or you can 

even get it to emphasize when you click on it or perhaps emphasis the photo when you click on 

it.  I’d also like you to apply animation to this slide with the functions of the House of Commons.  

So perhaps get the components of this to zoom in, maybe just one block at a time or one level at 

a time.  And then the third thing, I’d like you to do is to apply animation to this pie chart.  You 

can actually get the pie chart to build itself up a slice at a time.  So you’ve got three slides there 

to put animation on.  My answer will be example-10.  Don’t forget that when you come to look 

at example-10, if indeed you do, you’re going to need to click on those slides to make them 

appear if you look at it in Reading View or in Slide Show View later on.  So there we are.  Three 

slides to put an appropriate level of animation on.  That’s it on animation.  I’ll see you in the next 

section. 
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Chapter 23 – Printing and Page Setup 

Video:  Printing Slides and Handouts 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at printing a presentation.  It’s actually a very easy thing to do in PowerPoint 2013, 

but there are quite a few things to consider.  And when we say printing a presentation, there are 

actually a number of different versions of the presentation that you might want to print. 

Now for the purposes this section, I’m going to use example-10 from the examples provided as 

part of the course.  And with example-10 open, I’m going to click on File to go into Backstage 

View and then click on Print and that brings me a number of options. 

Now the option I want to look at first is the one that’s in the middle of the settings down here.  

Mine currently says full page slides which is normally the default on a new installation of 

PowerPoint 2013.  So let me click on the drop down there.  Because that will explain the main 

options that we have.  Now if you start with the top, there are what we call the print layout 

options.  If you choose the first option there, full page slides, what you will print will be one full 

page for each slide in your presentation.  Generally speaking, presentations are landscape, as I 

mentioned earlier on, but there’s no reason you can’t have other shapes.  But basically you get 

one slide to a page.  The second option is what are called notes pages.  Now the notes pages also 

have one slide to a page, but with notes pages you see the slide in the top half of the page and 

you see the speaker notes in the bottom part.  Generally speaking, notes pages would be the 

option that you would use if you wanted to print out the pages to accompany you when you’re 

making a presentation.  So if you want to be able to read the notes while you’re giving the 

presentation, or perhaps you want to take the notes away and check them and mark them up 

before you make the presentation, maybe read them on the train on the way home, something 

like that.  You want to be able to see the slides with the notes.  Generally speaking, you wouldn’t 

be giving the notes to the audience, although, of course, there’s no reason that you shouldn’t.  

The third option is the outline option and with the outline option, you’re looking at the outline 

text.  So you’re seeing basically a resume of the text of the presentation outlined.  So you won’t 

see the images but you’ll see the text.  So they are the top three options and we’ll look at each of 

those individually in just a moment. 
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Now below that we have the handout options and these are the options that are most often used 

when you want to present a set of handouts to the audience.  Very often, this will be in the form 

of sheets of paper with a number of slides on.  Now the handout options there are several here.  

The first one is there, one slide, printed in the middle of a portrait page.  Two slides to a page, 

three slides to a page, and so on; right down to nine slides vertical or nine slides horizontal in 

terms of how the slides were arranged on the paper, and this will normally be the option you 

want.  Say you’ve got a presentation with say 40 slides in it.  This means that it’s going to take 

maybe 10 sheets of paper to hold the presentation.  Now, of course, there are several options 

offered here so that you can choose something that suits your presentation which partly depend 

on the nature of the information in the presentation.  If you, for instance, have some diagrams 

that are really quite detailed, you may not want to make them appear too small on the paper 

because if you’ve got a very detailed diagram, that’s say quite difficult to read when it’s on a 

single slide, squeezing nine of those on to a sheet of paper might well make the diagrams 

completely illegible.  So you have to use your own judgment in terms of your own presentation 

as to what the best combination is for these handouts. 

But whether you’re printing the slides, the notes pages, the outline, or the handouts basically 

Print in Backstage View is the place you come to. 

So now let’s look at the main options that are available to us.  Forget the Print button for the 

moment.; we’ll come back to that in just a moment.  The top option here, the number of copies 

that you want; straightforward enough, you can use the tumblers to set the number or, of course, 

you can just type the number in. 

Now we come to the choice of printer.  My printer is set by default to Microsoft One Note partly 

because I very rarely actually use printed material nowadays and partly because when I do, I tend 

to put them into One Note first to have a look at them just to make sure I’m happy with the way 

they’re going to come out.  There is also an option here by default to the go to the Microsoft XPS 

document writer, that’s the Microsoft equivalent of PDF format.  I do have a physical printer 

attached here.  It is ready.  I’m going to use that in just a moment.  And I also have the facility to 

print to a fax.  Now, of course, the list of printers you have will certainly be different to mine and 

you have other options at the bottom here such as Add printer.  So if you’ve just realized, you 

didn’t have your printer plugged in or PowerPoint 2013 is not available to it or whatever, you 
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can go into the Add printer routine there and you also have an option to print to file.  Basically, if 

you’re going to print to paper, which is what I’m going to simulate here, you choose your 

physical printer, in this case the HP Printer that I want, and then once PowerPoint 2013 has 

acquainted itself with your printer, you can then go in and look at printer properties. 

Now printer properties is an area that it’s impossible to generalize about because if I click on 

printer properties for my printer, the dialog that I see will be different to the dialog that you see 

for your printer, unless, of course, you’ve got exactly the same printer as mine.  Some of the 

features will be the same and I’m going to quickly go through one or two of those features now, 

but it’s very likely that many of them will be different.  So for instance, depending on the maker 

and model of printer that you’ve got, the paper sizes that are available may vary.  I normally 

have my paper size set to A4 which people in the UK and Europe generally use.  In the U.S.A., 

you will probably have your paper size set to say Letter.  You can also specify things for my 

printer like borderless printer if you want the printing to go right up to the edge of the paper.  

You also have an option here in the case of my printer that once you’ve got a set of settings that 

you like, you can save them as a quick set of settings and come back to those at any later time 

knowing that you’ve got them set correctly.  The resolution of the print here can be set and then 

we have other things that I can set such as effects, shrinkage, growth, watermarks, how I want it 

finished, do I want to print on both sides, many, many other options.  And really these vary so 

much that as I say it’s impossible to generalize. 

But depending on the printer you’ve got, make sure you actually look at all those, maybe use the 

manual either electronic manual or paper manual that came with the printer and just make sure 

you understand what the settings mean.  Sometimes if you’re trying to print, say, slides and the 

quality of the images on them is not good, it may not be the fault of PowerPoint 2013 at all and 

could well be your settings on your printer.  So make sure you get used to what the settings are, 

have a look at them, and if you can save the settings when you’ve got them the way that you 

want, save them and then make sure you flick back to that setting whenever you’ve got a print to 

do.  I’m going to assume from this point onwards that your printer has its properties set correctly. 

So let’s get ready now to do an actual print.  And I’m going to choose first the middle setting, the 

one that we had right at the beginning, full page slides.  And with full page slides selected, I now 

look at the setting above it which currently says print all slides, print entire presentation.  If I 
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click on that drop down, I have the option to say print all slides, print a selection, print the 

current slide, or print a custom range.  Now with custom range, I can actually type in the 

numbers of the slides that I want.  So I could say, for instance, print 1, 3, and then say 5 to 6 and 

that would print Slides 1, 3, and 5 to 6.  And having decided which slides I want to print, my 

next decision is would I like those slides collated or not.  So I’ve specified two copies.  Would I 

like them printed as two copies of Slide 1, two copies of Slide 3, and then two copies of Slide 5 

followed by two copies of Slide 6?  Or would I like 1, 3, 5, 6 followed by 1, 3, 5, 6?  If I say 

collated, I get the latter option.  If I say un-collated, then I get all the copies of Slide 1, then all 

the copies of Slide 3, etc.  I’m going to stick with collated. 

And the final setting I have down here is the color setting where I can say I’d like them printed in 

color, in gray scale, or in pure black and white.  Now what you use here will largely depend on 

the purposes for which you’re going to use this printout.  If you really want to give your 

audience full color copies of the slides, then obviously color is the way to go.  If you really only 

want to give them a gray scale version of each of the slides or you’re doing some kind of proof 

reading exercise and you don’t need the full color version, then you can specify gray scale or 

even pure black and white. 

So basically for printing a selection of slides from the presentation as defined by this custom 

selection here, they are the decisions that you would normally need to make in order to do that 

print. 

However, there’s one other thing you can do here which you probably notice right at the bottom 

which is that you can also say Edit header and footer.  So if you’d like to put a header and footer 

on to these slides, click on Edit header and footer and it gives you the option of putting date and 

time, slide number, footer on, and so on.  And if you’re dealing with notes and handouts, it gives 

you an option of doing the same for the notes and handouts as well.  Note that it’ll preview on 

the right there which shows you where notes and handouts, headers and footers, page numbers, 

etc will appear. 

And while we’re on that subject, if I just go back into the presentation again, go to the View tab, 

don’t forget I mentioned these earlier on in the course, the Handout Master you can go into and 

edit.  So you could add header, footer, date, page number, and so on here and format those.  And 



PowerPoint 2013 
 

© Copyright 2008-2013 Simon Sez IT, LLC. All Rights Reserved. 
 

similarly, the Notes Master; you can do the same with that as well.  You can determine not only 

the layout of the Notes Master, but you can also put header, footer, etc on there as well. 

So let’s turn our attention back now to the print and look at the other things that we might need 

to print from our presentation.  So we go back into that selection box there and this time let’s 

look at notes pages.  Now when we make a selection here, we also get a preview on the right so 

we can see what these are actually going to look like.  On example-10, the one that we’re looking 

at, I actually added some notes to those so give you some idea of what that preview looks like.  

And I can use the scroll bar and the associated controls on the right to step through.  Note that 

I’ve made a selection here of just four slides: 1, 3, and 5 to 6.  It’s a custom selection.  The 

custom range still applies to the notes pages so you’re only going to see four of these notes 

pages, the ones I specified there in the custom range.  So that’s the notes pages. 

Now let me suppose that I want to print a full set of handouts.  So click there again, change from 

notes pages to I think four slides horizontal, and let me go back, I’m going to get rid of custom 

rage and say print all slides.  So what you’ll see now is how those four would look on my 

handouts.  Now you may think that’s rather wasted space really because the individual slide 

images on that portrait piece of paper seem a little bit lost. But sometimes this is quite a good 

way to give out handouts because it leaves the audience room to write their own notes above and 

below the slides.  They can draw their own little arrows and diagrams and so on.  So giving 

people space on the pages is sometimes a good idea.  In this case, I’ve said print all slides so I 

get two sheets of paper with all seven slides on. 

And of course, I should also point out that when you’ve made all of your choices, you do need to 

press the Print button.  So you go over here, you press Print, and what you have selected and 

specified will be printed. 

And just one other thing to mention; if you go back into the presentation on the Quick Access 

Toolbar, there are generally two buttons: a Quick Print button, and a Print Preview and Print 

button.  My Print Preview and Print button is not actually enabled at the moment so let me just 

enable that.  If I click on the Quick Print button, it does a quick print to the default printer at the 

moment.  And if I click on the Print Preview and Print button, it takes me back into Backstage 
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View, into the print page, and then I can go in and adjust my settings as well as getting a preview 

of how my print will look if I go ahead with it. 

So that’s it on printing in PowerPoint 2013.  I’ll see you in the next section. 
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Chapter 24 – Interactivity and Hyperlinks 

Video:  Linking to a Webpage and a Slide 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at Interactivity and Hyperlinks and I’m going to start by explaining to you the 

reasons for using interactivity and hyperlinks. 

So let me start with interactivity.  Interactivity really is the ability for a user to interact with a 

presentation.  In a straightforward PowerPoint presentation, you tend to start at Slide 1, step 

through the slides until you get to the end, and then that’s the end of the presentation.  But there 

are occasions when you might want to vary, you may want to give the presentation in a different 

sequence, you may want to skip to a later part of the presentation if part of the presentation is not 

relevant to the audience.  In addition to this, and as I’ll discuss a little bit more later on, it’s quite 

often the case that a PowerPoint presentation is being used interactively by a user.  Many people 

will present PowerPoint presentations online and they’re basically user driven, so the user steps 

their own way through the presentation.  It’s useful to be able to things like put links somewhere 

in the presentation to jump to a different section.  It’s quite often the case that people that 

develop PowerPoint presentations at the very end of the presentation put links back to various 

sections so that if somebody gets to the end and they decide that they want to run part of it again, 

they can easily jump back.  So the interactive side of it is basically giving users either the 

presenter, possibly the author of the presentation, but certainly a user of a presentation the ability 

to control the sequence in which the slides are viewed. 

Now the main tool that’s used to provide this interactivity is the use of hyperlinks within a 

presentation.  But there is another reason for having hyperlinks within a presentation and that is 

that they can give links to information outside the presentation.  Now in this section, I’m going 

to use part of the presentation about the UK Houses of Parliament to demonstrate accessing 

information outside a presentation and this information can take many forms.  One of the most 

obvious forms is the ability to access information on the internet.  You need a live internet 

connection to do this but provided, you have that facility I could, in fact, in this presentation 

quite easily link to additional information outside the presentation.  You can also use it to link to 

other presentations.  So if you have another presentation available, you can link to a slide in that.  
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So the ability to link to information outside the current presentation is also an important reason 

for using hyperlinks. 

So first of all, let’s look at inserting a hyperlink into a presentation where the hyperlink is going 

to give us access to a webpage.  So I’m going to go to the first page concerning the House of 

Commons.  I’ve already got three paragraphs there that describe some of the functions of the 

House of Commons.  What I’m going to do now is to put in a fourth paragraph and the fourth 

paragraph is going to be a link to the House of Commons webpage within the Parliament website 

for the UK.  And what I’m actually going to do there, although this isn’t really an important part 

of putting the hyperlink in, I’m going to stop that from being a bulleted point in my list so it’s 

just normal text. 

So to insert a hyperlink, click on Insert, and then in the Links Group, there is a Hyperlink button; 

click on Hyperlink.  Now there are various options and we’ll start with the option on the left.  

We can say link to an existing file or webpage.  We can say link to a place in this document.  We 

can say create a new document or we can link to an email address.  Now for each of those, the 

options that are available here are different and I’m going to start with existing file or webpage.  

If I’m linking to a webpage, there are various ways that I can actually find the URL for that 

webpage.  I can browse to it; I can look at pages I’ve recently browsed to, and so on.  One of 

those by the way is House of Commons UK Parliament.  So if I know that’s the one I want, I can 

say that’s the page that I want to link to and, in fact, it is the one that I want to use.  If I’ve 

actually got my browser open and I’m at the page that I want to use, I could actually copy and 

paste the URL into that address box there.  But whichever way that I use, I can drop the address I 

need into there and then what I need to do is to decide what text I would like to see displayed on 

my presentation slide.  I can have anything I like here.  So just to emphasize what this actually is 

I’m going to change the text there to say Link to House of Commons Webpage.  So that’s the 

text that a user would see.  This address is the URL that clicking on that address will link to.  I 

can also add a screen tip, and for the screen tip, I can pretty much type anything I like. But again, 

just to emphasize the point, I’m just going to put in there Screen tip for link to webpage just to 

emphasize what that does when I demonstrate this to you.  So they’re all the settings I need to 

link to a webpage, click on OK.  So you can see the link to the webpage at the bottom with the 

text that I entered. 
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The link doesn’t work in Normal View or Slide Sorter View or Outline View.  You need to be 

either in Slide Show View or in Reading View.  So let’s preview this is Reading View; click into 

Reading View.  Now, first of all, note if I hover over my link, up comes my screen tip.  Now 

obviously you wouldn’t actually use that as a screen tip, but I wanted to show you what the 

screen tip will do.  You’d put something a lot more helpful in there.  Notice that as I hover over 

the link in Reading View, the cursor changes to the pointing finger which indicates that I’ve got 

a live hyperlink there.  And if I click on that, it will take me to the House of Commons webpage.  

And sure enough I’m at Parliament.uk and it’s open at the House of Commons page.  So when I 

finish looking at that, I can either close the browser or switch back into the presentation. 

So if I’m given a presentation and assuming that I’ve got connection to the internet, I can put that 

kind of link within the presentation. And maybe if somebody asks me a question and I need to 

link to some more detailed information, I can have those links ready to use. 

Now just one thing to point out by the way; let me now go to the House of Lords page and let’s 

suppose that on the House of Lords page I was going to do the same kind of thing.  So I’m going 

to put an extra paragraph at the bottom.  Again, I’m going to stop it being a bulleted list.  I can 

type in the text that I want to use first and then select the text and then say insert hyperlink and 

the text will appear in the text to display box.  And then similarly, if I’ve either got the URL 

copied  on to the Clipboard or it’s in my browse pages, that gives me a very easy and quick way 

of inserting a link to a URL, to a webpage within my PowerPoint presentation. 

What I want to demonstrate next is how to introduce interactivity into a presentation.  So on this 

occasion, I’ve got the Houses of Parliament slide, the second one in the demo version of this 

presentation, and, first of all, I’m going to right click on its thumbnail and go to layout and 

change it to two content layout; you’ll see why in a moment.  That gives me a placeholder on the 

right.  What I’m going to do is I’m actually going to select that placeholder, make sure it’s got a 

continuous line around it, press the Delete key, and then on the Insert tab I’m going to do insert 

shape.  The shape I’m going to use is the first one here.  This is actually a textbox.  I could use 

any of these other shapes if I wanted to, but I’m going to use a textbox on this occasion.  I’m 

going to draw the textbox and type some text.  I’m going to put in there House of Commons.  

Now I’m going to with that box selected I’m going to do center alignment of the text.  I’m going 

to make the text a little bigger.  Let’s say 28 point.  Then I’m going to go to format and change 
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the format of this box. So let’s see what about something like that one.  Now I’ve got an object 

that says House of Commons.  If I just click away from it for a moment, it’s got a bit of shadow.  

It looks fairly 3-D and so on.  And I can actually hyperlink from that object. 

And this is a very important point about hyperlinks and interactivity, and that is that you can 

hyperlink from virtually any object.  It doesn’t have to be some text.  You don’t have to write 

some words on the slide.  You can choose an object whether or not it has text in it.  So I could 

hyperlink, for example, from this image, from this photo.  But I’ve got here what looks like a 

button with House of Commons written on it.  I’m going to select that, go to the Insert tab, click 

on insert hyperlink.  Now notice the text to display says Selection.  It knows that I’ve selected an 

object.  And on this occasion, I’m going to hyperlink to a place in this document.  So if I now 

click on Place in this document, what it does is to give me a number of options.  It says do you 

want to go the first slide or the last slide or the next slide or the previous slide?  These are good 

options given that you may introduce new slides or move slides around rather than specifically 

say which slide you want to link to you might say well link me to the last slide.  If you have a 

button on a slide that says Go to the end, you’d want this to say Go to the last slide.  But you also 

have the slide titles and one of those is House of Commons and that’s the one actually that I want 

to use at the moment.  I’ll get the little preview there that just makes sure I’m looking at the right 

page.  So I’ve said when you click on that button hyperlink, link to place in this document, the 

House of Commons slide.  I could put in a screen tip if I wanted to.  You know how to do that.  

So I won’t do that on this occasion.  Click on OK.  Now let’s go into Reading Mode and let’s 

click House of Commons and it takes me to the House of Commons slide. 

So in this section, we’ve covered the basics of how to insert hyperlinks into a presentation and 

the main two functions really which are navigation in the presentation, but also to give links to 

additional or related information.  There are actually much more extensive facilities in 

PowerPoint 2013 for interactivity and there’s a whole raft of functionality related to actions.  

This is outside the scope of this course but when you get more experience with the use of 

PowerPoint and you want to make your presentations more interactive and particularly if you’re 

building self-running presentations, ones where users are going to be using them themselves, 

then finding out about actions will be a very useful thing to do I’m sure. 
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So now it’s time for you to do the next exercise.  In the presentation that I’ve been working on, 

this presentation about the UK Parliament, I’ve already put in a link to the House of Commons 

webpage or more particularly to the House of Commons section of the UK Parliament website.  

I’d like you to put at least two informational links in your equivalent presentation, the one that 

you’re doing about your government, your club, your society, your company, your department, 

put in at least two links of that kind and make sure that they work okay.  And then I’d like you to 

put in at least two navigational links.  Now what I’ve done is basically on the page where I added 

the House of Commons button, I’ve put a House of Commons button and a House of Lords 

button and each of those takes me to the relevant section in my presentation.  And I’ve also 

added a new last page to the presentation and the last page basically says thank you to people for 

watching and gives a link back to the House of Commons section and the House of Lords 

section.  So from a navigational point of view, I’ve started to make it possible for people to sort 

of find their own way around my fairly straightforward presentation. 

I’ve saved my answer to that exercise as example-11 and I’ll see you in the next section. 
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Chapter 25 – Layouts and Slides 

Video:  Aligning Object; Grid and Guides; Nudging 

 
Toby:  Hello and welcome back to our course on PowerPoint 2013.  In this section, we’re going 

to look at laying out slides and in particular I want to look at some of the options for alignment 

of objects on a slide.  Now I’m going to illustrate this with three objects.  I’ve taken our two 

circles that we’ve used before and added a green card with a cut off corner, as you can see.  But 

what we’re going to look at can really be applied to just about any objects on slides in 

PowerPoint 2013. 

So first of all, let’s select Green card and then go to the Format tab in drawing tools and just 

quickly look at one or two of the things we’ve seen before.  In the Arrange Group, there are a 

number of functions.  We know that if we have these objects overlapping, we can do bring 

forward, bring backwards, we looked at that before.  We’ve also seen that we can rotate and flip 

objects.  And in the case of Green card, if I rotate it 90 degrees, I get that; left 90 degrees, I get 

that, flip vertical, flip horizontal.  With the circles, of course, the flipping is different in that 

physically there’s no difference, but, of course, the text will still flip or rotate.  Another very 

important and useful tool when you’re laying out slides is the Selection Pane, which we also saw 

before.  If I click on Selection Pane again, it gives me a list of the objects that are on the slide 

and on the right hand end of the entry for each of these objects, there’s a little picture of an eye.  

You can hide individual object quite easily.  This sometimes helps to keep big obstructive 

objects out of the way or perhaps just objects that are getting in the way of what you’re doing 

and visually interfering with laying out the slide.  All you need to do is to click on the eye and an 

object becomes invisible, it’s hidden.  And, of course, you can do that with as many objects as 

you like.  So if you’ve got some objects hidden and you want to show them all again, there’s a 

Show all button; obviously, there’s also a Hide all button as well. 

So when we’re working with a number of objects on a slide, we can show and hide them.  You 

know how to resize them.  You know how to recolor them, change the text, add effects.  You 

know how to bring them forward, send them back if they’re in a group.  You know how to group 

and ungroup them and you know how to merge the objects into one.  So what we’re going to 
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concentrate on now in this section is how to align the objects when they’re normally going to 

stay as separate objects but they need to be aligned. 

Now there are some good tools in PowerPoint 2013 for helping you to align objects and one or 

two of those are new in PowerPoint 2013 as well.  Let’s start with one of the traditional ones 

though.  If I go to the View tab, you may recall that we can switch on the ruler by checking the 

box there and just below the check box for the ruler is a check box for Grid Lines.  Now you 

should just about be able to make out the grid lines on the screen there.  The slide has some faint 

dotted lines on it and I can use those faint dotted lines to visually align objects.  So let’s suppose 

I wanted to align the tops of these three objects.  I could move them, just drag them around, and 

visually align them with one of the horizontal lines.  Similarly, if I wanted to align their left 

edges, I could align them with one of the vertical grid lines.  However, there is an even better 

way of doing that and that is you can tell PowerPoint 2013 to snap objects to grid lines. 

Now in the Show Group on the View tab, in the bottom right hand corner there is a Dialog Box 

Launcher and that launches the Grid and Guides dialog box.  Note that as with all the other 

dialog boxes, it’s got a little question mark there if you need to go into Help.  But the very first 

item on that is Snap to check box, Snap objects to grid.  And if that is switched on, what will 

happen is as you move the objects around, they will tend to snap to grid lines.  Now the spacing 

of the grid lines is controlled by this second set of values here.  The grid line space at the 

moment is 1/12 of an inch.  That’s not actually the distance between the lines you can see.  The 

distance between the lines is actually one inch.  So the grid lines are much finer than that.  But in 

order to demonstrate this, what I want to do is to increase the spacing to a much bigger value.  

It’ll be easier for you to see if I do.  I’m going to increase it actually to one inch and then I’m 

going to switch on Snap objects to grid. 

There’s a lower section here, Guide settings.  I’ll come back to guide settings in a little while.  So 

let’s click on OK.  Now we have a one inch grid.  I’m going to try to move the red circle to the 

left and in theory, it will try to snap to one of the lines which is basically going to be one of these 

lines of dots.  It’s usually easier to detect this, if you’re actually dragging it yourself, but see if 

you can see how this works.  Click to select it, pull it.  As soon as I pull it a bit, it leaps right over 

to the next line.  I can’t sort of can’t stop it in between really.  So it’s going in big chunks of one 

whole line as it goes.  Now note it can be lining the left or the right or the top or the bottom. So 
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you may say, well, that’s on a grid line but the left hand edge is.  So it’s trying to snap any part 

of its perimeter to a grid line, and that’s basically how snap to grid works. 

Now using that approach and say moving this one up and down, you could get the top aligned.  

You could push the blue up and align.  You could push the green up and aligned.  You could get 

them all aligned to the same grid line and that’s traditionally one of the main ways that people 

have aligned objects on a slide. 

So now let’s take a look at guides because the third check box in the Show Group there is for 

guides.  And if I switch the guides on, I get vertical and horizontal lines that can be used as 

alignment guides.  So let’s suppose I was going to do some sort of vertical alignment.  I can grab 

the horizontal line.  I can pull it up to a particular position, say, that one, and then I can use it as a 

way of visually aligning each of the objects as I move it vertically.  Now one of the key things 

here is that you can put the guide anywhere.  You don’t actually have to have snap to grid on as 

well.  So if I went back into the dialog, removed snap objects to grid but let on display drawing 

guides onscreen, click on OK.  Now watch what happens as I move up and down, I can get to 

that and I can align with that completely visibly even though I’ve got a free move of the object 

within the space, I can align it vertically like that.  So that’s the function that the guides perform.  

Of course, as you can see here, you’ve got a vertical line here which acts as a guide for 

horizontal alignment.  If you’re not using it, you just ignore it.  It doesn’t actually do anything.  

It’s only there really as a visual guide, as the name implies. 

Now I should point out, there are a couple of things that you don’t need for all this to work.  One 

of them is you certainly don’t need the ruler on for this to work.  So let’s switch off the ruler.  

And you don’t actually need to be able to see the grid lines if you’ve got, say, snap to grid there.  

Also to a large extent, the features we’ve looked at so far are at least in part superseded by the 

latest developments in alignment.  I’m going to switch guides all together so there’s no vertical 

or horizontal guide, but what I want to do now is to move these three objects around without any 

visible alignment and just see what happens.  In fact, before I do that let me just go into the 

dialog, check that snap objects to grid is off, and check that the bottom item there, display smart 

guides when shapes are aligned is on.  Now watch what happens.  I want to try to get these 

aligned so that the centers of the three objects are aligned with a sort of imaginary vertical line.  

So I’m going to move the red one down a little bit to make a bit more space.  I’m going to put the 
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blue above it.  Now watch very carefully as I move the blue circle because I get to a point where 

there is a line going through the blue circle and the red circle and that indicates that their centers 

are aligned.  And if I move the green card down here, watch for that same equivalent line; it’s in 

the middle.  Now I can be sure that those three objects are aligned and the control that’s making 

that happen is basically the smart guide.  Now if I switch that off, let me move them around a bit 

more.  I can’t see anything; can’t see what’s going on.  I can’t see whether their aligned or not.  

Put it back on again and there I can see.  If I wanted to align the left edges, watch what happens.  

Green to red, they’re aligned.  Notice that that vertical line only touches green and red because 

blue isn’t aligned on the same line yet.  Let me move blue a little bit to the right; now all three 

are aligned along that edge. 

So in terms of shear convenience, this is a really good way of aligning objects on a slide.  And as 

I mentioned earlier, you’re not just talking about shapes like this, this will align many different 

things as I’ll show you in just a moment.  Let me move the green card first over to the left here 

and what I want to do is to get the blue circle over to the right in such a position that the spacing 

measured horizontally between the green card and the red circle and between the red circle and 

the blue circle is the same.  Now apart from checking the alignment as we go, PowerPoint 2013 

can also check spacing and it will flag when the spacing between objects is equal.  Now, again, 

this is a bit tricky for you to see.  I want you to watch this carefully as I move the blue circle 

around.  So select blue circle.  Notice that already I’ve got some alignments there.  Vertical line 

indicates that the left edge of red circle and the left edge of blue circle are aligned.  And it also 

indicates that the top of green card and the bottom of blue circle are aligned.  So all the time I’m 

doing it, alignments are being flagged by PowerPoint.  Now watch what happens.  I’m going to 

move blue circle down here and I’m going to move it out towards the right and I get to a point 

where that happens.  And I’ve got a pair of markers there that indicate that the horizontal spacing 

between green card and red circle and the spacing between red circle and blue circle are equal.  

So it’s told me that the objects are equally spaced.  So I’m going to release the mouse and I know 

that those objects are equally spaced on the slide.  And it’ll do the same in terms of spacing 

vertically, of course.  So if I put those like that and then put green down here, again, they are 

spaced equally vertically as well.  So you can see what a powerful set of alignment tools you get 

in PowerPoint 2013. 
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Now I’ve got a couple of other things to point out in relation to aligning objects.  First of all, if I 

have an object selected, I’ve currently got big blue circle selected, and I’m using the keyboard 

then the arrow keys on the keyboard effectively nudge the object a little bit.  So watch this 

carefully.  If I click the up arrow key repeatedly, you’ll see me just moving the object very 

slowly up the screen and I can do that in very small increments; similarly, now the left arrow.  So 

that’s a good way of nudging things very slightly if maybe you’re not so good at fine 

adjustments using the mouse. 

And for those of you who are using touch screen devices, everything that you’ve seen in this 

section still applies to touch screen devices.  If I move Green card around with my finger say, so 

I’ve selected it with my finger, now I’m moving it round.  Note that I still get all the same 

markers and I can still achieve all the same types of alignment just by using a touch screen as 

well. 

Now one of the things I mentioned just now is that this alignment works on just about any object 

in a PowerPoint presentation.  So let’s go back to the Houses of Parliament presentation that I’ve 

been working on throughout the course so far.  I added one button to the demonstration version 

of this presentation, this House of Commons button earlier on in the course.  Let me now select 

that button and watch what happens if I move it up and down.  I get that same alignment guide 

there, the smart guide that says that button is now aligned with the top of that image.  If I move 

the button down, I’ll get a guide when it’s aligned with the middle and down to the bottom and 

so on.  Also note that I appear to get a line on the right.  And you may say, well, what’s that line 

on the right doing?  Well, the line on the right is because of this particular placeholder.  So the 

alignment was with the edge of that placeholder.  So even where you can’t see edges, so for 

instance, the border of a placeholder, you will get alignment there anyway because the rest of 

this particular title placeholder is still an object on the slide. 

And that brings us to the next little exercise.  There may be very little for you to do on this, we’ll 

see.  But I produced example-11 which was my most recent version of the presentation on the 

Houses of Parliament in the UK, the one that included the interactivity and hyperlinks.  I’d like 

you to take your equivalent of that, or indeed take example-11, and just go through it and make 

sure that where there is any alignment to be performed that it’s all aligned.  So things are aligned 

with other things, where edges look as though they should be aligned they are.  Bear in mind that 
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doesn’t mean to say that everything needs to align with everything else.  That’s impossible.  It’s 

just situations where you believe that things should be equally spaced, left aligned, bottom 

aligned, right aligned, that they actually are. 

My answer to that is example-12.  I’d like you to work on your own equivalent presentation and 

I’ll see you in the next section. 
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Chapter 26 – Preparing for a Presentation 

Video:  Spell check; Create Handouts and Videos; Inspect Document Hide Slide; 

Custom Show 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  Given the amount of 

trouble you’ve gone to, to make a really impressive PowerPoint presentation, it’s absolutely 

essential that when you present it or it is presented it has the maximum effect, and one of the key 

requirements for any presentation to be effective is that the preparation for that presentation has 

to be good.  Now there are various ways of presenting a PowerPoint presentation and in this 

section, I’m going to quickly review what the main ones are and then I’m going to spend a little 

bit of time talking about some of the preparation that you would need to make to maximize the 

change of your presentation being effective. 

Let’s start at the low tech end of the technology spectrum.  Let’s suppose that you’re going to be 

making a presentation in a location with no electricity, no computers, and your preparation will 

largely consist of preparing paper material.  So you’re perhaps going to give the audience a copy 

of your slides and carry with you a copy of your notes pages.  Your notes pages can have all of 

your notes written on them, as in this draft of the Parliament presentation.  So you’ve got all the 

notes you need.  If you take something like this slide which is actually SmartArt where we 

applied an animation so that the boxes come in one at a time; bear in mind in that situation that 

you won’t have animation.  You won’t have any sort of dynamic content at all on the 

presentation.  But you might still use exactly the same notes to talk through each of the points in 

the diagram.  Now it may well be that the focus here is on having some nicely printed slides.  

You may also choose to give you handout pages where the slides don’t occupy too much space 

because very often in this kind of low tech situation, one good aspect of presentation is leaving 

some space on each of the pieces of paper so that the audience can perhaps write some notes or 

do a little bit of exercise work, team work as they work their way through your presentation with 

you.  But something’s that generally very important and the first thing that I’d like to highlight 

for any type of presentation, including one which is actually done from paper, is that it’s 

absolutely essential that you spell check and/or grammar check the content of your presentation 

because few things devalue a presentation more due to the emission of a very small amount of 
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work on your part than a presentation that’s got spelling and grammar errors in it.  So rule one, 

always make sure that you’re spelling and grammar check is done, the content of your slides is 

well thought out, there are no obvious errors, there are no missing slides for example.  And then 

even in this situation where you’re going through a paper copy of a presentation, you won’t be 

embarrassed by a very obvious glaring error. 

And when it comes to preparing paper documents, there’s a very good option in PowerPoint 

2013 that we haven’t looked at so far.  If I go into Backstage View and click on Export, one of 

the options there is Create Handouts, and Create Handouts gives you handouts in Microsoft 

Word.  This means that you can edit and format the content in Word and you can also 

automatically update those handouts when your presentation changes.  That’s a very good option 

to look at because you can produce a much more nicely formatted document and you can also 

put additional material into the document to help in a presentation.  And if you’re presentation 

relies a lot on the audience either reading or using printed material, it’s worth taking a look at 

that option. 

Now although the option of working through a presentation on paper still happens from time to 

time and in some situations it’s still the preferred approach, some of the other non-computer 

ways of giving a PowerPoint presentation have all but died out now really, although occasionally 

and in some situations they are used.  These include, for example, producing 35 mm slides and 

giving a presentation using 35 mm slides and the use of overhead projector transparencies 

generated from a PowerPoint presentation as well.  These really don’t happen very often and to a 

large extent the rules to follow are the same as the ones for paper in terms of preparation, spell 

checking, etc.  So I’m going to set those to one side and concentrate for the rest of this section on 

the presentation methods that are basically computer based. 

Now for the methods that are computer based, there are a number of options and I want to look 

first at the option of producing a video because it’s now very straightforward using either 

PowerPoint itself or various other third party products to produce a video of a PowerPoint 

presentation.  If you go to Backstage View and click on Export, one of the options is Create a 

video and this gives you the option to save your presentation as a video that you can burn to a 

disc, upload to the web, or email.  Now this is a very different option to the ones that we’re going 

to look at next because in this particular option, you’re not really supplying people with a copy 
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of your PowerPoint file in any format, you’re just giving them a video.  So they can’t look at the 

individual slides.  They can’t dig into the presentation in some way.  They can just see what 

appears on the screen.  You can include your own narration and there are many settings in terms 

of quality and so on.  You can also dictate the timing on the slides.  So when you create the 

video, you can actually say how long is spent on each slide.  And, of course, because it’s actually 

a video of the presentation, animations and so on can all be included in this presentation. 

The video can then, of course, be played in all the usual ways.  So for example, the video could 

be uploaded to a website and people with the appropriate browser and video playing software 

could play that video on their own PCs.  But that wouldn’t give them any access to your 

PowerPoint file at all.  You’d really just be letting them play a video of the presentation as it 

would be given by you. 

Now for most of the other ways of delivering a presentation, then in some way the PowerPoint 

presentation itself is going to be used or available.  And so let’s take a look at some of the other 

steps in the preparation for delivering a presentation and preparing the materials to go with that 

presentation. 

So let’s suppose that I’m going to deliver example-12 as a presentation and I’m going to deliver 

it using a PC and a separate monitor.  Let’s go through some of the preparation steps.  I’ve 

already mentioned the importance of running spelling and grammar check, but particularly if the 

PowerPoint file itself is going to be copied somewhere or given to somebody else and maybe not 

protected in a particular way, then I may also want to take another couple of precautions.  If I go 

into Backstage View and on the Info tab, one of the options, the middle option there is Inspect 

Presentation.  Now this option is particularly useful.  It really comes in three flavors, two of 

them:  Check accessibility, which is for checking the presentation for content that people with 

disabilities might find difficult to read, and Check compatibility, which is to do with 

compatibility with earlier versions of PowerPoint.  But in the context of getting ready for a 

presentation, it’s the first option there, Inspect document, that is very useful.  Now if you click 

on Inspect document, the Document Inspector dialog let’s you choose what you want to inspect it 

for.  And there are just really two things I’d like to draw your attention to here.  One of them is 

that one, document properties and personal information.  If you have that box checked, when you 

run this inspection, it will look to see if there is personal information in the document.  This will 
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include straightforward things like the name of the author.  Now if you get into the routine of 

running this inspection, it will remind you at least that you need to take your name out of the 

presentation if you don’t want it there, and it will offer other kinds of personal information as 

well 

 The other very important part of this inspection is right at the bottom and that is presentation 

notes.  Now generally speaking, the notes are going to be of use when you are giving the 

presentation itself and if you leave the notes there, there may be a good reason for that.  You may 

be going to use them yourself.  But if you’re going to distribute this presentation, you may well 

want to remove those notes because you won’t necessarily want somebody else to sort of read 

your jokes or perhaps read some comments that might be taken the wrong way.  There may be all 

sorts of dangerous things in your presentation notes.  So both of these at least remind you of 

those things and if you get into the habit of running the inspection after you’ve run the spelling 

and grammar check, you will probably find from time to time that they act as at least a very good 

reminder.  When you click on Inspect, it runs the inspection.  It doesn’t take long.  And if it finds 

either personal information or potentially personal information or presentation notes, then it will 

flag both of those for you and you can check them out or make sure that they’re removed as 

necessary.  So that’s the second very important point to remember.  Make sure that you run the 

Document Inspector if the presentation is going to be copied or if the presentation is going to go 

out of your absolute control. 

So having checked the spelling and the grammar and for confidential or sensitive information, 

the next thing to do is to look at the presentation and say on this occasion am I going to present 

the whole presentation?  Am I going to show all of the slides to my audience?  There are 

situations where you may want to eliminate one or two slides.  Supposing you’ve made a 

presentation for your boss at work and included in that some financial information or some 

planning information or information that somebody else might find a little bit sensitive shall we 

say, then you can hide individual slides very simply.  If you use the thumbnails on the left, 

choose a slide, say, that one with the table on it, right click, and one of the options is Hide slide.  

And if you look at the numbering to the left of the thumbnails that particular slide the numbering 

is changed to read and it’s got a little diagonal line through it.  Now, of course, that slide is not 

deleted from the presentation.  It’s just currently hidden.  So if I went through this presentation in 
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Reading View or I actually presented it as a slide show, people wouldn’t see that slide and I 

could unhide it at any later stage.  If you right click on it again, you have Hide slide is selected, 

click it again, and it becomes deselected and the slide is back in the normal flow of the 

presentation again. 

Now one of the tabs that we’re going to be using a lot in this section and the next one is the Slide 

Show tab.  And if I click on the Slide Show tab, there is a Hide slide button there, depress it and 

the selected slide is hidden; depress it again and it’s unhidden. 

And in fact that Slide Show tab is one also where we have another way of achieving the effect of 

only showing some of the slides in our presentation.  There is a group there Start Slide Show and 

includes Custom Slide Show, so click on Custom Slide Show.  You get an option that says 

Custom Shows and you can create a custom show or use an existing custom show.  So let’s 

suppose I’m going to have three or four versions of this presentation.  I’m going to have one for 

the general public and maybe one for schools, perhaps I’m going to take this presentation round 

and explain the UK political system to schools.  So I click on New and I get a Define Custom 

Show dialog.  Now let me give my custom show a name.  So let’s say I say School and that will 

remind me that this show is the one I take to schools, and I decide which slides I’m going to put 

in there.  So let’s say I’m going to have that one and that one and that one and well I’m going to 

miss those two and I’m going to have that one and that one.  So I then click on Add and I’ve got 

the slides in my custom show.  And I can change the order using these commands on the right 

here.  I can delete one of the slides if I decide I don’t actually want that.  When I’ve made up my 

custom show, it’s available for me then to use when I go to do a presentation.  So when I set 

myself up to run my slide show, I’m at a school and I say ah, I want the school show for this.  So 

that’s creating a custom slide show. 

And you can use this Custom Shows dialog to produce pretty much as many custom shows as 

you want.  Let’s suppose you had a school show and you had versions of that for senior schools 

and junior schools.  You could even make a copy of that, so click on Copy, copy of school.  You 

could then go in, set that up with a different selection of slides, rename it, and so on.  So that’s a 

great way of taking a body of slides and information that you’ve got in a PowerPoint 

presentation and reworking it for different situations and different audiences. 
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And that brings us to the next example.  What I would like you to do is to either take your 

equivalent of example-12 or if you haven’t got one, example-12 itself, and create a custom show.  

Call that custom show what you like.  Mine is going to be called School, and mine is also saved 

as example-13.  I would like you to have at least six slides in that custom show. 

And just a passing thought while you’re working on example-13, you do remember about 

hyperlinks don’t you?  And you do understand about navigation and buttons that move around 

and taking some slides out of a slide show?  It’s just something to be a little bit careful of. 

That’s it in this section.  In the next one we’re going to have a quick look at the final stages of 

preparing to give a presentation.  So please join me for that. 
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Video:  Transitions and Timings; Setting up and Recording a Slide Show 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the previous 

section, we looked at some of the preparation needed before giving a PowerPoint presentation.  

We talked about some of the situations in which you might give a PowerPoint presentation 

without actually providing or even using directly the PowerPoint file itself.  But we’re now 

talking about typical presentation preparation where the PowerPoint file itself is going to be 

used.  Now I’ve already talked about things like spelling and grammar checking and inspecting 

the document for certain types of information if at some stage the document is going to fall into 

other people’s hands or at least other people’s access.  In this section, we’re going to look a little 

bit more at how to actually prepare to give the presentation and some of the factors that come 

into decisions about giving a presentation. 

And the first thing I want to do is to go to the Transitions tab.  Now many people setup 

transitions well before they get to the point of giving a presentation, but some people always 

review transitions just before they give a presentation.  There are a number of reasons for this.  

One of them is that if you have a custom slide show and you’re only showing a certain number 

of slides, you may want to review the way that the transitions work.  And also you may want 

transitions to work differently in different situations.  So let me just talk briefly about what 

transitions are about. 

Basically a transition is what happens when you change from one slide to the next.  There are a 

number of available options and perhaps if we look at one or two of those first to give you some 

idea.  There is actually a gallery of transitions here and if I were to choose, say, Wipe as my 

transition, that gives you a preview of what wipe looks like.  So let’s go into Reading Mode, you 

can see, go to the next slide, nothing.  When you apply a transition, it applies to the selected 

slide.  I only had Slide 1 selected.  If I’d selected say three slides and clicked on Wipe, they 

would all get that transition or even with just one selected, if I click on Apply to all here in the 

Timing Group, it would apply to all.  If I then go into Reading Mode as I step through the slides, 

they all have that same transition. 

Now there are many transitions available.  There’s a big gallery here of transitions that you can 

try.  Some of them are quite complicated like Honeycomb.  And depending on the one that you 
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choose, so for instance, if I take a fairly straightforward one like Wipe, there may be effect 

options as well in which I can choose in this case whether to wipe from right, top, left, bottom, or 

from one of the corners.  Now apart from the basic selection of transition, I can also choose 

whether to include sound, how long a transition should take.  So I can change the duration if I’d 

like to make it slower of faster. 

And then finally on the right here, I can also with a presentation whether I want slides to advance 

on a mouse click or the equivalent of a mouse click or whether I want this slide to advance after 

a set amount of time.  Now as we’ll see, there are different ways in which you might run a 

PowerPoint presentation, including automated ways such as self-running presentations, when 

timing things is critically important.  I’m going to leave this presentation set on mouse click at 

the moment.  I’m going to switch off sound and I’m just going to leave the duration at one-and-

a-half. 

Now what I’d like to do is to go back the Slide Show tab again.  I’m now going to assume that I 

put my transitions into place.  That’s all setup exactly the way I want it to be.  And now I’m 

going to look at setup slide show.  Now to some extent, I’ve got a kind of a lot of things that I 

need to do before I’m actually ready to present the show, as you’ll see in a moment.  But I want 

to look at setup show now because it will highlight a few of the other factors that we need to take 

into account. 

Now, first of all, in the top left the show type.  Is it presented by a speaker in full screen?  Is it 

browsed by an individual in a window?  Or is it browsed at a kiosk in full screen?  Now these are 

very different situations because, for example, if an individual is going to browse a presentation, 

they may go backwards and forwards; they may want buttons that link from part of the 

presentation to another and obviously the capability to do that needs to be built into the 

presentation.  But it also affects the way that we setup things like the transitions and the timings 

and how much of it is automated and how much is not.  There are also a number of options that 

are very important.  For instance, loop continuously until escape.  If you’re going to have a 

presentation that say shows in some sort of kiosk, then you may want the presentation to just 

loop forever until somebody escapes out of it.  You may want to show the presentation without 

any narration.  As we’ll see in a moment you can record a narration and play that back if you 
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want to.  You may want to show it without animation.  Again, it’s an option to show it without 

animation. 

Then there are two other facilities we’ve got which we’re going to look at in the next section and 

they are pen color where we can actually write on slides as we give a presentation and we can 

also choose a laser pointer color as well.  On the right, we then have options for show slides, all 

slides, a selection of slides, or one of our custom shows.  This current presentation has a custom 

show of school that I might choose to use.  Do we want to advance the slides manually or using 

timings if present?  And then we also have options for multiple monitors and alongside multiple 

monitors one of the more recent additions to PowerPoint which is the use of Presenter View.  

Now we’re going to look at multiple monitors and Presenter View in the next section and the one 

after that, but two or three of these options need further consideration.  So let me cancel this and 

we’re going to turn our attention to rehearse timings. 

Now rehearse timings let’s you practice giving your presentation, but it will also time how long 

it takes you to go through each stage of the presentation.  Once you get the timings right, you can 

then automate the running of the show.  So consider this a step towards being able to automate 

the show rather than the whole thing.  The other advantage of rehearsing timings is even if you 

intend to continue to run the show manually yourself, at least you’ll have a better idea of how 

long overall it’s going to take you to give your presentation.  So we’ve only got eight slides in 

this presentation.  Let’s start a rehearsal of the timings. 

Now as soon as the slide show starts I’m going to see a timer at the top there recording each step 

as I make the presentation.  I’m currently in Slide Show View so I’m seeing this exactly as it 

would appear.  Because of the equipment I’m doing which also has to be able to record not only 

what I’m doing but also me talking as well, I’m afraid the image is slightly stretched, but don’t 

worry about that because from the point of view of timings it doesn’t make any difference to 

what you’re actually seeing in terms of the functionality of PowerPoint 2013.  What I’m going to 

do is I’m controlling the presentation obviously by clicking the mouse.  I’m going to run through 

the whole presentation and PowerPoint 2013 is timing as I go because I want to show you what 

happens at the end as well.  So I’m going to click through it all fairly quickly, and then at the end 

we get this message, “The total time for your slide show was 1 minute 3 seconds”.  Do you want 

to save the new slide timings?  Now if I was happy with the way I’d presented this, I would 
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probably save these timings and this is the basis for automating this show.  If I wanted to be able 

to automate the timing of the slides, then I could base it on the timings I made here.  Now clearly 

what I’ve just done, I’ve done very quickly and they wouldn’t really be very realistic timings.  

But I’m sure you can see how you could do this properly on the proper time, probably saying 

what you would intend to say at the same time and get the timings much closer to a realistic 

amount.  So let’s save those slide timings. 

Now having done that and this is a really good one for you to try yourself, if you then go into 

setup slide show, make sure that under advanced slides, the option “Using timings if present” is 

checked, then if you actually run the slide show, so you say Start slide show from beginning.  

We’re going to look at that option in the next section anyway.  You will find that the slide show 

will be presented automatically on the basis of the timings that you just recorded.  But we can go 

one step farther than this, and that is also in the Setup Group here there is an option to record the 

slide show.  And with this option, you can start recording from the beginning or start recording 

from the current slide, but it will also record narration as well.  And if you’re using the laser 

pointer which we’re going to look at a little bit later on, you’ll also see that, and slide and 

animation timings will also be recorded and shown on playback. 

So as we’ve seen, if you want to find out how much time to allow for your slide show, you can 

do rehearse timings.  On the basis of that you can also make your slide show play automatically 

or you can go one step further and record the slide show including a narration and playback 

including the narration as well.  And both of these are significant steps in the direction of 

automatic playback of your presentation, of producing self-running presentations.  But one must 

never lose sight of the fact that sometimes you want to give presentations live, and in the next 

section we’re going to start looking at how to actually give a presentation and in particular at 

how to setup the equipment necessary to do that. 

But I have got one thing for you to do.  I’d like you to use your equivalent of example-13 or 

example-13 if you don’t have an equivalent and I would like you to add slide transitions to every 

slide in the presentation, and not the same transition to every slide.  I’d like the transition on 

Slide 1 to be a fairly spectacular one.  You saw the honeycomb one in this section.  You might 

want to choose something of a similarly splendid nature.  For all of the others something that’s 
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not too showy and preferably all of the other slides have the same transition.  So just number 

one, the first slide different.  My answer to that is example-14.  I’ll see you in the next section. 
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Chapter 27 – Delivering a Presentation 

Video:  Manual Presentation; Presenter View and Tools 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to actually look at a slide show.  Now I’m going to do the most basic version of this really.  

I’m going to use the same Parliament presentation that we’ve been working on, this is example-

14 from the supplied files. 

The first thing we’re going to do is to set the slide show up.  Of course, all of the preparation has 

been done but when you come to actually show the slide show you still have to decide on the day 

what you’re going to show.  I’m going to show the full presentation, not the school one.  And if 

you look at the Setup Group here on the Slide Show tab on the Ribbon, you can see some of the 

options that are immediately visible.  For instance, if I don’t want to use automated timings and I 

don’t want to playback a narration, I can uncheck those.  Media controls relate to using and 

playing audio and video clips.  I don’t need those at the moment.  They aren’t there anyway, but 

I might as well switch them off.  So straightaway I know this is going to be a manual 

presentation and I’m going to be working through it manually, which is exactly the way I want to 

do it. 

So let’s now setup the slide show.  Check the settings, presented by a speaker full screen.  Yes.  I 

don’t want to loop continuously.  I do want to show it without narration because I’m going to 

control this myself.  And I don’t want to show it without animation.  The pen color is currently 

red; I’m going to keep it at red.  And the laser pointer color is also red. I’m going to keep that at 

red.  All slides.  I’m going to operate this one manually.  And don’t worry about Presenter View 

and Slide Show Monitor automatic at the moment.  I’ll come back to those later.  So the settings 

are ready and all I need to do now is to start the slide show. 

With starting the slide show, I’m going into Slide Show View which is the only view we haven’t 

looked at so far in any detail.  Slide Show View occupies the whole screen basically.  So there 

are limited amount of controls visible, although there are some.  And the main choice you have 

when you go into starting a slide show is on the left of the Ribbon here. Do you want to start 
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from the beginning or do you want to start from the currently selected slide?  Let’s start from the 

beginning. 

Now as the slide show starts I get my first transition.  Now to click through, there are a number 

of ways of doing this.  The simplest way is just to click with the mouse.  And as you click 

through, you get the transitions.  I’ve basically got these wiping up.  And let’s look at some of 

the other things we can do while the slide show is in progress. 

Now there are a whole range of keyboard shortcuts that you can use.  You can use the arrow keys 

to go backwards and forwards; so left arrow generally takes you back through the presentation, 

right arrow generally takes you forward through the presentation.  And you can also use certain 

keyboard shortcuts such as N for the next slide, P for the previous.  Don’t forget when you’re 

talking about next and previous, in the case of animations it will be the next animation.  Now if 

you’re dealing with an automatic presentation, you would stop or restart it using the S key.  And 

you can display a shortcut menu.  Keyboard shortcut for that is Shift and F10.  Now that gives 

you a short menu at the top where you can end the show, you can get help, you can reset pointer 

options, and so on.  So having that menu can be pretty useful when you’re partway through a 

presentation.  Another way of stepping through the slides is to press Enter for next and to press 

Backspace for previous.  If you want to go to a particular slide, you can literally type the number.  

Say, I wanted to go to Slide 6, I could type six, press Enter, and it would take me Slide 6. 

Now let’s look at how to use the laser pointer.  Now to use the laser pointer, you hold the Control 

key down and use the left mouse button and with that you can point at any point on the 

presentation.  So for instance, if I click from here into the pie chart, hold the Control key down, 

left mouse key, and I can point at one of the slices in the pie.  Now the other way of bringing that 

menu up is to right click somewhere on the slide.  From there you can choose from pointer 

options.  Laser pointer we’ve already seen, but you could also select pen and then with the left 

mouse key held down you can actually write on a slide.  It takes a little bit of practice, but again 

that can be very affective in a presentation.  Included with that we have an option for an eraser; 

so if I want to rub out what I’ve written that’s pretty straightforward as well. 

If you make ink annotations during a presentation when you close down the presentation, you’re 

given the option of keeping them and they actually become part of your presentation. 
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So I think we’ve covered the main points there.  When you finish with the presentation usually 

the way that people end it is to press the Escape key and that brings you back into Normal View 

in PowerPoint 2013. 

Now a couple of sections ago when we started looking at preparation, I talked about the way that 

people present PowerPoint presentations; we talked about the paper only version, but we’ve just 

looked at what I suppose you might think of as the traditional computer based version where 

basically maybe a very small group of people would gather around a computer screen or a laptop 

screen and watch somebody going through a PowerPoint presentation in much the way we just 

have; maybe using right and left arrow keys to go through it, maybe able to highlight certain 

things, bring up a menu, skip a slide or two, and so on.  And even when people started plugging 

monitors into PCs and letting the audience look at the monitor while the person driving the 

presentation sat at the PC, it was very often the case that the person doing the presentation was 

looking at exactly the same thing as the audience.  But now we have something called Presenter 

View and in Presenter View, the person doing the presentation can see a lot more and a lot more 

useful information than the audience can.  So what I want to do now is to show you Presenter 

View in action. 

Now, of course, I can’t truly show you the full story because I can’t show you two monitors at 

once, but the setup that I’ve got now is basically that I have a PC where I’m running Presenter 

View or I will be in a moment anyway, and I have an external monitor, think of it as a very big 

projection screen, and on that I am basically going to have Slide Show View.  Normally, I go on 

to the Slide Show tab now to start this presentation.  Let’s go back to Slide 1.  You can always 

go into Slide Show View in the same way that you go into the other views using one of the 

buttons at the right hand end of the status bar.  So let’s just go down there.  There’s a button 

there, click on that, Slide Show button, the one that looks a bit like a projector standing on a little 

stand, and let’s go into Slide Show View. 

Now I’m back into Slide Show View now and I did mention earlier on that there are actually 

some little controls in Slide Show View and you need to look down here towards the bottom left 

and you’ll see a little row of buttons.  They’re fairly gray, quite difficult to see.  But you’ve got a 

left button and a right button.  There’s another one which will bring up laser pointer pen and 

highlighter settings.  There’s another one here which will show you all of the slides.  There’s 
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another one that zooms in.  I’ll talk about that in a moment.  But the one of the right with the 

three dots can take you into Presenter View.  So if I say Show Presenter View, I will see 

Presenter View on the screen. 

Now you’ll have to believe me about this but while Presenter View is on the screen, the slide 

show itself is on the monitor, the one that the audience can see.  Now in Presenter View, I have 

many useful options available to me.  Let’s start on the right.  I have my notes over here.  So I 

can actually read my notes while I’m sitting there stepping my way through the presentation, I 

can be reading my notes.  I also have the pens.  I pointed out the pen and laser pointer tools 

options just now.  If I click on that, I can for instance say well I want the highlighter and then I 

could maybe highlight something on a slide.  Now I also have a zoom into slide option here 

which gives me a little sort of rectangle that I can zoom in somewhere on the slide, choose the 

part I want to focus on, click, that’s zoomed in, and then click again on the magnifier to click out 

again.  Now the three dots here let’s me hide Presenter View in which case I would go back to 

Slide Show View.  And I also have options here like Help and end show.  If I want to put a black 

screen on the monitor that the audience can see, click on black screen there to do that, but I can 

still read my notes and I can still work out what I want to do next.  And that could possibly 

include going to one of the other slides. 

Now there are a couple of other very useful things that I have in Presenter View.  The top left I 

have a Show Taskbar option which will let me see my Windows taskbar at the bottom in case I 

need to do anything particular like run another program to check something.  I also have a 

Display Settings button and amongst the options there is swap Presenter View and Slide Show.  

So if in fact, when I start this all up I find that they’re the wrong way around so that I can see the 

slide show and the audience can see Presenter View, then I can figure my way around switching 

those back again.  I can also set this particular display to just duplicate the slide show, and then 

the ever important end slide show at the top here as well.  And finally down at the bottom here 

I’ve got some little buttons I can use to make the text of my notes larger or smaller to make them 

easier to read if necessary, particularly if I’m say in a room with bad light. 

So that’s Presenter View.  It’s a great way when you’re in a crowded room, big presentation, big 

monitor display with the audience watching it.  You can see a lot more of what’s going on and 

control what’s going on and the audience will only ever see what’s in Slide Show View. 
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So you should be in a position now to give your presentation.  You need to make sure that 

everything’s ready; that it’s all spell checked, grammar checked, you’ve got your transitions in 

place, etc.  If you’re just running through it on paper make sure that the handouts are all 

prepared.  If you’re presenting it electronically, then make sure that you know how to use 

Presenter View if you have two alternative devices, one to run it from and one to display it on.  

And, of course, if at any stage you are parting company with a copy of your PowerPoint 

presentation, don’t forget to make sure that it’s as secure as you need it to be, for example, as 

we’ve seen make sure that you’ve removed any personal information that you don’t want in it 

and make sure that you’ve removed your presenter notes if that’s what you intend to do.  In 

terms of actually giving the presentation, if you’re giving it manually, as I said Presenter View is 

great. But you may have decided to record it, including recording a narration.  If that’s the case, 

then when you play the slide show make sure that you’ve got options like play narrations here set 

and you’ll sit back and enjoy other people watching your slide show either with you there or 

without you not there. 

So that’s it on giving a presentation.  I’ll see you in the next section. 
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Chapter 28 – Collaboration 

Video:  Comments 

 
Toby:  Welcome back to our course on PowerPoint 2013.  So far on the course we haven’t really 

considered some of the factors involved in collaborative working on a presentation.  What 

happen if you’re working as a member of a team or if at least you have somebody else to review 

the work that you’re doing?  One of the facilities provided in PowerPoint is the ability for 

somebody to comment on the contents of a presentation and these facilities have been improved 

in PowerPoint 2013.  So in this section we’re going to look at how you can review a 

presentation, make comments on it, and then as the perhaps original author of the presentation 

how you can respond to those comments. 

So first of all, let’s suppose that I’m reviewing the presentation that I’ve been provided with.  I 

go to the Review tab and one of the groups on the Review tab is Comments.  Now if I’m looking 

at this particular slide about the House of Commons, I could choose something and make a 

comment on it.  Let’s suppose that I decide that I don’t think that say particularly suitable 

photograph.  If I select the photograph and click on New comment, the Comments Pane appears 

and it includes not only an identification of me, this is a comment by Toby Arnott, but it gives a 

timing for the comment and this little Delete button here let’s me delete the comment.  But I 

would make my comment here.  So let’s suppose that I say I think we need a better image here.  

When I finish typing I can either hit the Enter key or I can just click somewhere outside the 

comment box.  I’ll just hit the Enter key.  And that leaves a space for a reply probably by the 

author, the person who originally put that image in there. 

Now one thing to note here is that once you’ve put a comment in, a little indicator shows next to 

the object or the place where you’ve inserted the comment and somebody reviewing this can see 

that indicator and realize that a comment has been made.  In the Comments Group, there is a 

Show comments button and if you click on the drop down arrow, the bottom half, it says Show 

markup which is currently ticked so it means we can see the markup and show the Comments 

Pane which is clearly visible as well.  If I click off Show markup, then I don’t see the pane or the 

comments, but of course the comments still there I just can’t see it.  So let me just put markup 

back on and I can see that little comment. 
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Now if I were the person that were going to review the comments what I might do is to go 

through doing next and previous buttons in the Comments Group here to look at the comments 

that have been made.  So let me put another comment in now.  Let me go down another couple of 

pages, say to here, and say insert there.  New comment; again, make a comment here. There you 

are.  I’ve made a slightly longer comment there.  And note how the little icon, the comment icon 

which is like a speech bubble, appears in the middle of the text where I’ve made the comment. 

Now let me suppose that I’m the original author. In fact, I’m going to be replying to my own 

comments here I’m afraid.  But I’ve just opened the document and the first thing I want to do is 

to see if there are any comments.  Now with the Review tab selected, if I click on Next, it will 

take me to the next comment and automatically opens the Comments Pane as well. Now if I see a 

particular comment like I think we need a better image here, I’ve got a couple of options.  One 

option, of course, is to reply.  So I could type in my own reply to that comment and perhaps send 

the document back to the person who made the comment again.  Or if I disagree with the 

comment, all I’ve got to do is delete it.  And if I right click, one of the options there is to delete 

the comment.  If I delete the comment, it’s deleted and then I can just go to the next comment 

and then decide what to do about that as well.  One option is to delete the comment; one option is 

just to make a reply. 

And that’s just about it on comments in PowerPoint 2013.  Just one other very quick thing to 

mention; you may recall when we looked at printing that one of the options when you print a 

document is whether to print the comments and certain other types of markup as well.  So if you 

were say taking a paper copy of this away to review, you might want to just check and make sure 

whether you want the comments printed or not.  Similarly, if you were printing a paper document 

for a handout related to this presentation you might want to carefully consider whether you want 

the comments included or not. 

So I just have one pretty straightforward exercise for you to do based on comments.  Example-15 

in the supplied files which is again the UK Parliament presentation has three comments in it at 

various places.  I’d like you to delete the first one and the third one and on the second one, I’d 

just like you to reply to it and say that you agree. 
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So that’s it on comments in PowerPoint 2013.  My answer to the exercise is example-16.  I’ll see 

you in the next section. 
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Chapter 29 – Sharing 

Video:  Saving your Presentation on SkyDrive 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section, we’re 

going to look at sharing and SkyDrive. 

And first of all, I want to explain to you by sharing.  Once you start to collaborate with other 

people on a presentation, then you need a way of accessing that presentation.  Now, so far, we’ve 

spoken in terms of passing the presentation from one person to another.  So I could, for instance, 

work on a presentation, get it started, put it on my memory stick, give it somebody else, let them 

make comments, let them make their own changes, and so on and in that way we can pass the 

presentation around until we’ve finished working on it.  But in many situations this is neither a 

very efficient way of working nor a very helpful way of working.  It’s a much better option to 

have the presentation in a place where we can all see it and we can all work on it.  And in that 

situation we’re really saying that we have shared access to a presentation and that we’re able to 

literally share the presentation. 

Now in many ways, there are similar arguments when you’re talking about people being able to 

view a presentation.  You can setup your presentation to be visible on the web, perhaps from 

your own website, and in that sense the presentation is shared in that other people can watch the 

presentation, possibly even have the ability to navigate their way through it independently of you 

or to have it auto-play so that they can just sit and watch it.  But what we’re talking about in this 

section is really a step beyond that.  It’s not the ability for somebody just to watch the 

presentation.  We’re talking about the ability for somebody to change the presentation or at least 

potentially change the presentation.  Now if you publish a presentation on a website for the 

general public to see, the last thing you want is for them to be able to go in and delete a few 

slides or change a few of the words.  So in the sense of being able to watch a presentation that’s 

one thing.  What we’re talking about here is the next step beyond that which is the ability to 

change a presentation or as I say potentially change a presentation. 

Now traditionally when people have wanted to have shared access to a presentation or in fact to 

many other types of Office document, the approach they’ve used is to put the document on a 
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network or a network available drive, a storage device that’s available to many people on what is 

often a business network.  And over many years that has worked as a very good approach to 

sharing presentations.  But this more recently has evolved into something else all together and 

this is the ability to have what is probably the widest network of all which is the Cloud, which is 

the ability to store a presentation somewhere that you can access from almost anywhere in the 

world.  And in addition to being able to access it from just about anywhere, to have a very wide 

choice of devices that you can use to access it from.  So let’s suppose that you’re using a 

conventional laptop to work on a presentation and you want to share the development of that 

presentation with one of your colleagues who’s perhaps on the other side of the world to you.  

You might want them to be able to work on it using say a tablet device.  Or maybe you want 

them to work on it without having an installed copy of PowerPoint, for example, on the PC that 

they’re using.  This is really where the Cloud comes in, in general terms and in the context of 

Microsoft and Office, it’s where SkyDrive comes in. 

Now I must emphasize here that SkyDrive is just one approach to the use of the Cloud.  But in 

terms of Microsoft Office 2013 in general, I believe it’s the most convenient and the most 

seamless approach.  And as you’ll see hopefully in this section using the Cloud as a way of 

sharing a document gives you both good control and very flexible facilities for working on a 

document with your colleagues and to making it available under your own control. 

Now the key to this is having a Microsoft account.  If you had an old Hotmail account or maybe 

still have an old Hotmail account or you have a Live account, Microsoft Live, Live.com, 

Live.co.uk, whatever it might be, then either of those basically gives you a Microsoft account.  

So let’s start with the Microsoft account. 

You’re going to need a Microsoft account to do this.  If you don’t have one already, you’re going 

to need to sign up for one.  There’s plenty of information on Microsoft.com about how to do this.  

I’m only going to say the next thing once.  I’m not responsible for Microsoft changing things.  At 

the moment, these accounts are free and I’m going to tell you a little bit about what comes with 

those accounts being free.  But if they change this between the time that I’m recording this and 

the time that you’re following this course, I’m sorry but I’m not really responsible for that.  So at 

the moment, Microsoft accounts are free.  I’ve had a Microsoft account for many years.  They’ve 

never started charging me for it.  I don’t believe they’re going to start doing that now.  But you 
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are going to need a Microsoft account.  So if you haven’t got one, check it out on Microsoft.com 

and get yourself a Microsoft account. 

Now once you’ve got the account or if you’ve already got an account, you need to log in to 

Live.com.  So I’m just going to log in with my Microsoft account, click on Sign in.  By the way, 

if you go to Live.com, there is a link down here “Don’t have a Microsoft account.  Sign up now.”  

So you’d actually get your Microsoft account from there.  But I’m going to click on Sign in.  

Now once you’ve logged in one of the options available to you will be SkyDrive.  So click on 

SkyDrive. 

Now if you’ve never used SkyDrive before or you’ve never accessed files on the Cloud before, 

you may wonder what on earth SkyDrive is.  Well, think of it as a storage folder.  Just think of it 

as a folder on your computer and in that folder you can put files and in that folder you can create 

other folders.  So in the case of my SkyDrive, I’ve currently got three folders.  I’ve got a 

Documents folder, Pictures folder, and a Public folder and each of those has got some files in it.  

In fact, Documents has got one file, Pictures has got four, Public hasn’t got any at the moment.  

What I can do is to use those folders or in fact the top level, which is currently empty apart from 

those three folders, to store a presentation.  And then what I can do is to send a link to that to one 

of my colleagues who’s working on the presentation with me.  Now generally speaking these 

files are not accessible to the general public.  So although I can easily see what’s in my 

SkyDrive, the general public can’t and I have to give people specific permission to even look at 

these files and even more specific permission to make changes to them.  But if I say saved the 

presentation, I’m working on to my SkyDrive and sent somebody else the right link and gave 

them the right permissions, then what they’re going to be able to do is to open that presentation 

from their computer and make changes to that presentation.  And that’s really what we’re going 

to look at in the rest of this section, that is I’m going to save a PowerPoint presentation to this 

SkyDrive and then I’m going to give somebody else access to that presentation so that they can 

go in and work on it as well. 

Now just before we do what I just described, I’ve got one other thing to point out about 

SkyDrive.  You may well want to take a little tour of SkyDrive and found out how to use it a 

little bit more extensively yourself, but at the time of writing when you get a Microsoft account, 

you’re entitled to 7 GB of space on SkyDrive for free.  If you look on the left here, there’s a little 
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note there saying I’ve got 6.99 GB available.  So obviously the storage space I’m using is not 

very much at the moment.  Microsoft may well change the amount that’s free, of course, at any 

time.  But there are also paid plans if you need more that 7 GB. 

So all that I’m going to do here now is to create a folder for my presentation.  So I click on the 

Create drop down here, say create folder.  Note that I could create a PowerPoint presentation 

here is I wanted to and I’m going to talk about that a little bit later on. But for now I’m going to 

create a folder.  The new folder is going to be called Parliament and it’s empty at the moment, 

that folder, but it won’t be for long.  So when I finish doing that, I can sign out of SkyDrive, and 

then I’ll go back to PowerPoint. 

So now I’m back in PowerPoint and I’m going to save this presentation to SkyDrive.  So I go 

into Backstage View, go to Save As.  Now if you already have SkyDrive setup in PowerPoint, 

you’ll have an entry like this at the top, in my case Toby Arnott SkyDrive.  If you don’t have 

that, then provided you’ve already setup SkyDrive via your Microsoft account in order to set this 

up or the equivalent of this up in PowerPoint, click on Add a place and one of the options in Add 

a place is SkyDrive.  Just mention in passing here Office 365 SharePoint, if you’re a subscriber 

to Office 365, this is how you would actually setup a linkage there.  That’s outside the scope of 

this course so I’m just going to stick with SkyDrive.  So select SkyDrive and now what happens, 

it says Sign in to Office.  Now if you click on Sign in here and then put in the details of the 

Microsoft account that you may just have created that will make a connection into SkyDrive, and 

then you’ll have the equivalent of Toby Arnott SkyDrive listed when you do Save As.  Now 

obviously, I’m not going to go through that for my account because it’s already done, but that’s 

basically where you need to go and what you need to do.  So, sign in to your new Microsoft 

account and you’ll finish up with a linkage through there to your SkyDrive.  I’m going to close 

that now and go back to use my SkyDrive. So select SkyDrive, then click on Browse and as you 

can see I’ve accessed what I’ll call the top level in my SkyDrive.  You can see the three folders 

that were there when we first got to my SkyDrive a little while ago and you can also see the new 

folder that’s there, Parliament Presentation.  So I just treat this now exactly as though it was a 

storage folder on my PC.  Go into the Parliament Presentation folder and just click on Save, and 

now that presentation is saved to SkyDrive. 
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So when I’m running my copy of PowerPoint 2013 on my PC, I can open that copy of this 

presentation on SkyDrive whenever I have a connection to the internet.  But the other important 

aspect of this is that independently of my installation of PowerPoint 2013 on the PC I’m using 

here, I can go to any browser and look at this presentation on SkyDrive without using 

PowerPoint 2013 and that’s what we’re going to look at in the next section.  So please join me 

for that. 
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Video:  PowerPoint Web App; Send Email; Get a Link 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In the previous 

section, we saved a presentation to SkyDrive and in this section, I want to show you how you can 

both look at that presentation on SkyDrive without necessarily having an installation of 

PowerPoint 2013 and also how you can setup to share that presentation with other people.  So, 

first of all, let’s open a browser and go to SkyDrive. 

So here I am at Live.com again.  I’ve put my Microsoft account email address in there, type in 

my password, and click on Sign in.  And once I’ve signed in go to SkyDrive. Note the options 

that are available on SkyDrive.  I have four options at the bottom:  New Word document, New 

Excel document, etc.  These enable you to create new Word documents, Excel workbook, 

PowerPoint presentations using the web versions of these pieces of software.  Now we’re going 

to talk about that in just a moment, but we also get access to things like recent documents and 

also Docs, documents shared with you.  And where you have somebody sharing a document with 

you this is one way that you’ll be able to go into access that document.  But for the moment, let’s 

just go into documents, the top option.  I can see that one of the folders is Parliament 

Presentation.  So if I click on that, I will see my UK Parliament presentation there as a file. 

Now I’m going to right click on that presentation and the range of options here is very important. 

First of all, we have two top options:  Open in PowerPoint Web App and Open in PowerPoint.  

The second option will only be there if you have PowerPoint installed on the machine that you’re 

accessing the presentation with.  But if you don’t have any installation of PowerPoint at all, you 

can still open it in the PowerPoint Web App and indeed work on it in PowerPoint Web App.  

Now I’m not going to go into detail here of what the difference between PowerPoint Web App 

and desktop PowerPoint is.  You can’t do as much in PowerPoint Web App but you can do most 

of the things that you’d be likely to want to do on a standard presentation. 

I’m going to open this is PowerPoint Web App in just a moment but I want to talk about a couple 

of the other options on this menu first.  One option is to download the presentation and another 

option, the one we’re going to look at in a little while, is sharing and this is where we share the 

presentation with other people.  I’m not going to go into any of the other options in detail now.  
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Most of them are pretty self-explanatory, Rename, Delete, Move to, Copy to, etc.  But before we 

do anything else let’s just take a look at the PowerPoint Web App. 

Now when the presentation opens in the browser, it basically opens in a way that you can step 

through it.  It’s really a bit like Reading View really.  And at the bottom of the display here you 

can see Slide 1 of 6.  It lets you step through the slides in the presentation and basically where 

there are links, they will work and so on.  But you have a menu system up here, one where you 

can manage comments.  So it’s a great way of actually going through and making comments on a 

presentation, either one you’re sharing or maybe one that’s been shared with you.  You also have 

the option of starting a slide show here.  But very importantly, you have an Edit presentation 

option and from here you can decide whether you want to edit in PowerPoint. Notice it says there 

use the full functionality of Microsoft PowerPoint, or whether you want to edit in PowerPoint 

Web App.  Make quick changes right here in your browser.  So if you say Edit in PowerPoint 

Web App, now the selection of things that you can do is restricted but there are still many things 

that you can do and if the changes that you want to make are not particularly complicated and 

you don’t need the full range of shapes, for example, and that you don’t need to be able to handle 

every kind of animation, for example, then you can certainly do straightforward pieces of work 

within the PowerPoint Web App.  And don’t forget the big advantage of using the PowerPoint 

Web App is that you don’t need PowerPoint installed on the device you’re using.  So if you’re on 

the other side of the world, you don’t have your regular PC or laptop with you, all you have is 

access to an internet browser, you can literally go in and use the PowerPoint Web App and you 

can make changes to presentations.  So when we finish working on this it’s got its own little sort 

of Backstage View so I’m going to do an exit from that to my presentation and I’m going to right 

click again.  Now let’s take a look at sharing. 

Now there are two or three mechanisms for sharing a presentation on SkyDrive with other people 

and we’re going to quickly look at those in just a moment.  But before we do, I need you to be 

aware of something.  And that is that when you share a presentation, you can share it with 

somebody in one of two ways.  One way of sharing it with them is to give them Read Only 

access.  So the person can literally use the link you send them, open the presentation, and read it.  

They can step through it.  They can look at it.  They can read the information.  They cannot 

change it.  The second option is to give people the ability to edit the presentation, to change it in 
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the way that you can.  Now these are governed in this situation by this check box here.  If that 

check box is checked, recipients can edit.  It may well be that when you come to share this 

presentation you do two operations.  One operation is to share it with people who can edit it and 

one operation is to share it with people who cannot edit it. 

So let’s look at these options for sharing now; over on the left, Share.  You can send an email.  

You can post it on Facebook, Twitter, or LinkedIn or you can get a link.  Now I’m not going to 

go into Facebook, etc here.  Pretty straightforward; if you click on that option, then follow the 

instructions you’ll be able to share it with named groups or people using one of those three social 

media services.  Send email is the first one to look at.  All I need to do here is to type the name of 

one of my colleagues, friends.  I can actually type in several names or use the distribution list.  I 

can put in a personal message if I want to and then I click on Share.  Don’t forget what I said just 

now, if you leave that box checked, you’ll be sharing access with those people and when they 

access the presentation they’ll be able to change it.  So if you’ve got one person, say a colleague, 

a coworker you’re working on this presentation with, you as might well put their email address 

in here, type in a suitable message, say, Hi Jane, Here’s that presentation.  Please make your 

changes and let me know when you’ve done.  Leave recipients can edit checked, click on Share.  

If you just want people to be able to read it put their address or addresses in there, maybe a 

distribution list, again a message, make sure that box is unchecked, and click on Share.  The 

person or people will get an email message with a link that they click on and when they’ve 

clicked on that link, then SkyDrive, you’re Microsoft account, and PowerPoint take care of their 

access to your presentation. 

Now the other main option for sharing is this one:  Get a link.  And if you click on Get a link, 

you get basically three sorts of link.  You get a View only link which you can send to people.  

You could actually email the link to them, put it into an email message or maybe even post it on 

your website.  Anyone with this link can see the files you share.  If you click on this button, you 

get a link where anyone with this link can see and edit the files you share.  So again you could 

provide this to somebody who’s working on the PowerPoint presentation with you and you’d not 

want to publish this link obviously in a public place.  But it might be useful rather than emailing 

it to somebody to be able to put it in a secure location for them.  And this one is the one where 

you say make public, anyone can search for and view your public files even if you don’t share a 
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link.  So this is the way that you can take a presentation that you’ve got stored on SkyDrive and 

make it publically accessible, so people don’t even need to have a link sent to them.  So Get a 

link is the other way of sharing your PowerPoint presentation that’s stored on SkyDrive. 

So that’s it as far as sharing and SkyDrive is concerned.  I’d like to leave you with one exercise 

to do here.  This isn’t one where you’re going to specifically produce a presentation.  I want you 

to take the most recent presentation that you’ve made yourself and I want you to store it on 

SkyDrive.  You don’t necessarily need to share it with anybody.  Of course, you can do if you 

want to.  But I’d just like you to save it to SkyDrive.  Now if you have a particular reason not to 

save something on SkyDrive or not to get a Microsoft account, then obviously you don’t need to 

do this.  But if you already have a Microsoft account it should be very straightforward, if not as I 

say you can get a Microsoft account for free and you may find it useful for other aspects of using 

PowerPoint 2013 and Office 2013.  But make sure you get SkyDrive setup and save one of your 

presentations to it just to make sure that you understand how that all works and that you can use 

that in the future. 

That’s it for this section.  I’ll see you in the next one. 
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Chapter 30 – Online Presentation 

Video:  Presenting on the Web 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In earlier sections, we 

looked at a couple of important aspects of using PowerPoint 2013.  One of them is that with your 

Microsoft account, you can use SkyDrive both for storing and sharing presentations.  And we 

also looked at various ways of delivering your presentations to your audiences.  In this short 

section, we’re going to look at one of the other ways of delivering a presentation to an audience 

and this one uses the internet and your Microsoft account.  And we’re going to refer to it as 

presenting on the web, although in PowerPoint 2013 it’s usually referred to as presenting online. 

Now this is really pretty straightforward to do.  You click on Slide Show and then one of the 

options in the Start Slide Show Group is Present online.  Now note what it says there.  This uses 

the Office Presentation Service, a free public service that allows others to see your slide show in 

a web browser.  So click on Present online and we get a fuller description.  The Office 

Presentations Service is a free public service that comes with Microsoft Office.  You can use this 

service to present to people who can watch in a web browser and download the content.  You 

will need a Microsoft account to start the online presentation.  There’s a check box under there 

which you check or uncheck as the case may be, depending on whether you want your audience 

to be able to download the presentation.  So if you want them to be able to download a copy of it 

check that.  You’re going to need your Microsoft account, of course, which you should have by 

now.  There are Service Agreement, but basically click on Connect and then when the 

presentation preparation is complete, you see this little dialogue, a link is in the box here.  Share 

this link with remote viewers and then start the presentation.  You can copy the link if you say 

want to drop it on to a web page or you can send the link in an email to a set of recipients, the 

people you want to be able to follow the presentation online.  I’m going to assume for the 

moment that I’ve sent the email to the people or I’ve copied and published the link.  When 

you’ve done all that, you just click on Start presentation and then I just run through the 

presentation in the usual way knowing that my audience can all follow it using their own web 

browsers.  So that’s a pretty good way of giving a presentation remotely on the web. 

That’s it for this section.  I’ll see you in the next one. 
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Chapter 31 – Working with Multimedia 

Video:  Inserting and Formatting Video; Adding Audio 

 
Toby:  Hello again and welcome back to our course on PowerPoint 2013.  In this section we’re 

going to take a look at multimedia in presentations and I’m going to do this by means of a couple 

of examples.  First of all, I’m going to put some video into a presentation and then I’m going to 

add some sound.  So let’s start with the video. 

I’ve got a brand new presentation now.  Let’s put in a new slide.  We’re going to go for the title 

and content option and you’ll be familiar by now with the six little icons.  We’ve used all of 

those except the one on the bottom right and that is Insert Video; so click on Insert Video and 

this brings up the Insert Video dialog.  Now there are basically four possible sources for video to 

go into a PowerPoint 2013 presentation. 

Now I’ve said that there are four options.  There are sort of five options in a way but let’s just go 

through them; first of all from a file.  If you have a video file in an appropriate format, you can 

browse to that file here and insert that.  You can also ask PowerPoint to invoke a Bing video 

search to find an appropriate video.  You need to be careful if you get a video from the web, you 

get all the same sort of copyright issues that you have with images.  So if you’re putting together 

a presentation that is going to be made public in some way, do be aware of copyright and royalty 

issues.  You can access and insert a video from your SkyDrive using this option.  And if you 

have a video embed code, you could paste the video embed code in there.  Now if you’ve used 

certain types of video services, then you may be aware of video embed codes.  I’m not going to 

go into them in detail here, but if you know what they are, you can paste one into there.  The sort 

of fifth option is the YouTube option which is really a variant on the above.  But it is a very 

convenient way of inserting a video from YouTube.  I could go through examples of each of 

these but really I think I’m just going to do the first one and that is to insert a video from a file 

because this is the one that offers us the most options and I’m going to leave you to experiment 

with the others. 

So I click on Browse and that brings up an Insert Video dialog and it will show the videos that 

are available in selected folders.  Now the list of video file formats is basically on this drop 
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down.  You may well not be able to see the whole thing.  And I’ll talk about the video file 

formats later in this section.  There are many of them and when I try to do this insert, it will only 

show me video files of these formats.  So I believe the one I want is in that folder.  There it is.  

It’s that one.  It’s an AVI file so I can either double click that or I can select and click Insert and 

the video is inserted into my slide. 

Now there are a couple of things to notice here.  First of all, once you have an inserted video and 

the video is selected, you have the video tools, which is two additional tabs on the Ribbon.  You 

have a Format tab and a Playback tab.  We’re going to look at both of those in just a moment.  

You’ll also have a still from the video itself.  This is not at this stage moving video.  You have to 

actually play it and I’ll come back to that in a moment.  But you’ll also see a set of play controls 

and they’re conventional kinds of play controls.  So you’ve got a play and pause button, you’ve 

got buttons that label you to move back and move forward, and you’ve got a little time control 

and you’ve even got a sound volume control.  So basically the video is there but we have a 

couple of issues in this particular case. 

So let’s take a look at the Format tab first.  The Format tab controls shouldn’t really hold any 

surprises for you.  There are a couple of things such as video shape, video border, video effects 

in the middle here but really they are just shape, border, and effects.  The main issue at the 

moment is that the video is lying on its side.  It’s been taken, it’s basically a portrait video and 

it’s there in landscape mode.  But you just rotate it.  So in the Arrange Group on the Format tab, 

there is a button which enables us to do a rotate right 90 degrees.  Now the play controls are 

hanging off of the bottom of the slide.  So let me just drag the whole thing up to avoid that.  Note 

that you have got sizing handles here.  So you can resize the video if you need to, and you can 

also do corrections.  So you could change brightness and contrast, for example, and perhaps most 

impressively of all, you have video styles.  So let’s suppose I wanted to change this video style.  

Let’s go for something a little bit more, how about that for a video style?  And then finally I’m 

not going to need a title on this one so let me just click on the title placeholder and delete it.  My 

play controls are visible if I hover over it.  But there we have my video ready to use. 

Now let me just select the video again.  If I now look at the Playback tab, the sort of controls I 

get on the Playback tab, I’m not going to go through all of them, but for instance in the Video 

Options Group here Start, two options are automatically.  So you could have this video 
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automatically start when you get to the slide or you can just say Start on click.  I’m going to 

leave it at on click.  You can also say play full screen or not.  So do you want to fill the screen 

with this video?  Do you want it to loop until the person running the presentation stops it?  Do 

you want to rewind it after playing?  You can also put in fade in/fade out and trim the video.  If 

it’s too long, you can reduce it.  You can take some off the beginning, some off the end; maybe 

just use a section in the middle or whatever.  So the playback controls are really very powerful.  

The Format options are powerful as well.  Let’s take a look at this video as it is though. 

So I’m just going to go into Reading View for this and I’ll hover over the play controls.  I might 

just drop the volume down a little bit.  I’m not quite sure how loud this is going to be.  So I’ll put 

the volume down to there and then I’ll click on play.  (Video playing background noise.)  And 

there’s the video playing on my PowerPoint 2013 slide.  Hover over the controls and pause.  And 

there we are; a video within a PowerPoint presentation.  The alignment isn’t quite right as you 

can see, but that’s something that’s very easy to adjust. 

So having had a look at the basics of putting video into a presentation, let’s add some sound.  I’m 

going to put a title on this presentation.  I’m going to call it Getting Wet.  I’m going to just get 

rid of the subtitle and what I’m going to do is to put some sound on this first slide, this title slide.  

Now it’s quite often the case that if you’re given a presentation the audience will arrive and you 

may well decide to have the first slide up and maybe a bit of music playing in the background.  

Now what I’m going to use here is not music.  I’m going to use a sound effect and I don’t think 

you’d probably play this sound effect over a long period of time.  But I want to show you one of 

the ways of inserting sound into a presentation and talk about one or two of the other ways.  So 

what I’m going to do is to put effectively a background sound on this first slide. 

So the first slide is selected.  I click on the Insert tab and then at the right hand end of the Insert 

tab is Audio.  Click on the drop down at the bottom of audio and I’m given three options.  I can 

choose online audio which is the option I’m going to choose.  I can choose audio on my PC 

which lets me insert audio from my computer or from a network.  I can even pick up audio from 

say a CD or something like that.  Note the usual copyright issues.  And then the third option is 

record audio.  You can actually record your own audio, perhaps your own narration or your own 

music to include in your presentation.  But on this occasion, we’re going to go for the first 

option, online audio. 
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That brings up the Insert Audio dialog and the option we have there is to search Office.com 

ClipArt.  So I’m going to search for something related to water.  So enter the word Water, click 

on the Search button.  And I’ve got 69 ClipArt sounds which relate to water.  Sprinklers, jungle 

waterfalls.  What should we go for?  Let’s go for rushing water.  So click on Insert and the sound 

is inserted.  Now don’t be put off by the visible play control.  You’re not really going to want 

that stuck in front of the title of your presentation.  I’ll come back to that in just a moment.  The 

icon in the middle, the speaker icon, is basically the thing you select in order to format this 

sound.  Now you get a set of play controls pretty much similar to the video play controls.  I think 

I’m going to reduce the volume a little bit just in case, and then you have audio tools tabs on the 

Ribbon.  So you have Format tab and you have a Playback tab. 

Now I just want to adjust a couple of the playback settings to demonstrate this at work.  Now you 

may have this sound attached to another object in the presentation or you may have it as a free 

standing play control as we’ve got here.  But if you want this as background music and you want 

no sign that there is a sound linked here, you just want it to appear like magic that music plays 

when you get to this slide, then you click on the option here in Audio options, Hide during show.  

You need to be a little bit careful about that though because with Hide during show you won’t be 

able to see the play control which means if you need to be able to control it you’re either going to 

need to know a relevant keyboard shortcut or you will have needed to set something up to 

control it.  Now that’s beyond the scope of what we’re doing here but I am going to say Hide and 

the reason I’m going to say hide is this.  To the left of that, there is an option that says Play 

across slides.  If I checked that, this sound would play across all the slides in the presentation.  

And if I clicked the one below that, Loop until stopped, it would keep going on and on and on 

until I stopped it.  And the way of stopping it might well be to end the presentation.  Now I don’t 

want this particular sound to play on all slides.  So I just want it to play on the current slide but I 

am going to loop it.  So what this is going to do is to say on this slide, just the title slide, the play 

control will be hidden; so hide during show.  The sound will loop but it would just be on this 

slide.  So let’s see that at work.  Let’s go into Reading View.  We’ll be going to Slide 1, the title 

slide (rushing water sound), and you can hear the rushing water.  That will loop continuously 

until I go to the next slide.  And, of course, on the next slide it’s silent and, of course, I’ve got 

my video here.  So if I go to the controls for that or indeed just click on the still image itself, it 

plays the video. 
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So that’s an introduction to how to insert video and sound into your PowerPoint 2013 

presentations.  There is a very useful page in the PowerPoint Help, video and audio file format 

supported in PowerPoint.  This lists in the first section the video formats and in the second 

section the sound formats that you can insert into a PowerPoint 2013 presentation.  Earlier 

versions of PowerPoint did not support all of these.  So if you’re used to an older version, you 

may be pleased for example to find that the MOV, the QuickTime format is now supported, for 

example. 

So now we have one last exercise for you to do, and the last exercise for you to do is a pretty 

straightforward one again.  I’d like you to find a piece of music, some sort of sound effect, and I 

would like you to add it to the title slide of your final presentation.  Now example-16 in the 

supplied files is the almost final version of the short presentation about the UK Parliament.  So 

you should have an equivalent of example-16.  And I’d like you to add this music or sound to the 

first slide.  I’ve added music to example-17 which is the last sample file.  It’s on the first slide.  It 

loops and it’s hidden.  So basically when you open the presentation, it’s sort of the music that 

will be playing at the beginning of the presentation and just before I move on to say the second 

slide and start talking.  So I’d like you to do the equivalent either to example-16 or to your most 

recent presentation and I’ll see you in the next section. 
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Chapter 32 – Conclusion 

Video:  Protecting your Presentation; Trust Center; Closing 

 
Toby:  Hello again and welcome to this final section in our course on PowerPoint 2013.  I’ve 

just got a couple of final things that I’d like to cover before the course finishes, and one of them 

is to remind you that it’s very important that you keep your installation of PowerPoint 2013 up to 

date along with the rest of Office 2013, of course.  This is normally done if you’re using 

Windows 7 or Windows 8 using Microsoft update which you should run regularly to make sure 

whether there are any updates, fixes, service packs, etc. 

The second thing is to point out that on the Info Page in Backstage View we looked at the Protect 

presentation button and some of the options there.  One of the options on there is the Restrict 

access option.  Now we looked when we looked at SkyDrive, etc at letting other people edit a 

presentation.  But if you really want fine control over what people can do, you can use what’s 

called Digital Rights Management and this is a service that you can get through Microsoft.  I 

believe they even offer a free trial of this service.  It’s outside the scope of this course, but if you 

need to get more specific restrictions on what people can do to your PowerPoint presentations, 

then Digital Rights Management is the way to go and something for you to investigate yourself. 

One aspect of security when you’re using PowerPoint 2013 is the Trust Center and effectively 

the Trust Center applies to all of Office.  Now it’s very important that you understand certainly 

some aspects of what the Trust Center does and what the settings affect.  But if I go into the 

Trust Center Settings, if I go to Protected View, one of the options that I’ve actually got enabled 

is that if you open a potentially dangerous file which could be a potentially PowerPoint 

presentation, then what happens is it’s opened in a mode which helps to minimize the potential 

harm to your computer.  Now some people find Protected View a little bit annoying and they 

switch it off, but there is quite a bit of risk associated with this.  If you open something from a 

source like just the internet where it would be very straightforward for somebody to put a 

dangerous presentation there with some code inside it that might harm your computer, then what 

this setting will do is to open it in Protected View and warn you about that.  Now if in fact the 

presentation was one that you knew was safe, friend or colleague had provided it to you and you 

knew there was no danger with it, you could then switch off Protected View in that particular 
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case.  But in general terms, I think this is a very good setting to have switched on.  Similarly, 

when it comes to have macros inside a PowerPoint presentation, they can also potentially do 

harm to your computer.  And a setting like this one, Disable all macros with notification, which 

basically means if you open a presentation that’s got macros in it PowerPoint 2013 will say, well 

I’ve disabled these macros.  Again, you can look at how safe you consider the presentation to be 

and decide whether to enable the macros or not. 

So I would suggest you spend some time looking at your Trust Center Settings and making sure 

that you understand what they do.  Some of them may well not be relevant to you, but many of 

them will be and looking at some of the information available from Microsoft on any of them 

that you’re not clear about. 

Well, that’s it on our course on PowerPoint 2013.  My name’s Toby.  I hope you’ve enjoyed the 

course as much as I’ve enjoyed preparing it and delivering it to you.  And I look forward to 

seeing you online again sometime soon.  Goodbye for now. 


